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Getting Started

Welcome to Sparx Systems' Enterprise Architect, a desktop
tool with a 20+ year proven track record of helping people
and teams explore, develop and implement their personal or
corporate vision. Enterprise Architect is a tool that is used
to:
· Create rich and expressive business, systems and software
models
· Model and work with "As-Is" and "To-Be" models
· Manage and track requirements
· Model with many industry standard languages such as
UML, SysML and ArchiMate
· Model with many industry frameworks such as TOGAF,
Zachman, UPDM, UAF
· Model with custom purpose built modeling languages for
a domain
· Collaborate with colleagues, teams and customers
· Unite teams spread across multiple geographic locations
· Publish models in standard document formats or for the
web
(c) Sparx Systems 2022
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Share content with other tools in standard industry
formats
· Simulate business and systems processes
· Visualize, inspect and document complex software
systems
· Engineer compelling visualizations
· Provide direction, information and certainty
· Generate a common understanding to both business and
technical stakeholders.
Getting started with Enterprise Architect is easy. As your
modeling practice becomes more advanced, it will have the
power and rigor to support more advanced modeling,
including working with multi-disciplinary teams and
developing strategic, business, software, engineering, and
database models.
This getting started section introduces you to everything you
need to know to become productive with the tool and covers
the essential features that you will use to deliver
demonstrable value to your enterprise or project
stakeholders.
·

Prerequisites
The only prerequisite for getting started is selecting a folder
in your file system for your repository and a mind full of
ideas and concepts that you want to model and some
enthusiasm for sharing your ideas with others through the
rich collaboration features built into the tool.
(c) Sparx Systems 2022
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Why Enterprise Architect?

Welcome to Enterprise Architect, the ultimate collaborative
platform for modeling, visualizing, constructing and
managing Enterprise, Business, Engineering and
Technology solutions. Harness the power of this leading
tool to simplify the way you work, unify interdisciplinary
teams, create models that perform work, leverage and reuse
assets across programs and projects, and much more.

Key Benefits
These are just some of the benefits that Enterprise Architect
can bring to your Enterprise, team and projects:
· Work together with teams from anywhere in the world
using a range of devices such as laptops and smart
phones, working through the phases of solution
development with visibility for both business and
technical audiences
· Integrate with a rich landscape of external tools to unify
teams and enterprises, resulting in fantastic productivity
gains
· Create models and solutions at lightning speed
(c) Sparx Systems 2022
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Work under the umbrella of support for a wide range of
standards and specifications
· Unify the work of business and technical teams
· Enjoy the flexibility, extensibility and configurability of
Enterprise Architect to meet your specific needs
· Accessible using the Enterprise Architect thick client
software or by using the Cloud Server and WebEA from
any device with a browser
For further details, see the Key Benefits Help topic.
·

Key Functional Areas
Sparx Systems Enterprise Architect is a comprehensive
strategy, requirements, analysis, design, construction, testing
and management tool that addresses all aspects of
enterprise, business, systems and software modeling. It is a
scalable, multi-user, visual platform with a rich feature set.
Enterprise Architect combines the power of UML and
derivative modeling languages such as BPMN and SysML,
with a high performance, intuitive interface, to bring an
integrated and advanced toolset to the whole development
team.
Enterprise Architect also includes detailed support for
architectural frameworks such as TOGAF, UAF/UPDM,
ArchiMate, Zachman Framework and others, providing
seamless modeling and design capabilities.
For a breakdown of the functional areas of Enterprise
(c) Sparx Systems 2022
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Architect and the facilities they provide, see the Key
Functional Areas Help topic.

Key Usages
For over twenty years, Enterprise Architect has been the tool
of choice for a wide range of project types and work areas,
supporting most job roles and functions within those areas.
Enterprise Architect is ideal for:
· Strategic Modeling
· Requirements Development and Management
· Business Process Modeling and Analysis
· Software Development
· Systems Engineering and Database Engineering
· Enterprise Architecture
· Testing and Debugging
· And much more
For further information on the usage of Enterprise Architect,
see the Key Usages Help topic.

(c) Sparx Systems 2022
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Key Benefits

Work together in small or large teams from anywhere in the
world using Computers, Tablets and Smart Phones,
specifying, analyzing, designing, simulating, testing,
implementing, deploying and supporting solutions that will
exceed the expectations of business and technical audiences
alike.
Integrate with a rich landscape of external tools to unify
teams and enterprises resulting in productivity gains that
create truly astonishing results.
These are just some of the benefits that Enterprise Architect
can bring to your Enterprise, team and projects:
· High productivity tool creating results in record time
Models and solutions can be created at lightning speed
using a variety of features, including a Model Wizard,
Transformation tools and Code Generation; see the The
Model Wizard Help topic
· Standards and Specification Based
Enterprise Architect supports a formidable range of
standards and specifications, ranging from Enterprise
Architecture, Strategic and Business Modeling, Systems
Engineering, Design and Construction through to
(c) Sparx Systems 2022
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Implementation, Testing and Deployment; see the More
Domain Models Help topic
A platform for business and technical users
With Enterprise Architect it is possible to bridge the
divide between business and technical teams; executive
stakeholders, line managers analysts, development and
testing teams can work together using the tool features
that apply to them but knowing that they are all
contributing to a unified business and technology
solution; see the The Business Model Help topic
Flexible, Configurable and Extensible
The tool is highly flexible, allowing you to tailor the way
you work with Perspectives and Workspaces, helping you
to stay focused and resulting in great productivity; it also
provides a range of mechanisms to extend the core
features, from basic scripts to full-blown third party
Add-Ins; see the Model Perspectives, Model Views,
Workspaces Portal, Scripting and Add-ins & Scripting
Help topics
Code Engineering and Visualization
The tool provides a vast set of code engineering features
that not only allow the full management of source code
but also provide unique facilities to visualize code in
models and diagrams; code hot-spots and performance
problems can be analyzed and resolved in record time; see
the Software Engineering and Execution Analysis Help
topics
Simulation of Business and Technical Models
Models can be brought to life, with easy-to-use

(c) Sparx Systems 2022
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simulations of business models such as Business Process
Diagrams, and technical models such as StateMachines;
these work out of the box but can be extended to allow
advanced analysis using tools such as BPSim, MATLAB
and Modelica; see the Model Simulation and BPSim
Business Simulations Help topics
Extended Features
Beyond the core features for modeling, Enterprise
Architect boasts an extraordinary number of facilities,
from enterprise modeling right through to deployment and
support; these include Kanban, Calendars, Mail,
Discussions, Reviews, Model Library, Gantt Charts, Code
analyzers, Simulation and much more; see the Project
Build & Deploy Help topic
Rigorous Metamodel Driven Technologies
Many of the technologies that underpin the specification
are driven by metamodels, allowing robust and compliant
models to be created and validated; see the Model
Validation Help topic
Collaboration Platform that Unifies Interdisciplinary
Teams
Enterprise Architect was built from the ground up as a
tool to support interdisciplinary teams, fostering
collaboration and team work to ensure that the solution is
far more than the sum of its parts; see Discussions, The
Model Library and The Modeling Team Help topics
Secure, Scalable, Multi-User platform
Any number of users can collaborate, accessing models
securely, and the repositories can scale to support

(c) Sparx Systems 2022
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hundreds of projects in global enterprises; users can
interact with the models in a variety of ways, such as
using WebEA; see the WebEA Help topic
Formidable selection of supported Specifications and
Standards
Enterprise Architect has grown from being a UML tool to
a platform that supports almost all modeling
specifications, from Enterprise Architecture through to
Code Engineering; see the More Domain Models Help
topic
On-Premise and In-Cloud Deployment Models.
There is a range of deployment options from local file
based repositories, through on-premise repositories to full
Cloud solutions; see the The Model Repository Help topic
Accessible from Computers, Tablets and Smart
Phones
Models can be created and edited using the Enterprise
Architect thick client software or by using the Cloud
Server and WebEA from any device with a browser,
including Smart Phones and Tablets; see the WebEA Help
topic
Dashboards, Simple and Advanced Publishing and
Reporting
Enterprise Architect can display expressive dashboards,
with charts and graphs that allow model managers and
others to visualize the model's key performance
indicators; there is also a flexible and extensible report
generator that can produce basic reports through to highly
polished corporate publications; see the Dashboard

(c) Sparx Systems 2022
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Diagrams and Model Publishing Help topics
User Experience
The user interface of the thick client is a highly polished
ribbons-based interface which is a delight to use and
provides simple and obvious access to the rich set of
available features; see the The Application Desktop Help
topic

(c) Sparx Systems 2022
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Key Features

Enterprise Architect from Sparx Systems is a
comprehensive strategy, requirements, analysis, design,
construction, testing and management tool that addresses all
aspects of enterprise, business, systems and software
modeling. The tool can be used from the formulation and
definition of strategy, requirements management through
analysis, design, construction, build, debug, simulation,
testing, change management and maintenance to
implementation and support. The resulting integrated
models include full traceability between all tasks, phases,
domains, components and lifecycle management.
Enterprise Architect combines the power of the UML
specification (and derivative modeling languages such as
BPMN and SysML), with a high performance, intuitive
interface, to bring an integrated and advanced toolset to the
whole development team.
A scalable, multi-user, visual platform with a rich feature
set, Enterprise Architect helps you to build and document
robust, maintainable systems and processes. As a proven,
highly popular tool for analysts, developers, consultants and
managers in over 150 countries world-wide, it is used in the
(c) Sparx Systems 2022
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development of many kinds of applications, processes,
workflows, database schema, knowledge bases,
organizational architectures, systems and technology
standards in a wide range of industries and domains.
Sparx Systems' Enterprise Architect also includes detailed
support for architectural frameworks such as TOGAF,
UAF/UPDM, ArchiMate, Zachman Framework and others,
providing seamless modeling and design capabilities from
early strategic modeling right through requirements to
application lifecycle management, impact analysis,
architectural design and future state modeling.
Industries supported include aerospace, banking, web
development, engineering, finance, medicine, military,
research, geospatial, academia, transport, retail, utilities and
electrical engineering and many more. Enterprise Architect
also has a long history of being used by standards
organizations worldwide to structure and organize their
domain specific knowledge, common models and message
specifications.
Enterprise Architect is supported by many partners,
consultants, colleges and other organizations that provide
training and consulting services based on the system. Details
on partners and local trainers can be found at the Sparx
Systems web site (sparxsystems.com).

Functional Areas
Feature Area Description
(c) Sparx Systems 2022
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Installation

Describes how to install and run
Enterprise Architect, and provides a brief
overview of capabilities. The section
explains where to buy Enterprise
Architect and includes legal and formal
statements with respect to copyright and
licensing.

User
Interface

A description of how to work and access
material in Enterprise Architect,
including how to tailor your Enterprise
Architect environment. This section
includes a detailed review of the user
interface and the windows, ribbons and
other devices that provide the rich and
efficient toolset that has made Enterprise
Architect a market leader in UML Based
modeling and design. A short, simple
tutorial is also provided, which goes over
the basic modeling tasks such as building
a Package structure, creating diagrams
and adding elements to both the model
and a diagram.

Repositories,
Projects and
Teams

Learn about the modeling environment
that accelerates and integrates Software,
Business and Systems development.
Review the basic types of repository that
can be used to host models, from local

(c) Sparx Systems 2022
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files through to Cloud based solutions.
Understand how teams can collaborate
and share models and design tasks. This
chapter also introduces the Re-usable
Asset Service, which is a Cloud based
service that provides access to re-usable
components and technologies, and
provides introductory material on Project
Management within the Enterprise
Architect platform, as well as topics on
Testing and Maintenance.
Modeling
Fundamental
s

Includes a wealth of information on the
Enterprise Architect modeling
environment and how best to express
your design ideas. Introduces the basic
concepts of models, Packages, elements,
connectors and diagrams.

Navigating
and
Searching

Learn about the tools and capabilities
within Enterprise Architect for navigating
within a model, searching a repository for
specific information and tracing between
various elements within the model.

UML Models

(c) Sparx Systems 2022

A review of the basic UML modeling
language, its elements and the main
diagrams that are used to model and
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design solutions. UML is an industry
standard modeling language that has a
proven track record and many years of
development and refinement in its
history. As well as the core UML,
Enterprise Architect also supports a
number of derivative modeling languages
that use UML to provide a rich and exact
visual modeling tool suite. For example
SysML and BPMN are realized in
Enterprise Architect as official extensions
to the core UML language.
Requirements Enterprise Architect is a multi-featured
Management and effective Requirements Management
tool that in addition to the common
capabilities generally offered by such
tools, includes more advanced options to
provide complete traceability from
strategic modeling to implementation,
architectural definition, deployment and
maintenance. Cloud based repositories,
discussions, impact analysis tools,
reporting and a host of other capabilities
make Enterprise Architect the ideal
platform for storing and working with
requirements. The Specification Manager
is a document-like interface that provides
an easy and familiar environment for
creating and editing requirements without
(c) Sparx Systems 2022
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needing to use diagramming or visual
tools.
Business
Modeling

Effective tools for business modeling
including BPMN, Simulation, BPEL,
Requirements, Use Cases, Structured
Scenarios and more.

Software
Engineering

Discover the comprehensive development
toolset, integrated with the modeling
environment for Software and Database
designing and coding. Code engineering
encompasses automated code generation,
reverse engineering of source code and
synchronization between the source code
and model. Enterprise Architect supports
code engineering for more than ten
programming languages out of the box!

Systems
Engineering

Integrating many high-end features for
systems engineers, the Ultimate and
Unified Editions of Enterprise Architect
provide SysML modeling and parametric
model simulation for an engineering
analysis of critical system parameters,
including the evaluation of key metrics
such as performance, reliability and other
physical characteristics, as well as
executable code generation and

(c) Sparx Systems 2022
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model-to-code transformations for
Hardware Description Languages (HDLs)
and ADA 2012.
Enterprise
Architecture

Enterprise Architect supports
industry-standard architectural
frameworks to facilitate enterprise
modeling. Framework implementations
are based on the UML and its related
specifications, which maximizes
architectural rigor and allows users to
exchange enterprise model information
using standards such as XMI. Define
your enterprise with built in tools and
frameworks such as TOGAF, Zachman
Framework, UAF/UPDM, ArchiMate and
more.

Database
Design and
Construction

Enterprise Architect includes a rich and
effective database designer, a profile for
working with database tables and schema,
visual tools for modeling diagrams, and
tools for importing database structures
and comparing existing structures to
models. Integrating data models into the
overall enterprise model provides a rich
set of information and meta data that can
be linked and traced through various
aspects of the model to show how change
might impact remote systems or

(c) Sparx Systems 2022
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processes.
Schema
Engineering

(c) Sparx Systems 2022

Structural models in Enterprise Architect
are frequently used to define the
meta-models of domains of interest. An
important part of realizing the benefit of
these models is in the definition of
schema (often XSD based). The Schema
Composer in Enterprise Architect helps
to make maximum advantage of such
models by streamlining the conversion of
model information into schemas that
comply with the naming standards and
format of a variety of popular industry
meta-models. In addition to the new
Schema Composer, Enterprise Architect
also supports the modeling of XSD and
WSDL definitions using UML Profiles
that support explicit modeling of the
relevant types. You can model and
develop a complete Service Oriented
Architecture in Enterprise Architect,
using XSD or WSDL, or also SoaML and
SOMF.
Additional topics included in this section
are devoted to MOF (the Meta Object
Facility), ODM and NIEM - Enterprise
Architect includes many features for
modeling and working with NIEM
Page 25 of 524
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domains and schema.
Geospatial
Design

As a standards-based modeling
environment, Enterprise Architect
empowers geospatial domain experts
through the use of ArcGIS and GML
tools and profiles. These tools and
profiles allow you to visualize geospatial
database design using UML,
communicate designs to enterprise
stakeholders, link geodatabase designs
directly to enterprise and system models
and requirements and trace from
corporate strategy to realization by
critical GIS components.

Model
Transformati
on

Model Driven Architecture (MDA)
Transformations provide a fully
configurable way of converting model
elements and model fragments from one
domain to another. This typically
involves converting
Platform-Independent Model (PIM)
elements to Platform-Specific Model
(PSM) elements. A single element from
the PIM can be responsible for creating
multiple PSM elements across multiple
domains. Transform your elements with
built-in transformations or write your

(c) Sparx Systems 2022
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own transformation templates.
Execution
Analysis and
Simulation

Understand your code base by visually
analyzing running code and performing
simulations. Use test points, profiling,
automated diagram generation.

Reporting

Generate high quality documentation in
PDF, RTF, DocX and HTML formats.
With an extremely detailed template
driven report generation capability,
Enterprise Architect is the pre-eminent
tool for producing quality documentation
in a variety of formats that help to extend
the reach and usefulness of models
designed and built in Enterprise
Architect.

Project
Management

Estimate project size, measure risk and
effort. Connect the Project Manager and
development team, allowing for
up-to-the-minute reporting and
assessment of how a project is
developing. Assign resources and track to
completion via views and charts. Assess
the relative complexity of a software
project.

Testing and

Define test specifications, execute tests

(c) Sparx Systems 2022
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Quality
Assurance

and record results directly from model
elements. Keeping model elements and
testing documentation in one integrated
model can significantly improve the
communication between quality
assurance teams, software developers,
analysts and architects. Explore the
facilities for testing and validating your
model structure and content.

Maintenance

Model validation, Testing, Maintenance,
Changes and Issues.

Automation
and Scripting

Extend the power of Enterprise Architect
to create your own domain specific
Add-Ins, scripts and functionality.

Extending
UML

How Basic UML and open standards are
extended in Enterprise Architect's support
of other modeling languages, and how
you can use UML Profiles, MDG
Technologies and SDK to create your
own modeling languages.

Learn more
(c) Sparx Systems 2022
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The Open Management Group UML Specifications

(c) Sparx Systems 2022
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Key Usages

For over twenty years, Sparx Systems has actively and
continually developed Enterprise Architect based on the
current UML (and related) standards. Over those years it has
proven itself in a wide range of projects from small single
user models to extremely large team based enterprise
repositories. With nearly 1 million effective users in over
150 countries world wide, the power and effectiveness of
Enterprise Architect has been convincingly demonstrated in
many different areas. The Sparx Systems Community
website provides a wealth of community support and
information for new users.
Enterprise Architect is a proven, scalable, effective and
affordable full-lifecycle development platform for:
· Strategic Modeling
· Business Analysis
· Requirements
· Software Design and Construction
· Software Profiling, Testing and Debugging
· Business Process Modeling and Simulation
(c) Sparx Systems 2022
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Systems Engineering
Enterprise Architecture
Database Engineering
Development of XML Schemas and XSLT Transforms
Development and Dissemination of Technologies such
NIEM, CIM, UNCEFACT and many others.
Project Management
Testing and Maintenance
Reporting
And many other tasks

Enterprise Architect is optimized for:
· Creating, managing and working with a diverse set of
Requirements
· Modeling, designing and constructing a wide range of
software systems
· Business process modeling, business analysis, BPMN,
strategic modeling and similar
· Systems modeling, systems architecture modeling,
component design and simulation
· Modeling, constructing, comparing and updating database
systems
· Defining and generating schema based on XSD and other
standards
· Building and using domain specific modeling languages
based on UML
(c) Sparx Systems 2022
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Visualizing a wide range of systems, processes, data,
activities and structures
Building, executing, debugging, profiling and testing a
variety of software languages
Simulating behavioral processes, StateMachines and
interactions
Generating and building executable code for
StateMachines and supporting simulation of target
executable
Collaborating and sharing information and models
Testing, quality control and end-to-end verification and
trace-ability of complex systems
Project managing developmental tasks, work and
scheduling
Team based collaboration using Cloud based repositories
optimized for access over WAN networks

(c) Sparx Systems 2022
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Editions & Licensing

This section of the Enterprise Architect User Guide contains
a wealth of information to help project managers and other
stakeholders understand what are the key benefits and
features of the Enterprise Architect Tool Suite, what
editions of Enterprise Architect are available and the
facilities each provides; the Licensing Model for the
product; how Help information is made available in
different formats; how support is provided to the product
users; and more.
For further information, see these topics:
· Enterprise Architect Editions
· License Management
· Help and Support

(c) Sparx Systems 2022
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Enterprise Architect Editions
Enterprise Architect is available in a number of editions,
each tailored to support a particular organization of work.
The editions range from a free 'Lite' Edition through to four
purchased editions, which start with the Professional edition
and culminate in the Ultimate edition.

An organization is not restricted to using a single edition
and commonly a mixture of licenses will provide the most
flexibility. When floating licenses are purchased, access to a
higher edition can be achieved on an as-needs basis, thus
providing all users with access to the additional
functionality available in the higher-level editions.

Principal Editions plus 'Trial' and 'Lite'
Aspect

Advantage

Professional,
Corporate,
Unified and
Ultimate
Editions

These are the principal editions that are
available for purchase. An organization
or team can purchase any number of each
product to suit their own circumstances.

(c) Sparx Systems 2022
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Trial of all
The time limited Trial Edition allows a
Editions
user, team or organization to test the
(time limited) product before purchasing. An option is
provided to launch the trial in any of the
purchasable editions, allowing you to
compare them.
The Lite
Edition (read
only - limited
functionality)

(c) Sparx Systems 2022

The free read-only or 'Lite' edition allows
interested parties within an organization
or a team to view the full contents of a
model. They are, however, unable to
update the model or use features such as
document generation, simulation and
code generation.

Page 35 of 524

Getting Started

3 October, 2022

Available Editions
Enterprise Architect is available for purchase in four
Editions:
· Ultimate
· Unified
· Corporate
· Professional
The functionality for each Edition is described here; the
features of and differences between the Editions are listed in
the table provided on the Sparx Systems website.
To help you understand the differences between these
Editions and the advantages and limitations of each, you can
open and use the Trial Edition of Enterprise Architect to
mimic any of the Editions.

Edition Comparison
Ultimate
Edition

(c) Sparx Systems 2022

The Ultimate edition is designed for
power users and those working across
multiple domains, providing deep support
for Business, for Software Engineering
and for Systems Development,
seamlessly integrated into a single
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development environment.
It enables you to drill down to the lowest
levels of systems design and construction,
with SysML and executable code
generation for standard and hardware
description languages.
Business users can leverage BPEL, the
Rules Composer and executable UML, in
addition to all the advanced features of
the other editions of Enterprise Architect.
Software developers can integrate their
Eclipse and Visual Studio projects with
their UML models and leverage the
advanced executable code generators to
target different domains.
The Ultimate edition provides end-to-end
traceability throughout a global vision of
your enterprise - unifying strategy,
business process, interfaces, software,
rules, data and fine grained systems;
advanced tools, domain-specific
technologies, frameworks, integration
platforms and a consistent, scalable, and
robust interface work in unison to help
you deliver on the promise of Model
Driven Development.
The Ultimate edition incorporates a
number of MDG Technologies and
Add-Ins; the Ultimate edition and the
(c) Sparx Systems 2022
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MDG Technologies are all available in
either Fixed License or Floating License
form.
The Floating License arrangement is
particularly useful for companies that
manage a central store of license keys,
which can be used by different employees
over time, temporarily or permanently.
The Ultimate edition provides:
· Executable Code Generation - support
for generating functional source code
for StateMachines, Interactions and
Activities in C, C++, C#, Java and
VB.NET
· Full round trip support for Hardware
Description Languages (Verilog,
VHDL and SystemC) including support
for generating StateMachine code
· SysML Simulation Support - including
support for simulating SysML 1.4
constraint models with results graphing
capabilities
· BPEL Generation – transform BPMN
1.1 and BPMN 2.0 Business process
models down to BPEL 1.1 and BPEL
2.0 code respectively
· Business Rules – trace from abstract
business rules down to automatically
(c) Sparx Systems 2022
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generated behavioral code
Unified
Edition

(c) Sparx Systems 2022

The Unified edition is aimed at software
development professionals, business
modelers, architects, requirements
experts, project managers and others
involved in the design and construction of
quality software and business services as
well as systems engineers working on
real-time, embedded and systems
solutions.
The Unified edition combines advanced
features such as generation of executable
code from UML models (including
support for hardware languages such as
Verilog and VHDL), Ada, SysML 1.5,
executable SysML Parametric diagrams,
BPEL, advanced scripting and a
multi-purpose Rules Composer targeting
executable code from Business Domain
models.
This edition bundles licenses for
integration products and frameworks such
as UAF (UPDM, DoDAF-MODAF),
TOGAF and Zachman as well as SysML
and DDS, to provide advanced
model-driven construction tools to tightly
bind your code development in Eclipse or
Visual Studio with the UML/SysML
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models developed in Enterprise
Architect.
It provides additional features such as:
· SysML Parametrics, HDL, ADA
· DDS, Linux satellite service
· Math support in script library
· BPSim Model Configuration, BPSim
Execution Engine
· BPEL, UAF, UPDM, Zachman,
TOGAF, Visual Studio Integration
· DMN execution and code generation
· Executable StateMachines, Modelica
simulation
The Unified edition incorporates a
number of MDG Technologies and
Add-Ins; the Unified edition and the
MDG Technologies are all available in
either Fixed License or Floating License
form.
The Floating License arrangement is
particularly useful for companies that
manage a central store of license keys,
which can be used by different employees
over time, temporarily or permanently.
The Unified edition provides:
· Executable Code Generation - support
for generating functional source code
for StateMachines, Interactions and
(c) Sparx Systems 2022
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·

·

·

·

·

·

Corporate
Edition

(c) Sparx Systems 2022

Activities in C, C++, C#, Java and
VB.NET
Full round trip support for Hardware
Description Languages, including
Verilog, VHDL and SystemC, with
support for generating StateMachine
code
Generation of Behavioral Code from
State, Sequence and Activity models,
supporting standard programming
languages such as Java and .NET
SysML Simulation Support - Includes
support for simulating SysML 1.4
constraint models with results graphing
capabilities
BPEL Generation from BPMN 1.1 and
BPMN 2.0 models - including
validation and WSDL support
A Business Rules Composer that
enables you to build Business Domain
models and generate code to implement
complex business rules in standard
programming languages
Advanced math functions within the
scripting engine

Aimed at larger development teams, the
Corporate edition enables you to connect
to these DBMS back-ends as the shared
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repository:
· MySQL
· SQL Server
· PostgreSQL
· Access 2007 and
· Oracle
This provides additional scalability and
improved concurrency over the shared
.eap/.eapx file approach to model sharing.
User security, user logins, user groups
and user level locking of elements,
user/group based security (with locking at
diagram and element levels) are also
supported.
Security comes in two modes: in the first
mode, all elements are considered
'writeable' until explicitly locked by a
user or group; in the second mode, all
elements are considered locked until
checked out with a user lock.
The Corporate edition forms the base for
the Unified and Ultimate editions; like
those editions, it is available in either
Fixed License or Floating License form.
The Floating License arrangement is
particularly useful for companies that
manage a central store of license keys,
which can be used by different employees
(c) Sparx Systems 2022
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over time, temporarily or permanently.
Professional
Edition

(c) Sparx Systems 2022

Aimed at developers and engineers
working alone or in small work groups,
the Professional edition supports
file-based model repositories, unsecured
shared repositories and Firebird-based
Cloud repositories.
This Edition has an ActiveX interface for
interrogating Enterprise Architect
projects and extracting information.
The Professional edition fully supports
code import/export and synchronization
of model elements with source code; it
enables reverse engineering of SQL
Server, MS Access, MySQL, PostgreSQL
and Oracle databases.
Support for MDG Technologies (sold
separately) is included with the
Professional edition.
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License Management

Each purchased version of Enterprise Architect requires a
license, and tools to manage the licenses are available for
the product. There are two types of license available Private Licenses, which are allocated to a named user, and
Shared Licenses, which essentially provide a pool of
floating licenses. After a purchased copy of Enterprise
Architect has been installed, you will be required to enter
either the license key provided at the time of purchase or a
temporary shared key obtained from a central Keystore.
Enterprise Architect provides a licence management dialog
through which you enter, view and maintain licence
information, including upgrading the version of Enterprise
Architect and registering Add-Ins.

Access
Ribbon

(c) Sparx Systems 2022

Start > Help > Help > Register and
Manage Your License Key(s)
Start > Help > Register
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License Management Options
Option

Action

Key

This column lists the registration keys
that you are currently using.
If the entry is an alphanumeric code, that
is your private key that has been issued to
you permanently. You register this key
the first time you use the Sparx Systems
product, using the Add Key button.
If the entry is 'Shared Key', it indicates
that you have temporarily been allocated
a shared or 'floating' key from the key
store. When you log on to Enterprise
Architect, a key is automatically issued to
you (if one is available) from the key
store. When you have finished your work
session, the key will be returned to the
key store for issue to another user. (Note
that the Key Store might not have been
configured to manage keys automatically,
in which case you manually obtain a key
when you open Enterprise Architect and,
if you prefer, manually release the key
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before the 'lease' expiry - see Add Key
and Release Key.)
Lease
Expires

This column indicates when the 'lease' on
the registration key you are using expires.
For a private key the value is 'Never',
because the key has been permanently
assigned to you and there is no 'leasing'
involved.
For a shared key, the value is generally
the day after the key was automatically
issued to you at the start of a work
session, but the Key Store Manager can
set a different expiry period. In practice,
the key is usually returned earlier to the
keystore when you log out of the current
work session.

Product

This column identifies the Sparx Systems
product that the registered key gives you
access to.

Add Key

Display the 'Add Registration Key'
dialog, which you can use to:
· Register your new Enterprise Architect
license key
· Manually obtain a shared key from the
Sparx Systems Key Store
· Add a new key to update to a higher
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version of Enterprise Architect or to
register an Add-In
Remove Key
Release Key

(For a Private Key) Make the Add-In or
current version of Enterprise Architect
inoperable, such as when you are
upgrading to a more complex edition of
Enterprise Architect.
(For a Shared Key) Release the key to the
keystore; however, the Keystore Manager
is normally configured to release keys
automatically when you log off.

Copy button

Place the highlighted key into the
clipboard.

Close button

Close the dialog.

Help button

Display this Help topic.
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Finding Your License Information
You can find information on your Enterprise Architect
license in the 'About Enterprise Architect' dialog, which
shows, principally:
· The program version and build
· Your Registration Key
· The edition of Enterprise Architect you are registered to
use
· Your licensed user ID on the system

Access
Ribbon
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Start > Help > Help > About EA
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Adding License Keys
Two types of license key can be used in conjunction with
Enterprise Architect: Private and Shared.

Private Keys
Private keys allow you to register, indefinitely, on the
machine and user account that you are currently using:
· An Enterprise Architect license for the edition of
Enterprise Architect you have purchased, or
· An Add-In product license

Shared Keys
Shared keys are obtained from a shared key store, allowing
you to check out a key when necessary, and later check in
the key so that it can be used by someone else.
Shared Keys require a shared license key store to be
configured by your license administrator; the key store can
be either file-based or network based (preferred). Only the
Key Administrator is required to install the Sparx Enterprise
Key Store application; end users simply connect to the
configured key file - advised by the administrator - as
described here. No additional software is required to be
installed.
(c) Sparx Systems 2022

Page 49 of 524

Getting Started

3 October, 2022

Access
Ribbon

Start > Help > Help > Register and
Manage Your License Key(s) > License
Management : Add Key > Add
Registration Key
Start > Help > Register > License
Management : Add Key > Add
Registration Key

Add a Private Key
Ste Action
p
1

Click on the 'Enter Private Key' tab.

2

In the 'Name' and 'Company' fields, type your user
name and company name.

3

In the 'Copy registration key into space below...'
field, copy the registration key (including any
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parentheses around the key).
4

Click on the OK button to confirm the key selection.

Add a Shared Key
Ste Action
p
1

Click on the 'Get Shared Key' tab.

2

In the 'Name' and 'Company' fields, type your user
name and company name.

3

In the 'Shared Keystore' field, click on the button.
The 'Shared Keystore Selection' dialog displays.

4

If your keystore is file-based:
· Select the 'File Based Keystore' radio button
· Click on the Browse button, and
· Locate and select the keystore file
Go to step 6.

5

If the keystore is network-based:
1. Click on the 'Sparx Keystore Server' radio button.

(c) Sparx Systems 2022
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2. Select either 'ssks' or 'https' as the Protocol.
3. In the 'Server' field, type the server address of the
keystore.
4. In the 'Port' field, type the server Port of the
keystore.
5. If necessary type in the Username and Password
(advised by your administrator), and/or click on
the Test button to check that you have a
connection to the keystore.
6

Click on the OK button to return to the 'Get Shared
Key' tab.
This now shows the name of the keystore in the
'Shared Keystore' field.

7

In the 'Select a Product' field, click on the
appropriate product name.

8

Click on the OK button.
The 'License Management' dialog redisplays,
indicating that the shared key is registered for the
selected product until the key expiry date.

9

Click on the Close button.

Notes
(c) Sparx Systems 2022
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Some license keys can override and remove others:
- The key for a more advanced edition of Enterprise
Architect replaces the key for a simpler edition
- The key for MDG Integration for Visual Studio
replaces the key for MDG Link for Visual Studio
- Shared keys and Private keys have different formats
and cannot be used interchangeably
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Keystore Troubleshooting
The management of shared keys can be an onerous task, so
Enterprise Architect provides the Keystore and its
management interface to make the administration as easy as
possible. Occasionally issues arise that prevent users from
obtaining a license; these are typically due to the set up of
the Keystore and can easily be rectified.

Error Messages and Handling
Message
Displayed:

Explanation

Error reading
Key Store
file:
(Access is
denied)

All users who are to use the shared key
facility require Read, Write and Modify
access to the sskeys.dat file containing
the shared keys.
Please verify that all required users have
sufficient permissions to the file and try
again.
Review the effective permissions
calculated at the location of the key file
for the user account reporting the
problem - you should closely examine the
permissions for both the Network Share
and the File System; it is possible that
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Page 54 of 524

Getting Started

3 October, 2022

these permissions have been overwritten
at some point.
If the problem continues, contact Sparx
Support.
Error reading
Key Store
file:
(Key File has
been moved)

(c) Sparx Systems 2022

In the key store, as a security measure the
hard drive serial number is recorded
when the file is created; the file then
cannot be moved from the original
location in which it was created.
If the key store has to be re-located for
any reason, the administrator should
re-create the key store in the new location
using the original license keys.
This issue is commonly seen after a file
server has undergone a hardware upgrade
in which the physical hard drives have
been replaced; problems could also occur
if the drive used is part of a RAID
configuration.
The message can also appear where the
key store exists on a Novell-based file
system - when creating the key store, the
administrator is prompted to confirm that
the key store is to be located on a Novell
Netware file server; if they click on the
Yes button, the key store instead records
the logical path used to create it, and all
users must connect to the key store using
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this same path.
The recorded path is case-sensitive and
must be an exact match.
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Upgrade an Existing License
As you work with Enterprise Architect you might become
aware of additional features contained in other Editions,
which you could use on your projects. Fortunately, it is easy
to upgrade the Edition you are using to a more advanced or
specific Edition. For example, you might have been working
alone creating a private model using the Professional
Edition, and then at some point the project expands and a
team of people need to contribute to and update the models,
and the Project Manager decides to use security to
encourage collaboration between the users. This would
require an upgrade to the Corporate Edition, which contains
the role-based security features.
It is a cost effective and easy procedure to upgrade to
another Edition, but a new license key must be added to the
product to make the upgrade effective. This should not be
confused with license renewal, which is an extension of the
license for the same Edition of Enterprise Architect and
does not require a new key to be entered.
There are four Editions of Enterprise Architect; from
simplest to most fully featured, these are:
· Professional
· Corporate
· Unified
· Ultimate
The Enterprise Architect installer provides the facilities of
(c) Sparx Systems 2022
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every Edition; your registration key gives you access to the
facilities of the Edition you have purchased.
If you have purchased a lesser Edition, such as Professional,
you can subsequently upgrade your license to a more
complete Edition by purchasing a special upgrade key from
Sparx Systems. Once you have received this key, use the
procedure described here to gain access to the additional
features.
This procedure is mainly applicable to users with private
keys; if you are an end-user with a shared key, you would
simply be allocated the relevant key next time you requested
one. If, however, you want to upgrade while using a shared
key on a long lease, you would simply click on the Release
Key button and then the Add Key button on the 'License
Management' dialog.

Access
Ribbon
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Start > Help > Help > Register and
Manage Your License Key(s) > License
Management : Add Key
Start > Help > Register > License
Management : Add Key
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Upgrade from One Licensed Edition to
Another
Ste Action
p
1

Make sure you have a valid upgrade key purchased
from Sparx Systems; you typically receive this in an
email or PDF format.

2

On the 'Add Registration Key' dialog, in the 'Name'
and 'Company' fields, type your name and company
name.

3

Copy the key you received for the upgraded edition
of Enterprise Architect - including the { and }
bracket characters - from the email.

4

Paste the key into the 'Copy registration key' field.

5

Click on the OK button.
Enterprise Architect displays the message:
Registration succeeded – Thank you for purchasing
Enterprise Architect xxxx Edition

6

Click on the OK button, and then on the Close
button to continue working in Enterprise Architect.
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Select the 'Start > Help > Help > About EA' menu
option.
Copy the registration key shown and store it
somewhere safe; this is a key to the full license of
the edition you have upgraded to.
If you ever have to reinstall Enterprise Architect, you
can register it with this key, so you will not have to
go through the upgrade process again.

Notes
·

The Lite Edition and the Trial Edition cannot be
registered or upgraded; if you have used either of these
editions and then purchased Enterprise Architect, you
must download the registered edition from:
sparxsystems.com/securedownloads/easetupfull.msi
Then you can enter your registration key

(c) Sparx Systems 2022
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Register Add-In
Apart from registering Enterprise Architect, you must also
register any Add-Ins you purchase to use with the
application. You can register either a private key as
explained here, or a shared Add-In key as explained in the
Add An Add-In Key topic.

Access
Ribbon

Start > Help > Help > Register and
Manage Your License Key(s)
Start > Help > Register

Register Add-Ins for Enterprise Architect
Ste Action
p
1

Purchase one or more licenses for the Add-In from
your Add-In provider.
Once you have paid for a licensed version of the
Add-In, you receive (via email or other suitable
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means) a license key for the product.
2

Save the license key and the latest full version of the
Add-In.

3

Run the Add-In's set up program to install the
Add-In.

4

In Enterprise Architect, select 'Start > Help >
Register'.
The 'License Management' dialog displays.

5

Click on the Add Key button.
The 'Add Registration Key' dialog displays, showing
the 'Enter Private Key' tab.

6

Type or copy-and-paste in the key you received with
the Add-In, including the { and } characters.

7

Click on the OK button.

8

When the Add-In has been added successfully, close
down Enterprise Architect and restart it to apply the
integration changes imposed by the Add-In.
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Add an Add-In Key
When your organization is using a Keystore to distribute
keys you can retrieve a key for a third party Add-In in the
same way as you would for a key for any Sparx Systems
product.

Access
Ribbon

Start > Help > Help > Register and
Manage Your License Key(s) > License
Management : Add Key > Get Shared
Key
Start > Help > Register > License
Management : Add Key > Get Shared
Key

Add a Shared Add-In Key
Ste Action
p
1

In the 'Name' and 'Company' fields, type your user
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name and company name.
2

In the 'Shared Keystore' field, click on the button.
The 'Shared Keystore Selection' dialog displays.

3

Click on the 'Sparx Keystore Server' radio button,
and in the 'Server Address' field type the server
address of the keystore.

4

If necessary, in the 'Password' field type the
password (advised by your administrator) and/or
click on the Test button to check the connection to
the keystore.

5

Click on the OK button to return to the 'Get Shared
Keystore' tab, which now shows the name of the
keystore in the 'Shared Keystore' field.

6

In the 'Select a Product' field, look for the
appropriate product name and click on it.

7

Click on the OK button.
The 'License Management' dialog redisplays with the
shared Add-In key in the 'Currently Registered Keys'
list.

8

Click on the Close button.
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Notes
·

Shared Add-In keys require Enterprise Architect version
11 or higher
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Ordering and Installation

Enterprise Architect is available for download from Sparx
Systems in a free Trial Edition format. You can explore this
trial in all edition configurations and then, once you have
decided which edition to purchase, you have a number of
options as detailed in the Order Enterprise Architect Help
topic.

Feedback
We value any suggestions, feedback and comments you
might have regarding this product, documentation or install
process.
You can provide your feedback using one of the online
forms:
Bug Report - sparxsystems.com/bug_report.htm
Feature Request sparxsystems.com/feature_request.htm
or contact us via email at:
support@sparxsystems.com

(c) Sparx Systems 2022

Page 66 of 524

Getting Started

(c) Sparx Systems 2022

3 October, 2022

Page 67 of 524

Getting Started

3 October, 2022

Order Enterprise Architect
Enterprise Architect is designed, built and published by
Sparx Systems, and available through the Sparx Systems
website.
· You can download a free, 30-day Trial Edition of the
product
· On purchase of a suitable license or licenses, you can
download the registered purchase edition that provides the
facilities of the edition you require, as unlocked by the
license keys provided by Sparx Systems
· The Trial Edition of Enterprise Architect is identical to
the registered edition, except that all diagrams are output
to files with an embedded watermark
· The trial software stops working after the trial period has
elapsed; however, you can extend the evaluation period
by asking Sparx Systems for an extension key
· The latest information on pricing and purchasing is
available on the 'Purchase' page of the Sparx Systems
website, and from Sparx Sales

Purchase Options
·
·
·

On-line using a secure credit-card transaction
Fax
Check or equivalent
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Bank transfer
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Installation
Enterprise Architect is distributed as a Windows installer
(*.msi) file that will check and update previous installations
of Enterprise Architect.
· After you install Enterprise Architect, you can
immediately begin to create projects as .qea files
· The latest evaluation and registered versions of Enterprise
Architect are always available from the Sparx Systems
website
· The registered version is available through the 'Registered
User' area of the web site, which requires a username and
password to access; these are provided upon purchase of a
license

Installation
Aspect

Detail

System
The system requirements for installing
Requirements Enterprise Architect are defined on the
'Enterprise Architect System
Requirements' page of the Sparx Systems
website.
Installation
on Linux and
(c) Sparx Systems 2022
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on Linux, refer to the Installing
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MacOS

Enterprise Architect inside Wine Help
topic.
Under Linux, Formatted Notes text on
diagrams might not display correctly.

Install
Enterprise
Architect

Execute the Enterprise Architect .msi file
to run the Enterprise Architect set up
program. Generally, you can accept all
the default options without change.
To place Enterprise Architect in a
directory other than the default, enter the
name of the destination when prompted.
You might be prompted to restart your
computer when the installation
completes; although this is not always
necessary (if you already have the
components Enterprise Architect requires
installed on your computer), you should
restart just to be certain.

Install Local
Help

When you select to display Help in
Enterprise Architect, by default it opens
the appropriate topic in the Help on the
Sparx Systems website. You can,
however, download the
EAUserGuide.msi file from the
'Resources' page of the website, to install
the HTML Help files on your local
machine so that you can display Help
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information without accessing the
Internet.
Enterprise Architect should be restarted
after installing the local HTML Help
files.
Using a Third
Party DBMS
as Model
Repository

If you plan to use SQL Server, MySQL,
PostgreSQL, Access 2007, or Oracle as a
model repository, then you must use the
Corporate, Unified or Ultimate Editions
of Enterprise Architect.
You also require additional files and
supplementary installation processes;
please note that installation and
maintenance of these database
management systems is not included
under the support agreement.
Users planning to use SQL Server,
MySQL, PostgreSQL, Access 2007 or
Oracle as their model repository can
access scripts that create the required data
structures for the choice of DBMS, from
the Sparx Systems website.

Zero Config
Client
Support

Enterprise Architect can be used on client
machines without having to be installed
on those machines. This can ease
deployment in a corporate environment,
by running the system from a read-only
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shared folder. This enables a System
Administrator to install Enterprise
Architect once for all users rather than
once on each computer.
Version
Activation
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From version 14.0 onwards, Enterprise
Architect requires that you 'activate' the
Software Version you have installed.
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Installing Enterprise Architect Under
Linux or macOS
Using Wine, it is possible to install and run Enterprise
Architect on Debian-based Linux systems, such as Ubuntu
and Linux Mint, as well as on macOS systems.
Information relating to installation and use of specific
products on different platforms can be found in the topics
listed in the Learn More section.

(c) Sparx Systems 2022
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Installing Enterprise Architect under
Linux
This page describes how to install and upgrade Enterprise
Architect on Linux environments using Wine. Instructions
are also provided for installing and configuring Add-Ins, as
well as configuring Enterprise Architect's Visual Execution
Analyzer and Pro Cloud Server for use in non-Windows
environments.

Installing Enterprise Architect using Wine
The example commands used here relate to Debian-based
Linux systems, such as Ubuntu and Linux Mint, although
you can follow the same basic procedures for other Linux
distributions.
Ste Action
p
1

Follow the instructions provided on this WineHQ
web page:
https://wiki.winehq.org/Ubuntu

2

We recommend installing the Carlito font, so that
text in diagrams appears as it does in a native
Windows installation. This also prevents the diagram
from resizing unnecessarily.
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Issue this command to install the Carlito font:
· sudo apt-get install fonts-crosextra-carlito
3

Install the MSXML and MDAC components by
running these commands:
· winetricks msxml3
· winetricks msxml4
· winetricks mdac28
If prompted to do so, download the msxml.msi file
and place it in the directory:
~/.cache/winetricks/msxml3.
Note: When Wine updates are applied to your
system, often they interfere with the mdac28
module, preventing it from running. To avoid any
issues, it is good practice after installing Wine
updates, to run this command:
· winetricks --force mdac28

4

Run winecfg, and in the libraries tab add:
"*msado15"
Set this to Native,Builtin.
Click on the OK button.

5

Download the latest Enterprise Architect installer:
· Registered (paid) Enterprise Architect edition
· Trial Enterprise Architect edition
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Install Enterprise Architect by running one of these
commands, which relate to the registered and trial
installations respectively:
· wine msiexec /i easetupfull.msi
· wine msiexec /i easetup.msi

Install Jet 4.0 Database Engine
To install 'jet40', we will use 'Winetricks'.
Ste Action
p
1

Open a Terminal window and run the command:
· winetricks jet40

Install ODBC Drivers (Optional)
To connect directly to an Enterprise Architect project hosted
on a third party DBMS, you will need to use an ODBC
driver appropriate for the DB type.
To install an ODBC driver, first download the relevant
installer, then run the installer using Wine.
(c) Sparx Systems 2022
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Once the ODBC driver is installed, you can configure the
connection from the Enterprise Architect ribbon 'Settings >
User Tools > ODBC Data Sources'.
Note: For improved performance when accessing a remote
DBMS over a WAN connection, you should consider using
Sparx System's Cloud Server.
Ste Action
p
1

Open a Terminal window, then run the installer by
issuing a command similar to one of those provided
here, substituting the name of the ODBC Driver
installer that you want to run.
For .msi files, use:
· wine msiexec /i <odbc-driver_name>.msi
For .exe files, use:
· wine <odbc-driver_name>.exe

Upgrading Enterprise Architect Using Wine
To upgrade Enterprise Architect to a new version, you must
first uninstall your current version, before installing the new
version.
Ste
p
(c) Sparx Systems 2022
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1

Download the latest Enterprise Architect installer.

2

Run this command in a terminal:
· wine uninstaller

3

Uninstall the existing version of Enterprise
Architect.
· Select 'Enterprise Architect' from the
'Applications' list
· Click on the Remove button
· Follow the prompts to uninstall Enterprise
Architect

4

Install the new version of Enterprise Architect, by
running this command in a terminal:
· wine msiexec /i easetupfull.msi
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Installing Enterprise Architect under
macOS
This page describes how to install and upgrade Enterprise
Architect on macOS environments using Wine. This applies
for Mac OS 10.8 - 10.14.
For installation on macOS 10.15 and later, see the Installing
Enterprise Architect using CrossOver (macOS) Help topic.

Download and Install Wine
Go to the WineHQ website, https://www.winehq.org, and
download the latest version of Wine that is available for the
version of macOS that you are running. We recommend
using a 'stable' version of Wine rather a 'development'
version. Follow the instructions provided on the WineHQ
website for installing Wine.

Download 'Winetricks'
Winetricks is a helper script that assists with the installation
of a number of run-time libraries required by Enterprise
Architect.
The web page https://wiki.winehq.org/Winetricks provides a
link to the 'winetricks' file, which is currently:
(c) Sparx Systems 2022
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https://raw.githubusercontent.com/Winetricks/winetricks/ma
ster/src/winetricks
Note: The 'Winetricks' web page can also be located by
searching for 'winetricks' on the WineHQ website.
Ste Action
p
1

Using an Internet browser, navigate to the web page:
https://wiki.winehq.org/Winetricks

2

Locate the file link
https://raw.githubusercontent.com/Winetricks/winetr
icks/master/src/winetricks
Right-click on the file link and save the file locally
as '/Applications/winetricks'.

3

If the file is saved as 'winetricks.txt', rename it as
'winetricks'.
In a Terminal window, issue the command:
· mv /Applications/winetricks.txt
/Applications/winetricks

4

Change the permissions of 'winetricks' to make it
executable.
In a Terminal window, issue the command:
· chmod +x /Applications/winetricks
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Use 'Winetricks' to Install Run-Time Libraries
Use the helper script ‘winetricks’ to install the run-time
libraries MDAC28, MSXML3 and MSXML4, which are
required by Enterprise Architect.
Ste Action
p
1

On your Mac, use 'Finder' to open the 'Applications'
folder.

2

Double-click on 'Wine' (or 'Wine Stable') to open a
Terminal window that is configured to use the Wine
environment.

3

In the Terminal window, issue these commands:
· /Applications/winetricks msxml3
· /Applications/winetricks msxml4
· /Applications/winetricks mdac28
Note: If or when you apply Wine updates to your
system at some later date, they might interfere with
the mdac28 module, preventing it from running. To
avoid any issues, it is good practice after installing
Wine updates, to run this command:
· winetricks --force mdac28

(c) Sparx Systems 2022

Page 82 of 524

Getting Started

3 October, 2022

Install Jet 4.0 Database Engine
By using the Jet 4.0 database engine, Enterprise Architect
can access database files that employ Unicode character
encoding.
To install 'jet40', we will use 'Winetricks'. However, we
must first install 'Homebrew' - which is a Package Manager
for macOS - and 'cabextract' - which is software for
extracting files from Microsoft cabinet files.
Ste Action
p
1

Install 'Homebrew'
'Homebrew' is an unofficial Package Manager for
macOS.
To install 'Homebrew', open a Terminal window and
issue this command:
ruby -e "$(curl -fsSL
https://raw.githubusercontent.com/Homebrew/install
/master/install)" < /dev/null 2> /dev/null
Note: It will take a few minutes to download and
install all of the required components.

2

Install 'cabextract'
The 'cabextract' application is software that is
employed by 'Winetricks' to extract files from
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Microsoft cabinet files.
To install 'cabextract', open a Terminal window and
issue the command:
· brew install cabextract
3

Install Jet 4.0 Database Engine
Using 'Finder', display the Applications folder.
Double-click on 'Wine' (or 'Wine Stable') to open a
Terminal window configured to use the Wine
environment.
In the Terminal window, issue the command:
· /Applications/winetricks jet40

Installing ODBC Drivers (Optional)
To connect directly to an Enterprise Architect project hosted
on a third party DBMS, you will need to use an ODBC
driver appropriate for the DB type. To install an ODBC
driver, first download the relevant installer, then run the
installer using Wine.
Once the ODBC driver is installed, you can configure the
connection from the Enterprise Architect ribbon: 'Settings >
User Tools > ODBC Data Sources'.
Note: For improved performance when accessing a remote
DBMS over a WAN connection, you should consider using
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Sparx System's Cloud Server.
Ste Action
p
1

Use 'Finder' to open the 'Applications' folder, then
double-click on 'Wine' (or 'Wine Stable') to open a
Terminal window configured to use the Wine
environment.

2

Run the installer by issuing a command similar to
one of those provided here, substituting the name of
the ODBC Driver installer that you want to run.
For .msi files, use:
· wine msiexec /i
Downloads/<odbc-driver_name>.msi
For .exe files, use:
· wine Downloads/<odbc-driver_name>.exe

Install Enterprise Architect Inside Wine
When you install applications using Wine, the applications
will be installed in the '.wine' folder, within your home
directory.
For Enterprise Architect, the default installation folder will
be '.wine\drive_c\Program Files\Sparx Systems\EA'.
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(If you chose to include support for 64 bit systems when you
installed Wine, then 'Program Files (x86)' will be used
instead of 'Program Files'.)
Ste Action
p
1

Download the latest Enterprise Architect installer.
· Registered (paid) Enterprise Architect edition
· Trial Enterprise Architect edition

2

Open a Terminal window configured to use the Wine
environment.
(This is where you will run the installation
commands.)
· Using 'Finder', double-click on 'Wine' (or 'Wine
Stable') in the Applications folder

3

Install Enterprise Architect by issuing one of these
commands, which relate to the registered and trial
installations respectively:
· wine msiexec /i Downloads/easetupfull.msi
· wine msiexec /i Downloads/easetup.msi

Install Carlito Font
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We recommend installing the Carlito font, so that text in
diagrams appears as it does in a native Windows
installation. This also prevents the diagram from resizing
unnecessarily.
By default, Enterprise Architect uses Microsoft's Calibri
font, but this font is not available under macOS (or under
Wine) unless you have previously installed a Microsoft
product such as MS Office.
Ste Action
p
1

Download the Carlito font files.
- Carlito font can be downloaded from:
'https://fontlibrary.org/en/font/carlito'
Note: The web page contains advertisements; to
download the font files, click on the DOWNLOAD
CARLITO button.

2

The font files are packaged into ZIP files. Extract
the font files from the ZIP archive.

3

Use 'Font Book' to install the fonts, which will make
them available for use in all applications.
· Using 'Finder', double-click on 'Font Book' in the
Applications folder to launch that application
· Choose 'File | Add Fonts...' from the Font Book
main menu to open the file selection window
· Navigate to and select all of the Carlito font files
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Click on 'Open'

Create an Alias On Your Desktop to Run
Enterprise Architect
Ste Action
p
1

Using 'Finder', open your 'home' folder.

2

From the Finder menu, choose 'Go | Go to Folder...',
then enter '.wine' in the dialog that opens. (Notice
the 'dot' prefix in this folder name.)

3

Navigate to 'drive_c\Program Files\Sparx
Systems\EA'.
(If you chose to include support for 64 bit systems
when you installed Wine, then navigate to
'drive_c\Program Files (x86)\Sparx Systems\EA'
instead.)

4

Within this folder, locate the file 'EA.exe'.
Right-click on 'EA.exe' and choose 'Make Alias'.
Rename the alias as 'Enterprise Architect', then drag
the alias onto your Desktop.
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Alternatively, drag 'EA.exe' onto the Dock.
5

Launch Enterprise Architect by double-clicking the
shortcut on the Desktop, or by clicking the shortcut
in the Dock.

Upgrading Enterprise Architect Using Wine
To upgrade Enterprise Architect to a new version, you must
first uninstall your current version, before installing the new
version.
Ste Action
p
1

Download the latest Enterprise Architect installer.

2

Open a Terminal window configured to use the Wine
environment, then launch the Wine 'Uninstaller'.
· Using 'Finder', double-click on 'Wine' (or 'Wine
Stable') in the Applications folder
· Issue the command 'wine uninstaller'; the Wine
'Add/Remove Programs' window is displayed

3

Uninstall the existing version of Enterprise
Architect.
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Select Enterprise Architect from the
Applications list
Click on the Remove button
Follow the prompts to uninstall Enterprise
Architect

Install the new version of Enterprise Architect.
· Using 'Finder', double-click on 'Wine' (or 'Wine
Stable') in the Applications folder
· Issue the command 'wine msiexec /i
Downloads/easetupfull.msi'
· Follow the prompts to install Enterprise Architect
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Installing Enterprise Architect using
CrossOver (macOS)
This page describes the process of installing Enterprise
Architect using CrossOver under macOS. It is assumed that
you already have CrossOver installed on your machine and
that you have already downloaded the latest installer for
Enterprise Architect.

Prerequisites
Installation of macOS 10.15 or later requires:
· Intel® based processor or Apple M1 processor with
Rosetta2 installed
· CrossOver Mac 20, or later.

Using CrossOver to install Enterprise
Architect.
Installing a Windows application using CrossOver is quite
straightforward. First you launch CrossOver, then launch
the 'CrossOver Software Installer'. The 'CrossOver
Software Installer' consists of a window with four separate
tabs or pages, where each tab handles a specific part of the
installation process.
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Detailed steps for each part of the process are provided here,
to guide you through the installation of Enterprise Architect.
Task

Detailed Steps

Start
CrossOver
and Launch
the
'CrossOver
Software
Installer'
Start CrossOver, then either:
· Click on the button 'Install a Windows
Application', or
· From the CrossOver main menu,
choose 'Configure | Install Software'
The 'CrossOver Software Installer'
window is displayed.
Select the
Application
to Install

(c) Sparx Systems 2022

The first tab 'Select Application' should
be selected by default. If it isn't, click on
it now.
CrossOver comes pre-configured with a
list of applications, from which you can
select one to install. Unfortunately, the
list does not contain the latest release of
Enterprise Architect.
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In the 'Edit' field, type 'Enterprise
Architect nn' (substitute the version
number of the installer you have
downloaded)
As you type, an entry is created in the
drop-down list below the field you are
typing in.
· Click on the entry 'Unlisted application
'Enterprise Architect nn''
· Click on the Continue button
·

Select the
Installer to
Use
(c) Sparx Systems 2022
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·

·

·

Select a
Bottle to Use
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Click on the option 'Choose Installer
File...'
In the file chooser window, navigate to
and select the Enterprise Architect
installer you have downloaded, then
click on 'Use this installer'
In the 'CrossOver Software Installer'
window, select (highlight) the installer
you chose, then click on 'Continue'

The third tab 'Select Bottle' should now
be selected. If it isn't, select it now.
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Unless you have previously created a
Wine Bottle to use for Enterprise
Architect, you will need to create a new
Bottle now.
· Select the version of Windows that you
want to use; in this example, we chose
'New Windows 10 Bottle...'
· Type a name in the field 'New Bottle
Name:' that describes the Bottle. For
example, 'Enterprise Architect 15'
· Click on 'Continue'
Proceed with
Installation
(c) Sparx Systems 2022
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names and the fourth and final tab should
now be displayed.

If any of the previous tabs is not
displaying a checkmark, the Install button
will not be enabled. You will need to
revisit each tab that is not displaying a
check mark and provide valid information
on that page.
· When everything is complete, click on
the Install button
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Run Enterprise Architect
After successfully completing these steps, Enterprise
Architect should be installed and ready to run.
To start Enterprise Architect, first start CrossOver, then
simply double-click on the Enterprise Architect shortcut.

Upgrading Enterprise Architect Using
Crossover
When you upgrade Enterprise Architect to a new version,
you must first uninstall your current version before
installing the new version.
Ste
p
1

Click on the Bottle and select the 'Run Command'
option.

2

Type the command: uninstaller.

3

Select 'Enterprise Architect' from the list, then click
on the Remove button.

4

Again click on the Bottle and select the 'Run
Command' option.
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Browse for the new installer file, and click on the
Run button.
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Installing the Jet 4.0 Database Engine
Using Wine
By using the Jet 4.0 database engine, Enterprise Architect
can access database files that employ Unicode character
encoding.

Install Jet 4.0 Under Linux
To install 'jet40', we will use 'Winetricks'.
Ste Action
p
1

Open a Terminal window and run the command:
· winetricks jet40

Install Jet 4.0 Under macOS
To install 'jet40', we will use 'Winetricks'. However, we
must first install 'Homebrew' - which is a Package Manager
for macOS - and 'cabextract' - which is software for
extracting files from Microsoft cabinet files.
Ste Action
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p
1

Install 'Homebrew'
'Homebrew' is an 'unofficial' Package manager for
macOS.
To install 'Homebrew', open a Terminal window and
issue the command:
· ruby -e "$(curl -fsSL
https://raw.githubusercontent.com/Homebrew/inst
all/master/install)" < /dev/null 2> /dev/null
Note: It will take a few minutes to download and
install all of the required components.

2

Install 'cabextract'
The 'cabextract' application is software that is
employed by 'Winetricks' to extract files from
Microsoft cabinet files.
To install 'cabextract', open a Terminal window and
issue the command:
· brew install cabextract

3

Install Jet 4.0 Database Engine
Using 'Finder', display the Applications folder.
Double-click on 'Wine' (or 'Wine Stable') to open a
Terminal window configured to use the Wine
environment.
In the Terminal window, issue the command:
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/Applications/winetricks jet40
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Installing ODBC Drivers Using Wine
To connect directly to an Enterprise Architect project hosted
on a third party DBMS, you will need to use an ODBC
driver appropriate for the database type. To install an
ODBC driver, first download the relevant installer, then run
the installer using Wine.
Once the ODBC driver is installed, you can configure the
connection from the Enterprise Architect ribbon 'Settings >
User Tools > ODBC Data Sources'.
Note: For improved performance when accessing a remote
DBMS over a WAN connection, you should consider using
Sparx System's Cloud Server.

To Install under Linux
Ste Action
p
1

Open a Terminal window, then run the installer by
issuing a command similar to one of those provided
here, substituting the name of the ODBC Driver
installer that you want to run.
For .msi files, use:
· wine msiexec /i
Downloads/<odbc-driver_name>.msi
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For .exe files, use:
· wine Downloads/<odbc-driver_name>.exe

To Install under macOS
Ste Action
p
1

Open a Terminal window configured to use the Wine
environment.
· Use 'Finder' to open the 'Applications' folder, then
double-click on 'Wine' (or 'Wine Stable')

2

Run the installer by issuing a command similar to
one of those provided here, substituting the name of
the ODBC Driver installer that you want to run.
For .msi files, use:
· wine msiexec /i
Downloads/<odbc-driver_name>.msi
For .exe files, use:
· wine Downloads/<odbc-driver_name>.exe
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Using Enterprise Architect's Visual
Execution Analyzer (VEA) With Wine
Note these points before attempting to analyze your
application with Enterprise Architect running under Wine:
· These instructions only apply to native code (C/C++),
when running under Wine
· These instructions assume your application is installed
successfully into the Wine environment, and all
dependencies are met; for example, you have installed
msxml6 if your application requires it and it is not
deployed as part of your installer
· These instructions assume you have built your program in
Visual Studio as Debug or Release with PDB support
· If you are using a Debug executable file, you might have
to copy the MFC/ATL Debug SXS from your Windows
machine to your Wine environment; so the folder
C:\windows\WinSxS would map to
~/.wine/drive_c/windows/winsxs
· For every EXE/DLL that you want to debug or profile
using the VEA, you must have the PDB for that file

Using the Visual Execution Analyzer
Deploy and analyze your application with Enterprise
Architect's VEA using these steps:
(c) Sparx Systems 2022
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1

Copy all of your source files from your development
machine to the Wine environment. The path must
match exactly. For example, if your source code was
compiled in C:\source\yourApp, then you must copy
the source code files to
~/.wine/drive_c/source/yourApp.
This means that if you build your code on a separate
machine, you might first have to use 'winecfg' to
map a drive, in order to get the correct path.

2

Run your application manually via the command line
using a command of the form:
· wine PATH_TO_APPLICATION

3

If the application runs, proceed to the next step.
Otherwise, check the console for Wine output and
install any DLLs to resolve missing dependencies.
Once you are certain that there are no missing
dependencies and that the crash is due to something
else, proceed to the next step.
Tip: If a huge amount of output is generated by
WINE, pipe the output to a file using a command of
the form:
· wine PATH_TO_APPLICATION >& output.txt

4

Import your source code. This is optional - you don't
have to import your code into Enterprise Architect,
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but it does help when you want to set breakpoints
within your code.
5

Set up Enterprise Architect Build Scripts using these
steps:
· Add a build script to a Package; for details, see the
Help topic Analyzer Script Editor
· Configure the Run command
· Configure the Debug command
· Set the Debugger value to 'Microsoft Native'

6

Open the Debug window or use the Execution
Analysis - Debug workspace (preferred).

7

Select the Build Script you created in the previous
step.

8

Click on the Play button.

(c) Sparx Systems 2022

Page 106 of 524

Getting Started

3 October, 2022

Notes
·

·

·

·

Check that the breakpoint is bound - if it is bound, it will
stay red; if it has a question mark, it is not bound
If your breakpoint didn't bind, then check carefully that
the source path matches exactly
Ensure that the PDB file(s) is in the same directory as
your EXE file(s)
Ensure that EXE and PDB files match; that is, that they
are from the same compilation
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Configuring Subversion for Enterprise
Architect using Wine
To set up and use Subversion with Enterprise Architect
under Wine, the process is almost identical to the process
for setting up and using the systems under Windows. When
using Subversion with Enterprise Architect under Wine, you
still use a Windows-based Subversion command line client.
The differences are in the way you prepare the Subversion
working environment. Specifically, in the way you install
your Subversion client and the way you check out a working
copy folder from the Subversion repository.
For further information, please refer to the Help topic
Preparing a Subversion Environment Under Wine.
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Installing Enterprise Architect Add-Ins
Using Wine
Installing Add-Ins
To install Enterprise Architect Add-Ins using Wine, follow
these steps:
Ste Action
p
1

Download the Add-In of interest. Add-Ins are
usually distributed as executable installers. A list of
Enterprise Architect Add-Ins developed by Sparx
Systems can be found at:
https://sparxsystems.com/products

2

If your Add-In depends on .NET, you need to install
.NET first. Although .NET-based Add-Ins for
Enterprise Architect have not been tested under
Wine, you can run one of the commands listed here
to install the .NET runtime.
Open a Terminal window
[Under macOS, to open a Terminal window
configured to use the Wine environment:
· Using 'Finder', double-click on 'Wine' (or 'WINE
STABLE') in the Applications folder ]
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Now run one of these commands:
· winetricks Downloads/dotnet20
· winetricks Downloads/dotnet30
· winetricks Downloads/dotnet35
· winetricks Downloads/dotnet40
Note: Installing a higher .NET runtime will install
the previous versions as well.
3

Run this command, replacing the name of the
installer file with the one you downloaded.
· wine EAZachman.exe

4

Follow the installer's prompts to complete
installation.
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Configuring the MDG Link for Eclipse
Add-In using Wine
The MDG Link for Eclipse Add-In is now distributed and
installed automatically with the Enterprise Architect
installer (as of Enterprise Architect version 12). When
running under Wine, MDG Link for Eclipse allows you to
link to an instance of Eclipse running natively on the
Linux/macOS host. These instructions assume that Eclipse
has been set up within the native Linux/macOS
environment.

Configure the MDG Link for Eclipse Add-In
Ste Action
p
1

To run MDG Link for Eclipse in the native version
of Eclipse, Enterprise Architect's Plug-in jar files
must be copied to the Plug-ins directory of the
Eclipse installation. Copy the necessary jar files
from your Enterprise Architect installation under
Wine to your Eclipse installation.
Two sample copy commands are shown here, with
the jar file paths corresponding to 64 bit and 32 bit
Wine installations respectively. You can copy one of
these samples and replace the
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'PATH_TO_ECLIPSE_DIR' text with your Eclipse
installation path.
· cp ~/.wine/drive_c/Program\ Files/Sparx\
Systems/EA/*.jar
PATH_TO_ECLIPSE_DIR/plugins
· cp ~/.wine/drive_c/Program\ Files\ \(x86\)/Sparx\
Systems/EA/*.jar
PATH_TO_ECLIPSE_DIR/plugins
2

Start Eclipse and load the project to link to
Enterprise Architect.
Note: We recommend running Eclipse natively due
to potential compatibility issues between Java and
Wine that can manifest when running Eclipse via
Wine

3

Start Enterprise Architect (via Wine) and open a
project.

4

Configure the MDG Link for Eclipse connection
options by invoking Enterprise Architect's 'Eclipse
Options' dialog.
From the ribbon choose: 'Specialize > Add-Ins >
Eclipse > Options'.

5

Since Windows paths differ from Linux/macOS
paths, you need to specify how file paths are handled
in the 'Options' dialog, as illustrated.
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Replace 'Y:' with the path you use in Wine.
6

To link to an Eclipse project:
· Select a Package in Enterprise Architect's Browser
window
· From the ribbon, choose 'Specialize > Add-Ins >
Eclipse > Connect External Project'
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Select the project you opened in Eclipse using the
'Connections' dialog.
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Configuring Enterprise Architect's Pro
Cloud Server Using Wine
Enterprise Architect's Pro Cloud Server can be installed and
run on Linux using Wine. To configure the Pro Cloud
Server using Wine, you need to consider the guidelines in
the Help topic Pro Cloud Server Configuration and pay
particular attention to the points regarding privileged ports
on Linux and the commands for running the Pro Cloud
Server in standalone mode.
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Zero Config Client Support
Enterprise Architect can be used on client machines without
having to be installed on those machines. This can ease
deployment in a corporate environment, by running the
system from a read-only shared folder. This enables a
System Administrator to install Enterprise Architect once
for all users rather than once on each computer.
· The ea.ini file will be read if it exists in the same directory
as ea.exe
· To add settings, copy the value lines from a registry
export of defined Enterprise Architect options
· It is recommended that you specify JET 4 support using
the line "JET4"=dword:00000001
· You specify a keystore and the keys to checkout using the
values 'SKT', 'SharedKeyFolder', 'SSKSAddress',
'SSKSPassword' and 'AutoCheckoutEx'
· Use the Cloud Service to deploy shared models without
requiring additional database drivers and other software
Note: It is still preferable to install locally where possible.
Without a local installation these restrictions apply:
· The Automation Interface and Scripting will not be
available (without running the object registration as part
of the install)
· Firebird models (with the extension .feap) cannot be
loaded (without registering the ODBC driver as part of the
install)
(c) Sparx Systems 2022
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JET 3.5 is no longer installed by default on Windows
systems, and JET 3 drivers are unlikely to be available, so
you will need to enable JET 4
No file extensions will be automatically registered in this
scenario; users can still manually configure their
computers to use Enterprise Architect to open .eap files
The file handler allowing Enterprise Architect to open
source files and documents directly from the file system
will not be available

The system administrator must first follow this process:
1. Install Enterprise Architect.
2. Open the application.
3. Connect to a keystore containing the key(s) everyone
should use.
4. Select the 'Start > Application > Preferences >
Preferences' ribbon option to display the Preferences
window, click on the 'General' page and select the 'Use
JET 4.0' checkbox.
5. Click on the Close button and then close down Enterprise
Architect.
6. Open your registry editor and export
HKEY_CURRENT_USER\Software\Sparx
Systems\EA400\EA\Options.
7. Create an ea.ini file in the directory to be shared.
8. Copy these keys into the ea.ini file from the exported
registry: JET4, SKT, SSKSAddress, SSKSPassword, and
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AutoCheckoutEx.
9. Copy the Enterprise Architect install files from 'Program
Files' to a network share or USB device.
10. Optionally, mark the target directory as read-only.
Note:
· If the appropriate values for the ea.ini file are already
known, steps 2-5 can be skipped
· Defaults can be configured by placing them after a
registry key of the form
"INIFILE_VERSION"=dword:00000043; these will only
be executed when the existing value for this user is not the
same value as the one in the file

Example - Checkout an Ultimate Key
This example sets JET 4 and configures a keystore. Using a
configuration file to specify the settings for all users means
that the users can select a key without having to connect to a
keystore, as shown here. The first time this example is run it
checks out an Ultimate key, but allows the user to request a
different key on subsequent logins.
"JET4"=dword:00000001
"SKT"=dword:00000001
"SSKSAddress"="ssks://licenseserver"
"SSKSPassword"=""
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"INIFILE_VERSION"=dword:00000043
"AutoCheckoutEx"=hex:1a,00,00,00
An Enterprise Architect user will just need to run the system
from the network drive or USB device.
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Version Activation
From release 14.0 onwards, Enterprise Architect requires
that you 'activate' the software version you have installed by
entering a simple four-letter code to confirm your right to
use that specific version of Enterprise Architect. When you
first run Enterprise Architect a Version Activation window
will automatically display, prompting you to activate the
software version you have installed.
Details:
· 'Software Version' means an instance of the Enterprise
Architect software, either identified by a distinct number
(such as 14.1 or 15.0) or by its build date (such as March
2020)
· 'Software Version' is independent of and unrelated to the
Edition of Enterprise Architect (such as Corporate or
Ultimate)
· Version Activation does not involve or require a
connection to the Internet
· Registered users with an active support and maintenance
agreement can obtain a new activation code by logging in
to the 'Registered Users' page of the Sparx Systems web
site
· The Version Activation Code is prominently displayed on
the 'Registered Users' page
· The Version Activation Code is also delivered with your
New License or Renewal Details email
(c) Sparx Systems 2022
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You can also obtain a Version Activation Code by
clicking the 'Get a Code' link on the Version Activation
window and logging in using your registered user ID and
password
Your Version Activation Code will activate all versions of
the software built and released prior to and during the
period of your support and maintenance agreement (either
from a Renewal or a New License)
New versions of the software released after the expiry of
your support and maintenance agreement will require a
new Activation Code; when you renew your support and
maintenance agreement you will be entitled to download
newer versions of Enterprise Architect and will be given a
new Version Activation Code

How To Activate:
· Enter your Activation Code in the appropriate field*
· Tick the checkbox to acknowledge acceptance of terms of
the licence agreement
· Click on the OK button **
* Please note that the code is not case sensitive.
** An internet connection is NOT required or used for
activation
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Register a Full License
The free Trial Edition of Enterprise Architect available for
download is an evaluation version only. For the full version
you must first purchase one or more licenses.
The license key supplied determines which Enterprise
Architect Edition (Professional, Corporate, Unified or
Ultimate) is activated after installation.
The Corporate, Unified and Ultimate Editions can be
activated by either a private license key or a shared
(floating) license key. Shared license keys, for a user
population that includes temporary users, are checked out of
and in to a Sparx Systems key store.

Obtain and activate the registered version of
Enterprise Architect
Ste Action
p
1

Purchase one or more licenses.
Once you have paid for a licensed version of
Enterprise Architect, you receive (via email or other
suitable means):
· A license key or keys
· A web site address from which to download the
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full version
(If you have purchased a Sparx Systems key store)
a web site address from which to download the
key store

2

Save the license key(s) and download the latest
installation package from the address supplied.

3

Run the set up program to install the full version.

4

Open Enterprise Architect from the 'Start Menu' or
desktop icon.
The 'License Management' dialog displays.

5

Click on the Add Key button.
The 'Add Registration Key' dialog displays; register
your key.

6

Click on the OK button.
The full version is now activated on your PC, and
Enterprise Architect displays the message:
Registration succeeded! Thank you for
purchasing Enterprise Architect <type> Edition

Notes
(c) Sparx Systems 2022
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Private license keys and shared license keys have different
formats, so you cannot use one in place of the other
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Formal Statements

Please take the time to read these legal statements
concerning Sparx Systems Enterprise Architect.

Legal Notes
Sparx Systems would like to gratefully Acknowledgements
to the development of Enterprise Architect.
Statement
Software Copyright Notice
Enterprise Architect End User Licensing Agreement
Acknowledgement of Trademarks
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Copyright Notice
This legal information concerns the copyright ownership of
Enterprise Architect and of any 3rd party tools of code that
require a statement of copyright ownership.

Copyright © 1998 - 2022 Sparx Systems Pty.
Ltd. All rights reserved.
The Enterprise Architect software contains proprietary
information of Sparx Systems Pty Ltd. It is provided under a
license agreement containing restrictions on use and
disclosure and is also protected by copyright law. Reverse
engineering of the software is prohibited. Please read the
product license agreement for full details.
Due to continued product development, this information can
change without notice. The information and intellectual
property contained herein is confidential between Sparx
Systems and the client and remains the exclusive property of
Sparx Systems. If you find any problems in the
documentation, please report them to us in writing. Sparx
Systems does not warrant that this document is error-free.
No part of this publication may be reproduced, stored in a
retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording or
otherwise without the prior written permission of Sparx
Systems. Licensed users are granted the right to print a
(c) Sparx Systems 2022
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single hardcopy of the user manual per licensed copy of the
software, but may not sell, distribute or otherwise dispose of
the hardcopy without written consent of Sparx Systems.
Sparx Systems Pty. Ltd.
99 Albert St,
Creswick, Victoria 3363,
AUSTRALIA
Phone: +61 (3) 5345 1140
Fax: +61 (3) 5345 1104
Support Email: support@sparxsystems.com
Sales Email: sales@sparxsystems.com
Website: sparxsystems.com

Scintilla and SciTE
Copyright 1998-2003 by Neil Hodgson
<neilh@scintilla.org> All Rights Reserved.
Permission to use and distribute this (Scintilla) software and
its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appears in
all copies and that both that copyright notice and this
permission notice appear in supporting documentation.
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Sparx Systems Enterprise Architect
Modelling Tool
End User License Agreement (EULA)
Version 16.0 Professional, Corporate, Unified and
Ultimate Editions
Copyright © 1998-2022 inclusive, Sparx Systems Pty Ltd.
All Rights Reserved.
IMPORTANT - READ CAREFULLY: This End User
License Agreement ("EULA") is a legal agreement between
YOU (an individual person) as the Licensee of the
SOFTWARE PRODUCT ("You") and SPARX SYSTEMS
PTY LTD ("SPARX") as owner of the SOFTWARE
PRODUCT.
By installing, copying, or otherwise using any version of the
SOFTWARE PRODUCT, however obtained, You agree to
be bound by the terms of this EULA. If You do not agree to
the terms of this EULA immediately cease to use the
SOFTWARE PRODUCT. If you have paid to use the
Registered Version of Enterprise Architect promptly return
it to the place of purchase for a full refund within 30 days of
purchase.
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Your use of the SOFTWARE PRODUCT indicates your
acceptance of this EULA and warranty. The EULA applies
to all versions of the SOFTWARE PRODUCT, regardless
of age, and may be updated at any time without notification
to you, so please refer to this document from time to time.
The copyright in all versions of the SOFTWARE
PRODUCT and its associated documentation is owned by
Sparx Systems Pty Ltd (A.C.N 085 034 546), and is
software that is licensed, not assigned to you. The license
may be revoked. All rights not explicitly licensed to you are
reserved to Sparx without limitation.
Subject to the terms of this EULA, You are granted a
non-exclusive license to use the SOFTWARE PRODUCT
exclusively on the terms of this agreement. For the
avoidance of doubt, You do not acquire ownership of
copyright or other intellectual property rights in any part of
the SOFTWARE PRODUCT by virtue of this EULA.

1. DEFINITIONS
In this End User License Agreement, the following terms
apply unless otherwise specified,
· "ACADEMIC EDITION" means an edition of the
SOFTWARE PRODUCT purchased for educational
purposes at an academic discount price;
· "EULA" means this End User License Agreement;
(c) Sparx Systems 2022
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"SPARX" means Sparx Systems Pty Ltd, A.C.N. 085 034
546;
"Licensee" means You, or the organization (if any), or the
person on whose behalf You are accepting the terms of
this EULA;
"Registered Edition of Enterprise Architect" means the
edition of the SOFTWARE PRODUCT which is available
for purchase from the web site:
<https://sparxsystems.com/products/ea/purchase.html>,
"SOFTWARE PRODUCT" or "SOFTWARE" means the
following software products inclusively, or any one of
them (as the case may be): 'Enterprise Architect', 'LITE',
'Professional', 'Corporate', 'Unified' and 'Ultimate'
editions, which includes computer software and
associated media and printed materials (in digital or
physical form) , and any applicable online or electronic
documentation;
"Support Services" means email-based support provided
by SPARX, including advice on usage of the
SOFTWARE PRODUCT, investigation of bugs, fixes,
repairs of models, if and when appropriate, and general
product support
"SPARX support engineers" means employees of SPARX
who provide on-line support services;
"Trial Edition of Enterprise Architect" means the edition
of the SOFTWARE PRODUCT which is available free of
charge for evaluation purposes;
"EA LITE" means the LITE edition of Enterprise
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Architect that is distributed free of charge as a read-only
viewer of .eap files.
"Zero Config" means running the SOFTWARE
PRODUCT instance locally on an end user machine, as
per the terms of this license, where the binary executables
and associated files are stored and accessed from a
network file server instead of being installed locally on
the end user machine.
"Remote Desktop" means a mechanism by which an end
user runs an exclusive instance of the SOFTWARE
PRODUCT on a remote machine, but manipulates the
instance as if it were installed and executing on his current
machine.

2. GRANT OF LICENSE IN THE SOFTWARE
PRODUCT
Subject to clause 3 below and in accordance with the terms
of this EULA, You are granted these rights:
· To install and use one copy of the SOFTWARE
PRODUCT or, in its place, any prior version for the same
operating system, on a single computer. This license is for
direct and exclusive use of the SOFTWARE PRODUCT
only through the input hardware mechanisms of the
licensed computer, such as a keyboard, mouse, or via a
touchscreen. As the primary user of the computer or
device on which the SOFTWARE PRODUCT is installed,
(c) Sparx Systems 2022
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You may make a second copy for your exclusive use on
either a home or portable computer.
To store or install a copy of the SOFTWARE PRODUCT
on a storage device, such as a file server, used only to
install the SOFTWARE PRODUCT or execute the
SOFTWARE PRODUCT in ZERO CONFIG mode on the
licensed users local machine.
If YOU want to increase the number of users entitled to
concurrently access the SOFTWARE PRODUCT, YOU
must notify SPARX and agree to pay an additional fee (if
applicable) for the transfer in the type of license granted
to you.
To make copies of the SOFTWARE PRODUCT for
backup and archival purposes only.

3. FIXED AND FLOATING LICENSES IN THE
REGISTERED EDITION OF ENTERPRISE
ARCHITECT
There are two licenses available for the Registered Edition
of Enterprise Architect.
· A. Fixed License: A fixed license to use the Registered
Edition of Enterprise Architect is linked exclusively to the
person who has obtained it. It cannot be transferred
without the consent of Sparx, which may be withheld at
its discretion.
(c) Sparx Systems 2022
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B. Floating License: A floating license to use the
Registered Edition of Enterprise Architect is able to be
purchased by companies or other organizations of more
than one person. This license is transferable to other
individuals within that organization. The number of users
that may use a Registered Edition of Enterprise Architect
at any one time is limited to the number of licenses
actually purchased. Sparx Systems provides a Floating
License Keystore application to assist in the management
of Floating License keys.

4. TRIAL EDITION OF ENTERPRISE ARCHITECT
– GRANT OF EVALUATION LICENSE
The Trial Edition of Enterprise Architect is not 'free'
software, it is licensed to you for evaluation purposes only.
Subject to the terms of this agreement, You are hereby
licensed to use the Trial Edition of Enterprise Architect for
evaluation purposes without charge for a period of thirty
(30) days, from the date the Trial Edition of Enterprise
Architect is first installed on your device or computer.
Upon expiration of the thirty (30) days, the Trial Edition of
Enterprise Architect must be removed from the device or
computer. Continued unregistered use of the Trial Edition of
Enterprise Architect after the 30-day evaluation period is in
violation of Australian, U.S. and international copyright
(c) Sparx Systems 2022
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laws.
SPARX may extend the evaluation period on request and at
our discretion.
After the 30-day evaluation period has elapsed, a license to
use the Registered Edition of Enterprise Architect must be
purchased (as described at
<https://sparxsystems.com/products/ea/purchase.html>).
Upon payment of the license fee, YOU will be sent details
on where to download the Registered Edition of Enterprise
Architect and will be provided with a suitable software 'key'
by email.

5. EA LITE
Subject to the terms of this Agreement, EA LITE may be
installed on any machine indefinitely and free of charge.
There are no fees or Sparx support services in relation to EA
LITE. Sparx makes no warranty as to the usability of this
software for your purposes.

6. ADDITIONAL RIGHTS AND LIMITATIONS
All rights not expressly granted to you are reserved by Sparx
(c) Sparx Systems 2022
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Systems. For the avoidance of doubt, and without limitation:
· You explicitly undertake not to sell, rent, lease, translate,
adapt, vary, modify, decompile, disassemble, reverse
engineer, create derivative works of, sub-license, loan,
resell or distribute the SOFTWARE PRODUCT other
than as expressly authorized by this EULA;
· SPARX does not allow you to virtualize features of the
SOFTWARE PRODUCT separately, or work around any
technical restrictions or limitations in the SOFTWARE
PRODUCT;
· You undertake not to reproduce or distribute license
key-codes except under the express and written
permission of SPARX;
· You further undertake not to use any part of THE
SOFTWARE that will enable you to allow more than one
user to use the Registered Edition of Enterprise Architect,
despite only having obtained one fixed license. This
conduct is specifically prohibited and will result in your
license being terminated and/or damages being sought for
lost revenue;
· "Remote Desktop" access and the "Zero Config"
operation are permitted provided the end user is licensed,
has agreed to the terms of this EULA and accessing their
exclusive instance of Enterprise Architect on their
primary desktop machine;
· Server based installations that provide concurrent end
users with content or functionality derived from a running
remote instance of Enterprise Architect over a network is
not officially supported by Sparx Systems. (This is due to
(c) Sparx Systems 2022

Page 136 of 524

Getting Started

¨

¨

¨

¨

¨

¨

3 October, 2022

technical limitations in the Enterprise Architect product,
specifically its construction as a single user application
interacting with the desktop UI). If you wish to deploy or
use Enterprise Architect in this manner, as a minimum
you MUST adhere to the requirements detailed below and
further elaborated here:
<https://sparxsystems.com/products/ea/server-legal.html>
and accept the risks and responsibilities attendant on that;
Every end user MUST have a genuine Enterprise
Architect license of the correct edition;
The end user must have a licence under their own name,
even if that licence is obtained by that user's organization
on that person's behalf;
Sub-licensing Enterprise Architect by 3rd Parties to end
users is not permitted;
A Fixed license per end user is required without
exception. Licenses cannot be dynamically allocated or
transferred between end users;
Unlimited Read-Only and/or Unlimited Read/Write
access to a server based instance of Enterprise Architect is
expressly forbidden as unlicensed end users may be
illegally authorized (with or without their knowledge) to
use the Enterprise Architect instance on the server.
A server based instance must NOT be used to create a
derivative work, adapt Enterprise Architect for another
platform, virtualize separate functionality or otherwise
contravene the rights and entitlements granted to Sparx
Systems under copyright law and not expressly granted to
the end user in the Enterprise Architect EULA.
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You acknowledge the risks and limitations inherent in
using Enterprise Architect in a manner that is not
supported nor recommended and waive all rights and
warranties pertinent to this use.
If the SOFTWARE PRODUCT purchased is an Academic
Edition, YOU ACKNOWLEDGE THAT the license is
limited to use in an educational context, either for
self-education or use in a registered teaching institution.
The Academic Edition may not be used to produce
commercial software products or be used in a commercial
environment, without the express written permission of
SPARX. If the Academic Edition is used to produce a
commercial product, You shall be immediately liable for
payment of the Registered Edition of Enterprise Architect
and you acknowledge this is reasonable.

7. INTELLECTUAL PROPERTY AND
ASSIGNMENT
Sparx warrants that it owns all rights (including without
limitation, all copyright, and other proprietary rights) in and
to the SOFTWARE PRODUCT and that it is entitled to
grant the licences in the SOFTWARE PRODUCT contained
in this EULA without need for further agreement.
YOU may only assign all your rights and obligations under
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Page 138 of 524

Getting Started

3 October, 2022

this EULA to another party if YOU supply to the transferee
a copy of this EULA and all other documentation including
proof of ownership. Your license is then terminated.
Sparx retains complete copyright ownership of all patterns,
images, process and guidance documents shipped with the
SOFTWARE PRODUCT. These may only be used within
the SOFTWARE PRODUCT and other Sparx owned
software.

8. TERMINATION
Without prejudice to any other rights, SPARX may
terminate this EULA if YOU fail to comply with the terms
and conditions. Upon termination YOU or YOUR
representative shall destroy all copies of the SOFTWARE
PRODUCT and all of its component parts or otherwise
return or dispose of such material in the manner directed by
SPARX.

9. WARRANTIES AND LIABILITY
SPARX warrants that:
· The SOFTWARE PRODUCT (excluding EA Lite) will
perform substantially in accordance with the
accompanying written materials for a period of ninety
(c) Sparx Systems 2022
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(90) days from the date of receipt (and not for the
avoidance of doubt, from the date of installation); and
Any Support Services provided by SPARX shall be
substantially as described in applicable written materials
provided to You by SPARX on a case by case basis, and
SPARX support engineers will make commercially
reasonable efforts to solve any problems associated with
the SOFTWARE PRODUCT.

10. EXCLUSION OF LIABILITY
To the maximum extent permitted by law, SPARX excludes,
for itself and for any supplier of software incorporated in the
SOFTWARE PRODUCT, all liability for all claims,
expenses, losses, damages and costs made against or
incurred or suffered by You directly or indirectly (including
without limitation lost costs, profits and data) arising out of:
· Your use or misuse of the SOFTWARE PRODUCT;
· Your inability to use or obtain access to the SOFTWARE
PRODUCT;
· Gross negligence of SPARX or its employees, contractors
or agents, or of any supplier of software incorporated in
the SOFTWARE PRODUCT, in connection with the
performance of SPARX's obligations under this EULA; or
· Termination of this EULA by either party for any reason.
Sparx will remain liable to you in accordance with the terms
(c) Sparx Systems 2022
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of this EULA, in all cases where the user(s) has an active
and paid up subscription. The indemnities in this EULA will
have no effective where the SOFTWARE PRODUCT
licence is obtained, used, acquired or assigned unlawfully.

11. LIMITATION OF LIABILITY
The SOFTWARE PRODUCT and any documentation are
provided "AS IS" and all warranties, whether express,
implied, statutory or otherwise, relating in any way to the
subject matter of this EULA or to this EULA generally,
including without limitation, warranties as to: quality;
fitness; merchantability; correctness; accuracy; reliability;
correspondence with any description or sample, meeting
your or any other requirements; uninterrupted use;
compliance with any relevant legislation; and being error or
virus free are excluded. Where any applicable legislation
implies in this EULA any term, and that legislation avoids
or prohibits provisions in a contract excluding or modifying
such a term, such term shall be deemed to be included in
this EULA. However, the liability of SPARX for any breach
of such term shall, if permitted by legislation, be limited, at
SPARX's option to any one or more of the following, upon
return of the SOFTWARE PRODUCT and a copy of the
receipt:
If the breach relates to the SOFTWARE PRODUCT, Sparx
shall at its discretion:
(c) Sparx Systems 2022
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Replace the SOFTWARE PRODUCT; or
Cover the costs of the supply of an equivalent
SOFTWARE PRODUCT (up to the aggregate liability
figure listed below);

If the breach relates to services provided by Sparx in
relation to the SOFTWARE PRODUCT, Sparx shall at its
discretion provide:
· The services again; or
· The payment of the cost of having the services supplied
again.
In all cases, the total aggregate liability of Sparx under or in
connection with this agreement or use of the SOFTWARE
PRODUCT shall be limited to the cost of a SOFTWARE
PRODUCT licence (AU$600).

12. TRADEMARKS
All names of products and companies used in this EULA,
the SOFTWARE PRODUCT, or the enclosed
documentation may be trademarks of their corresponding
owners. Their use in this EULA is intended to be in
compliance with the respective guidelines and licenses.
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13. PRIVACY AND CONTACT
At SPARX we take your privacy seriously. A copy of our
privacy policy can be found at
<http://sparxsystems.com/privacy.html>. Should you wish
to contact us regarding privacy or any other matter
contained in this EULA, please contact us at our email
address - sparks@sparxsystems.com

14. GOVERNING LAW
This agreement shall be construed in accordance with the
laws of the Commonwealth of AUSTRALIA, in the state of
Victoria.
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Trademarks
Sparx Systems acknowledge these trademarks and registered
trademarks, which are used throughout the Enterprise
Architect documentation.

Acknowledgement
Company

Trademarks

Accellera

SystemC™

Actian
Corporation

Ingres™

Adobe
Systems
Software

Registered Trademarks:
ActionScript®
Adobe®
Flex®

Apple Inc

Registered Trademark:
Mac®

Atlassian

Registered Trademark:
Jira®
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Esri
ArcCatalog™
(Environment ArcGIS™
al Systems
Research
Registered Trademarks:
Institute Inc)
ESRI®
Autodesk,
Inc

Registered Trademark:
Autodesk®

Dropbox, Inc

Dropbox™

Firebird
Foundation
Incorporated

Registered Trademarks:
FireBird®

IBM

Informix™
Jazz™
Registered Trademarks:
DB2®
DOORS®
Rational®
Rational® Rhapsody
Rational Rose®

Idera
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Registered Trademarks:
Delphi®
Linux Mark
Institute

Registered Trademark:
Linux®

Methodologi
es
Corporation

SOMF™

Microsoft
Corporation

ActiveX™
Microsoft Office™
Microsoft Word™
VB.NET™
Registered Trademarks:
Access®
Active Directory®
Excel®
Intelli-sense®
JScript®
Microsoft®
Microsoft® .NET
Microsoft® Office 2016
MS Access®
MS Access 2007®
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Office 2016®
SQL Server®
SQL Server Express®
Visio®
Visual Basic®
Visual SourceSafe®
Visual Studio®
Win32®
Windows® (Windows XP, Windows 7,
Windows 8, Windows 10)
Windows Server® (Windows 2003
Server, Windows 2008 Server)
Open
Geospatial
Consortium

GML™

Open Source
Matters Inc

Registered Trademark:
Joomla!®

OpenSplice

OpenSplice™
OpenSplice DDS™

Oracle
Corporation

InnoDB™
MySQL™
Registered Trademarks:
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Oracle®
Java®
PostgreSQL
Community
Association
of Canada

PostgreSQL™

The Mozilla
Foundation

Bugzilla™

Python
Software
Foundation

Python™

RTI

Registered Trademarks:
RTI®
RTI Data Distribution Service®

Salesforce.co
m, Inc

Salesforce

Secretary of
State for
Defence
(USA)

Registered Trademark:
DODAF®

ServiceNow,

Registered Trademark:
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Inc

ServiceNow®

Sybase Inc

Sybase Central™
Registered Trademarks:
Adaptive Server®
Adaptive Server® Anywhere
Adaptive Server® Enterprise
SQL Anywhere®
Sybase®

The Apache
Software
Foundation

Registered Trademark:
Apache®

The Eclipse
Foundation

Eclipse™

W3C (World
Wide Web
Consortium)

Registered Trademarks:
W3C®

Wrike

Registered Trademarks:
Wrike®

Zachman
International

Zachman Framework™
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Registered Trademarks:
Zachman®
Zachman International®
The Object
Management
Group
(OMG)
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BPMN™
Business Process Model and Notation™
CORBAfacilities™
CORBAmed™
CORBAnet™
CORBAservices™
CWM™
DDS™
Executable UML™
IDL™
MARTE™
Model Driven Architecture™
MOF™
Object Management Group™
Object Request Broker™
OMG™
OMG Interface Definition Language™
OMGL™
OMG MDA™
OMG Model Driven Architecture™
OMG SysML™
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ORB™
The CORBA Academy design
The CORBA logo
Unified Modeling Language™
Registered Trademarks:
CORBA®
CORBA Academy®
IIOP®
MDA®
SoaML®
SysML®
The OMG Object Management Group
logo
The Information Brokerage®
The UML Cube logo
UML®
XMI®
The Open
Group
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The Trial Edition

The fully functional 30 day Trial Edition of Enterprise
Architect is available free of charge on the Sparx Systems
website
(https://sparxsystems.com/products/ea/trial/request.html).
The Trial Edition is identical to the registered edition except
that all diagrams are output to files with an embedded
watermark, and certain features are read-only.

Trial Details
Option

Detail

Try Out
Editions

You can use the Trial Edition to explore
and evaluate Enterprise Architect,
checking the edition you are interested in
and trying out other editions for
comparison.
When you start up the Enterprise
Architect Trial Edition, the 'Select Trial
Version' prompt displays; select the mode
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to trial.
If necessary, you can close down
Enterprise Architect and restart it in
another mode for comparison.
The prompt also directs you to useful
information such as a walkthrough of the
Enterprise Architect facilities, and
options to select one of several
workspace layouts.
Trial Period
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As you are evaluating the Enterprise
Architect Trial Edition, note that the
software operates for a limited period,
and denies access after the trial period
has elapsed.
To continue using Enterprise Architect
when the trial period expires, you can
either:
· Apply to extend the trial period, or
· Purchase and register a full license; on
purchase of a suitable license or
licenses, the registered edition is made
available for download
The latest information on pricing and
purchasing is available on the Sparx
Systems website; for more information,
contact Sparx Systems by email.
When you order and pay for an edition of
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Enterprise Architect, you receive
installation instructions and the location
of the executable files for download.
Extend Trial
Period

If you are testing the Trial Edition and
require more than 30 days to evaluate it,
you can apply to Sparx Systems Sales for
an extension of the trial period.
The trial period must expire before you
can enter the extension key.

Extend the Trial Period After Receipt of
Extension Key
Ste Action
p
1

Open the Enterprise Architect Trial Edition.
The 'Evaluation Version of Enterprise Architect'
dialog displays; once the trial period has expired,
you cannot proceed beyond this dialog without
extending the trial period.

2

Press Ctrl whilst you click on the Continue Trial
button.
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The 'Upgrade Key' dialog displays.
3

In the 'Upgrade Key' field, type or copy-and-paste
the extension key you received from Sparx Systems
Sales.

4

Click on the OK button.
Enterprise Architect confirms that your trial period
has been extended.
Your trial period is extended by the period of days
stated in the email from Sparx Systems Sales; you
can now restart and continue to use the Trial Edition
of Enterprise Architect.
The trial extension displays an error if you enter
anything other than a valid trial extension key; it
does not accept registration keys for purchased
editions of Enterprise Architect - you must download
the correct installer for your purchased edition, from
the Sparx Systems website.
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Install the Trial Edition
This topic briefly describes how to install the Enterprise
Architect Trial Edition, a free, fully-functional application
that enables you to explore the user interface and facilities
of Enterprise Architect for a 30 day period, in the
configuration of whichever editions of the registered
software you want to try out. You can - on application to
Sparx Sales - extend the trial period for an additional 30 or
even 60 days.
The installation procedure described here is generic. For
system requirements and information relevant to particular
operating systems, see the Enterprise Architect Help topic
Installation (Product Information > Ordering and
Installation > Installation).

Installation Procedure
Download the latest installer for the Trial Edition from the
Sparx Systems web site.
Download the Trial Version
(http://sparxsystems.com/products/ea/trial/request.html)
When the download is complete, double-click on the
installer file to begin the installation. The installer will guide
you through the installation process.
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Click on the Next button.

Read the License Agreement, click on the 'I accept the terms
in the License Agreement' checkbox and click on the Next
button.
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Read the 'Readme Information' and click on the Next button.

Click on the Next button to install the Trial Edition to the
default location.
If you need to install to a special location, click on the
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Change button and provide a different path, click on the OK
button and then on the Next button.

Click on the Install button, and observe the 'Status' bar
indicate the progress of the Enterprise Architect installation.
The dialog changes automatically.
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Click on the Finish button and check that the Enterprise
Architect icon is displayed on your workstation desktop.

You have installed the Enterprise Architect Trial Edition.
Double-click on the icon to open the product.
The Enterprise Architect workspace displays, overlaid by
the 'Trial Version' screen.
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Over time, the dialog shows a count-down of the days left in
the trial period. During the trial period, read the Help topic
on The Trial Edition (Product Information > The Trial
Edition), which explains how to extend the trial period.
The screen also displays a radio button for each of the
editions of Enterprise Architect that you can try out. This
screen displays whenever you open the Trial Edition, so you
can explore different editions as many times as you want
within the trial period.
Click on the radio button for any edition (for the purposes of
this guide, it does not matter which) and click on the
Continue Trial button.
The Enterprise Architect workspace displays.
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We provide a simple guide - Guide to the Trial Edition - to
help you learn about the user interface and how to start
modeling with Enterprise Architect. Refer to that guide now.

Notes
·

·

You cannot 'convert' the Trial Edition into the purchased
registered product; you uninstall the Trial Edition before
installing a registered edition
The Trial Edition is available from an 'open' web page,
whilst the registered editions are downloaded from a
registered user web page, which you can access only by
entering user credentials; these credentials are provided to
you when you purchase the registered product
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Guide to the Trial Edition
Thank you for downloading the Trial Edition of Enterprise
Architect and taking this time to become acquainted with
what the tool suite has to offer. We hope this short Guide
will prove helpful in showing you how to get started and
understand some of the crucial modeling concepts
underlying the tool.
Over the next 30 days you will have the opportunity to
test-drive Enterprise Architect in all its different editions
and find out for yourself how it can help visualize, examine,
verify and enhance your understanding of complex solution
domains across the Business, Software, Systems and
Architecture areas.
This Guide is intended to supplement and support your
initial contact with Enterprise Architect, and covers the
more important concepts and behaviors that are critical to
getting the most out of the tool.
Here is an overview of the Guide and its intended purpose:
· Part 1 is a brief introduction to some important concepts
concerning the tool, its repository based modeling and the
general function of the user interface
· Part 2 will step you through starting up Enterprise
Architect, finding the most common and necessary
controls and windows, and learning how to customize the
user interface
· Part 3 will walk through creating a new model, setting a
Perspective and using pattern-based model fragments to
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fast track model construction
· Part 4 is a collection of 'where to next' suggested links to
other material that will enhance and enrich your Trial
experience, depending on your personal requirements
Please take the time to read through this document if you are
a newcomer to Enterprise Architect, as it covers some of the
most fundamental concepts and tools you will be using
during this trial period. Enterprise Architect is an incredibly
rich and extremely effective modeling and design tool that
implements many technologies, frameworks and tools.
Walking through this Guide will help you find the right
tools and right modeling language(s) for your needs.
Thanks once again for taking the time to try out Enterprise
Architect. If you have any problems with installation or
getting started, please contact the Sparx Systems Trial
support team, at trial-assist@sparxsystems.com.
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Part 1 - Concepts
More than a Drawing Tool
One of the most important concepts underlying Enterprise
Architect is that it is far more than a simple drawing tool.
Unlike many of the simple drawing tools that sometimes
present themselves as modeling tools, in Enterprise
Architect all models are stored in and built on very detailed
and rich repositories. Some important results of this
approach are:
· A diagram in Enterprise Architect is a view of some part
of the underlying model
· Model elements can appear in multiple diagrams
· Updating an element in one diagram will update it in all
other diagrams it appears in
· Connections between elements are first-level model
elements, not just visual representations
· The Browser window (a UI window you will learn about
later) is the doorway into the model itself
· The Diagram Toolbox has a palette of appropriate
elements for the current diagram type and modeling
language
· Elements from modeling languages have special
properties, characteristics and linkage restrictions
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Repository Based Modeling
A model Repository in Enterprise Architect can be
implemented in a number of ways, depending on need.
Regardless of the type it is important to note that you must
create or open a repository before you can do any modeling.
Some typical repository types include:
· A single file (.eap/.eapx/.fdb/.feap) which is typically
used by a single developer
· A DBMS (Oracle, SQL Server, MySQL ...) based
repository used by workgroups and larger teams
· An internal LAN based Sparx Cloud-Server repository
(with .FDB or DBMS back end) for simplified
deployment, efficiency and other benefits
· A web facing Sparx Cloud-Server repository for globally
distributed development, stakeholder access, optimization
and more
The kind of modeling you will do usually determines the
kind of repository you will need. For the purposes of your
Trial, the single file approach will be the easiest to start
with, unless you have access to some pre-existing larger
repositories. This guide will assume a single file as the
simplest solution to get started with. But remember, your
single file model can always be scaled up later into a full
DBMS or Cloud based repository if required!
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Technologies, Perspectives & Frameworks
Another term you will come across a lot in learning about
Enterprise Architect is 'Technology'. In this special case,
what is meant is a collection of domain-related modeling
elements that together form a unique modeling language.
For example, UML 2.5 is an open standard modeling
language supported by Enterprise Architect; it is commonly
referred to as the 'UML Technology' or 'UML Perspective'.
Technologies
· A Technology is a collection of related modeling elements
forming a modeling language
· A Technology in Enterprise Architect can also include
scripts, shapes, document templates, patterns and other
useful artifacts
· Technologies can be turned on and off as required in a
model repository
Patterns
· Patterns are collections of re-usable modeled content, for
example a basic Use Case Model or simple Class Model
· Patterns are used to kick start modeling and speed up the
creation of common modeling solutions
· Enterprise Architect includes a collection of over 1000
patterns with detailed explanations, in many different
modeling languages
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Perspectives
· A Perspective is a constraint placed upon the user
interface to only show a particular technology or set of
technologies
· A Perspective is used to reduce complexity and help you
focus on your task
Frameworks
· A Framework is a collection of patterns, modeling
languages and other material that together support a
modeling approach
· Frameworks can aggregate different modeling languages
and often help determine model structure
As you work through your 30 day Trial, you will become
very familiar with these terms and see how each contributes
to your modeling expressiveness and effectiveness.

Things you can do with a Model
Because an Enterprise Architect model is repository based
with a rich set of connections, meta-information and other
material supporting the visual aspect, it is possible to take
the model and create a wide range of new material from the
model itself. Some possibilities include:
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Documents in rich text or PDF format that expose
underlying aspects of the model as well as the visual
representations
· Code generation from Class models and from behavioral
models
· Model interchange material in XMI and other formats so
that your model can be read and acted on by other tools
· Simulations of behavioral models in a variety of formats
such as BPSim, DMN, State Models, Activity Graphs and
more
· Applying a range of mathematical simulation tools to
Systems simulation and Dynamic simulation
· SysML simulation with OpenModelica or MATLAB
· Conduct reviews of model content
· Make models accessible online with WebEA and
ProCloud Server
Once you move your model in a DBMS or Cloud based
repository you might also implement model security to
control who can modify the model and control locking on
individual elements. In the Ultimate Edition you might also
implement Row Level Security and control which users can
see what parts of the model.
For the ambitious it is also possible to access the underlying
model using the automation (Active-X) interface of
Enterprise Architect using scripts and Plug-ins, or if
accessing a Sparx Pro-Cloud Server, via the OSLC interface
- a RESTful API for exploring and modifying the model
using standard web based calls.
·
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Next Step
Having installed the Enterprise Architect Trial Edition, you
can now start it up and explore it. Please refer to the next
section 'Part 2.0 - First Contact'.
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Part 2 - First Contact
Starting Enterprise Architect
We hope you are now familiar with the concepts presented
in Part 1 of this Guide. It's now time to start up Enterprise
Architect and find your way around the user interface.
Along the way you will make a few choices to help tailor
the Trial Edition to your purpose. Note that any decisions
you make are not final and can be changed by restarting
Enterprise Architect or using the various preference tools to
customize your experience.
Assuming you have installed Enterprise Architect you can
now click on the desktop icon (if available) or find the
shortcut in the Start Menu if preferred. Presuming
everything is in place we are now on our way.

Some House-keeping
During the process of opening the Trial, a dialog will pop
up.
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This dialog confirms that you have started using the Trial
Edition for the 30-day trial period, and provides an option
for accessing the web site to review pricing and purchase
options for the product. Also displayed is set of radio
buttons from which you select the edition of Enterprise
Architect that you want to try out. Information about what
each of the different editions includes and does is available
from the website by clicking on the Compare Editions
button.
This dialog will display whenever you open the Trial
Edition, so you can explore and compare different editions
as many times as necessary within your trial period.
As shown, the dialog also displays a count-down of the days
left in your Trial period.
Click on the radio button for any edition (for the purposes of
this topic, it does not matter which) and click on the
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Continue Trial button; the main Enterprise Architect
workspace displays.

You can tailor this workspace to have a different layout,
content and appearance to support your work tasks; we will
show you how in a later topic.

First Steps
Very (very) important!
When Enterprise Architect starts up there is no current
repository selected. Before you can start modeling and
creating diagrams you will need to either open an existing
model or create a new one. If this is your first time working
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with Enterprise Architect and you don't have any existing
models to use, you should create a new file based repository
that you can experiment and play in while you learn about
modeling and using Enterprise Architect.
Let's create a new Repository file now.
Press Ctrl+N which is the hot key to create a new file based
repository
-orIn the 'New' section on the Enterprise Architect Start Page,
click on the 'Create a new project' option

Select a filename and location for your repository
You will be prompted to select a file name and location for
your new repository. Once you have chosen a name and
location, click on the OK button and Enterprise Architect
will create a new empty model for you to begin working
with.
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What has changed?
Although not much will appear to have changed, you now
have a working repository into which you can start adding
new elements and diagrams. The main thing to note is that
the Browser window now has a new root element called
'Model' which is the starting point from which you will
build your own individual repository.

Where are we now?
By now we have started up the Trial Edition, created a new
repository and loaded that repository into the Enterprise
Architect workspace. Next up we will create some new
model elements and diagrams, before moving on to a brief
overview of the user interface.
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Part 3 - Building a Model
First Steps
Now that we have a new model created and loaded into the
workspace (from Part 2), our new goal is to add some
content to the model.
There are many ways to add content, but for this first
example we will take a convenient shortcut and add model
content using a model pattern. To do this you will:
· Select an appropriate Perspective
· Select a model pattern
· Familiarize yourself with the pattern content
· Add the pattern content to your repository
· Find the new content in the Browser window and explore
any new diagrams
So let's get started ...
Selecting a Perspective
As we mentioned earlier, a Perspective is a constraint placed
on the workspace to only show a limited set of
Technologies. We can select a Perspective in a number of
ways, but for this walk through we will use the drop menu
in the 'Create from Pattern' tab of the Start Page. Our goal
will be to create a simple Use Case model that we can later
extend and customize.
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Once you have found the 'Create from Pattern' (Model
Wizard) tab, click on the
icon above the left-hand panel
and select 'UML | All UML' as shown here.

Using a Pattern
Doing this will cause the Model Wizard to show all the
UML Model Patterns (and there are quite a few!) Scroll
down until you find the 'Use Case' section and select the
'Basic Use Case Model'. You should now be looking at
something resembling this image:
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Note that the right hand side has some very useful
information about the pattern, including an image to show
what you will get, a discussion of when you should use this
pattern, additional references and other material. While
some of the terms and references might be unfamiliar at this
stage, it would be a good idea to do a quick read through to
become aware of what we are adding to the new model.
When you have finished reading, click on the Create
Model(s) button located in the lower left corner of the
Model Wizard. Enterprise Architect will now create new
model elements, diagrams and Packages as required to make
a copy of this pattern for you to customize and play with.
Lets look at the Browser window
Ok, now that we have created our first model content, let's
take a look at what we have added. To do this, take a look at
the Browser window.
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As you can see from this image, there is new content that
has been added to the model. This includes a top level
Package and diagram, and some Actors and Use cases
(within the 'Actors' and 'Use Cases' Packages). Let's take a
look at this in detail.
Double-click on the 'Basic Use Case Model' diagram link to
show the graphical view of what we have. You should see
this diagram:
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In this diagram you can see several Actors and Use Cases. If
you click on one of the Actors and then press Alt+G, or
right-click and choose 'Find | In Project Browser' from the
context menu, the 'Actors' Package is expanded and the
element selected in the diagram will be selected in the
Browser window, as shown here.
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As you can see, there is an underlying model-level element
in the Browser window that has a graphical representation in
a diagram. Note that you can place a single model element
in as many diagrams as you like, and that changing the name
or notes or other element properties will be reflected
immediately in all diagrams in which the element has been
placed.

Working with Properties
Let's take a closer look at one of the elements and see what
kind of information you can add to describe in detail what a
particular element's purpose and behavior can be.
There are many property windows in Enterprise Architect,
and for this walk-through we will look at a few of the most
important. There are many shortcuts and keystrokes to bring
up different property sheets, but for now it is simplest to
access them from the main ribbon:
Start > All Windows > Properties > General > Properties
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The Properties Window
Let's start with a look at the main Properties window. Select
the 'Properties' item from the 'Start > All Windows
>Properties > General > Properties' ribbon menu.
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As you select items on the diagram or in the Browser
window, you can see the Properties window change to
reflect the appropriate settings and content for the current
selection. If you click on an Actor, you will see the Actor's
name and many other settings. If you select a relationship
between a Use Case and an Actor, you will see the
Properties window change to reflect this new type of thing
(connector). If you click on blank space on the diagram, the
diagram itself will become the current selection and the
appropriate properties will be available in the Properties
window.
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Note that when you select an element in a diagram and then
switch to the same element in the Browser window, the
properties do not change as the two visual elements are
actually representations of the same single element.
You can change some element properties by editing the
selected item in the Properties window. Try changing an
Actor's name, Alias, Keywords or Status.
The Notes Window
A second very important window to become familiar with is
the Notes window. This window is where you will type your
descriptive text about an object's purpose and any other
relevant information necessary to fully and completely
describe that object. This is one of the most important
windows because when it comes to other people reading and
understanding your model, the Notes and descriptive text
are one of the major determinants of how useful and
expressive your model actually is.

Select the 'Notes' item from the 'Start > All Windows >
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Design > Create > Notes' ribbon option.
(Shortcut key is Ctrl+3)
Try entering some notes for different elements.
The Responsibility Window
Another major window you should learn to use is the
Responsibility window. This has several tabs, each of which
provides important modeling detail.
You can access the Responsibility window using the ribbon
option: 'Start > All Windows > Properties > Responsibilities
> Responsibilities'.
On the window select from the tabs: 'Requirements' or
'Constraints' or 'Scenarios' or 'Files'.
(Shortcut key Ctrl+4)
Let's look at each in detail:
1. Firstly there is the 'Requirements' tab. This tab lets you
add Requirements for an element that represent
responsibilities that particular element must satisfy. These
are sometimes referred to as 'Internal Requirements' to
distinguish them from the more general System
Requirements that can involve multiple elements.
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2. Secondly there is the 'Constraints' tab. This tab lets you
enter restrictions and constraints on an element's behavior,
capability or structure. Many advanced behavioral models
use the 'Constraints' tab to specify, in detail, how a system
will function.

3. The third tab is the 'Scenarios' tab. This tab lets you either
enter simple text or (when you click on the Edit button for
a Scenario) use the Structured Scenario editor to build
detailed descriptions of how an element will behave in a
certain situation. Scenarios are most frequently used with
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Use Cases, but can be used with any element type where
appropriate, to explain some aspect of model behavior.

4. The final tab is the 'Files' tab, which simply lists any
external files that have been associated with the element.
You can easily add files to the list, by right-clicking on it
and selecting the 'Add New' option on the menu, and
specifying the file path. You open a file by selecting the
'Launch File' option on the same menu. Files you might
associate and access here could include a Statement of
Requirements spreadsheet or a User Story document.
There are many (many) more property windows in
Enterprise Architect that are used to describe and edit
element specifications. We have seen a few of these now,
and as you become more familiar with the tool, you should
experiment with others as the occasion arises.
Getting Help
In general, pressing F1 while the focus is in a Properties
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window will activate the Help for that window and you can
read about the window's purpose and general usage.

Working with Diagrams
Diagrams are the visual representation of the model and
provide one or more windows into the model's structure and
behavior. Learning to work with diagrams is an essential
part of modeling with Enterprise Architect. We will look at
some of the most fundamental aspects of using diagrams to
view and build models.
Basic Skills
Open a Diagram
If you want to view or work with an existing diagram, you
can open it by double-clicking on its icon in the Browser
window. For this short introduction, you should locate the
Basic Use Case Model diagram we created earlier and
double-click on its icon to open it. If it is already open it will
be selected and become the focus window.
Selecting and moving elements
Now that we have our diagram open, try clicking on
elements to select them. Once selected you can click and
drag to move, right-click to select actions from a context
menu, observe or work with an element's properties in the
various property windows and/or modify an element's
appearance and other visual characteristics. Note that you
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can also click on connecting relationships between elements
and likewise edit and view properties, appearance and
positioning.
The Layout Ribbon
The third Ribbon category is 'Layout' and it is the main
ribbon category devoted to manipulating the appearance of
diagrams. There are commands to change diagram themes,
set element appearance, align and format elements, layout
diagrams and filter diagram content. Many of these tools are
described in detail in the Help, so take the time to read up on
the tools and actions available so you can make the most of
your diagrams.
Basic Editing
Adding a Scenario diagram to a Use Case
Now that we have some familiarity with diagrams, let's add
a new one and build up a simple Sequence diagram
indicating the flow of actions and responses between an
Actor and a Use Case. First we will need to select a Use
Case in the Browser window that will contain the new
Sequence diagram (or Interaction).
Create the Diagram
To begin with, click on 'Use Case A' in the Browser window
to select it. Now, right-click on it to display a context menu
and select 'Add | Interaction | with Sequence Diagram'. Give
the new Interaction a name and click on the OK button.
You should now have something similar to this image in
your Browser window.
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Note that there is a new Interaction container with an empty
Sequence diagram. Double-click on the Sequence diagram
icon to make it the new default workspace. Now you will
have a blank diagram workspace. Click on the
double-arrows icon at the left end of the diagram title bar to
open the Diagram Toolbox. The Toolbox changes to show
elements that are appropriate to the current diagram. In this
case it shows elements commonly used in Sequence
diagrams. Firstly though, we will make use of our model
and place a link to the relevant Actor onto our diagram.
In our original diagram, Use Case A had a relationship to
Actor A, so let's find Actor A in the Browser window and
drag and drop it onto the new diagram.
In the dialog that pops up, select 'Link' as the type of
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placement required and click on the OK button.
A new visual representation of Actor A is now created and
placed onto the Sequence diagram as a Lifeline.
Next, we need to add a Boundary element to represent the
system being modeled and how it will interact with our
Actor. From the toolbox, click on the Boundary icon and
then click to the right of the Actor lifeline. Use the
Properties window to rename the Boundary element as
'System'. You should now have a diagram that resembles
this image:

OK - we now have an Actor and a System and we want to
represent the flow of Action and Response between the two
entities. We can model this using messages between the
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two.
Click back on the Actor Lifeline and look for the Quicklink
button - this is a small 'up arrow' located just at the right
edge of the selected element, and is only visible when the
element is selected.

Now, click-and-hold on the Quicklink button, then drag
across to the System Lifeline and release. This creates a
new message in our model, between Actor A and System.
Select the new message on the diagram and note that the
Properties window updates to show the properties of the
new connector, allowing you to edit the details. After
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entering a few details for the message and clicking the Save
button, your diagram workspace should resemble this
image:

A return message can be created in similar fashion, by
clicking on System, then dragging its Quicklink button
across to the Actor. Select the new message on the diagram
and fill in the details in the Connector Properties window.
In the 'Control Flow Type' section of the Properties window,
select the option 'Is Return'. Your diagram should now
display the return message, similar to this image:
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Building the Model
1. Basic Skills
The Design Ribbon
The Design ribbon groups together commands that are used
for creating and modifying model items, such as elements,
diagrams and Packages.
It provides access to a number of windows, such as the
Properties window, Features window and Responsibility
window, as well as commands for viewing Package content
and diagram content as lists or Gantt charts.
(c) Sparx Systems 2022

Page 197 of 524

Getting Started

3 October, 2022

Take a few moments now to explore the different menus and
sub-menus presented by the Design ribbon.
We will now use the Design ribbon to perform some basic
modeling tasks, such as creating a new Package and creating
a new diagram within the Package, before creating some
new elements and connectors on the diagram. In this
example, we will create a simple Class model.
Create a Package
We will create a new Package under the Model Root node,
so click on this node in the 'Project' tab of the Browser
window then, from the Design ribbon 'Model' panel, choose
'Add > Package'. The 'New Package' dialog will open. Here,
you can enter a name for your new Package and you can
choose to create a Package only, create a Package with a
diagram, or choose a model pattern to insert into the new
Package.
For this walk-through, choose 'Package Only', enter a name
for the Package, such as 'My Class Model', then click on the
OK button. You should see the new Package in the 'Project'
tab of the Browser window, as a child of the Model Root
node.
Create a Diagram
Now, we will create a Class diagram within the new
Package.
Click on the Package in the 'Project' tab of the Browser
window then, from the Design ribbon 'Diagram' panel,
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choose 'Add'. The 'New Diagram' dialog will appear.
The default name for a diagram is the same name as its
parent Package; leave this as it is.
In the 'Type' section, select from 'UML Structural', and
choose the diagram type 'Class'. Click on the OK button.
The new Class diagram will appear in the 'Project' tab of the
Browser window and it will open in the main diagram
workspace.
Diagram Toolbox
The Diagram Toolbox pages provide a palette of elements
and connectors that can be selected and dropped onto the
currently open diagram. Doing so creates a new element or
connector of the selected type within your model and
displays it on the diagram where you dropped it. The
Toolbox pages display a set of elements and connectors that
are commonly used with the current diagram type; this set
changes as you open diagrams of different types.
Open the Diagram Toolbox now by clicking the 'Toolbox'
icon in the 'Diagram' panel of the Design ribbon. The
Toolbox is displayed on the left side of the diagram
workspace.
This image shows the new, empty Class diagram and, beside
it, the Diagram Toolbox pages showing the elements and
connectors appropriate for working with Class diagrams.
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Add elements to the diagram
Let's now use the Diagram Toolbox to add some elements to
our Class diagram.
Select the Class element in the Toolbox, then click on the
empty diagram. A new Class named 'Class1' is created in
your model and placed onto the open diagram. The Class
name 'Class1' is applied by default. You can type a new
name into the Class on the diagram, or you can change the
name later using the Properties window. Create a second
Class on the diagram by again selecting 'Class' in the
Toolbox and dragging it onto the diagram.
Your workspace should now resemble this image:
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To create a relationship between two elements on a diagram,
simply select a relationship type in the Diagram Toolbox,
then drag a line from one element on the diagram to another.
Most relationships are directional, so dragging a link from
Class1 to Class2 is different to dragging a link from Class2
to Class1.
Click on the Generalize relationship in the Diagram Toolbox
then, on the diagram, drag a line from Class2 to Class1.
The relationship that is created indicates that Class1 is a
generalization of Class2.
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Add Elements Using Quick Linker
We briefly looked at the Quick Linker in Working with
Diagrams, where we created links between two elements in
the form of Interaction messages. Now we are going to use
the Quick Linker to create a new element at the same time
as creating a new relationship from an existing element.
In the diagram 'My Class Model', click on Class1 to select it.
The Quick Linker arrow should be visible beside the
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top-right corner of Class1. Click and drag the Quick Linker
arrow to the right, releasing the mouse button in empty
space on the diagram. This action displays a pop-up menu
that prompts you to choose a relationship type, then an
element type. From the menu, choose 'Realization |
Interface'.

The resulting connector and element are shown here:
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2. Using Perspectives and Model Patterns
Enterprise Architect offers a wide range of different
Perspectives that cater to the many different kinds of
modeling you can perform. As mentioned earlier, a
Perspective is a constraint placed upon the user interface to
only show a particular technology or set of technologies. It
is used to reduce complexity and help you focus on your
task.
Add a Requirements Model
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We will now build a simple Requirements Model in our
project. Firstly, let's select one of the Requirements
Perspectives. From the 'Perspectives' menu, choose
'Requirements | Requirements'.

After we select the Requirements Perspective, the 'Create
from Pattern' tab (the Model Wizard) of the Start Page is
displayed in the main workspace area, offering just a
selection of basic Requirement model patterns. Firstly, we
should choose where in the model this new content will be
added. Click on the folder icon beside the 'Add To:' field at
the bottom of the Model Wizard page, then choose the
Model root node and click on the OK button. Now, let's
select the pattern 'Two Level Requirement Hierarchy' and
click on the Create Model(s) button.
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The selected model pattern is added to our model under the
Model root node.

Double-click on the diagram link in the 'Project' tab of the
Browser window to open the diagram in the main diagram
workspace. You can then select elements on the diagram (or
in the 'Project' tab) and use the Properties window to tailor
them to your own use, by renaming them, entering
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descriptions in the Notes window or setting other properties
as required.
Add a Class Model
We will now add a simple Class Model to our project,
following a procedure similar to the one we have just used.
From the Perspectives menu, choose 'UML | Structural'.

The 'Create from Pattern' tab (the Model Wizard) of the
Start Page is displayed, showing the Structural Perspective.
Scroll through the list to find the Class diagrams, then click
on 'Basic Class Diagram with Operations'. Click the folder
icon beside the 'Add To:' field and choose the Model Root
node as the location in which to add the new model content.
Finally, click on the Create Model(s) button to add the new
model content to your project.
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The selected model pattern is added to your project; the
Packages, diagram and elements are shown in the 'Project'
tab of the Browser window.

Double-click on the diagram link 'Basic Class Diagram with
Operation' in the Browser window. This opens the diagram
in the main workspace. Now, we will use the Features
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window to view the operations of Class A.
From the 'Explore' panel of the Start ribbon, choose the
menu item 'Properties > Features'. The Features window is
displayed; select the 'Operations' tab of this window.
Now click on Class A in the diagram (or in the 'Project' tab
of the Browser window). You will notice that as soon as
Class A is selected, the details of its operations are
displayed in the Features window. Here you can modify an
existing operation, by changing its name, its return type or
even its parameter list. When you select an operation in this
list, the Properties window switches to Operation Properties,
and displays details of the selected operation.
You can also use the Features window to define new
operations, by simply typing a name into the list where it
says "New Operation...".
This image shows the Features window when Class A is
selected on the diagram and the Operation Properties
window when Operation B is selected in the Features
window.
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We have walked you through some simple modeling
operations to give you a basic understanding of how you
might use Perspectives and Model Patterns to create model
structures that you can use as a starting point for creating
your own models.
We have also demonstrated using the 'Project' tab of the
Browser window to navigate through the model, using the
Diagram Toolbox to add new content to your model via the
diagram and using various Properties windows to inspect
and modify the properties of various model elements.
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Part 4 - Where to Now?
Having created a model in a repository, you might now like
to see how your work can be further supported by tailoring
the Enterprise Architect work area to your requirements.
You can also re-visit the tools you have used, and learn a
little more about them and about other tools and facilities
that are equally valuable in helping you develop and manage
your models.

Customize the Workspace
When you first open Enterprise Architect, you see the
default layout of the user interface. You can change the
layout and appearance of the interface in many, many ways,
hiding windows you don't need, organizing the dialogs you
do need in the most convenient configuration, changing the
display colors and texts, and much more, to suit your
personal preference, the area of work you are responsible for
and the tasks you perform.
The sections here show you where you can perform this
customization.
Change Visual Style
The illustrations of the user interface you have seen in the
Guide have a particular color and appearance - or visual
style. You can change this style to one of several
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alternatives, using the 'Application Look' dialog (select the
'Start > Appearance > Visual Style' ribbon option).

The first three fields on the dialog have the greatest visual
impact. Try experimenting with changing the values; you
can click on the Apply button and see the effect without
having to close the dialog. Note that for some of the
permutations you do not need to have values in all three
fields.
Set Some Major Preferences
Preferences are aspects of the system that you personalize so
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that every project you open in Enterprise Architect, on your
workstation and under your user ID, looks and behaves in
the same way - the way you want them to! Each user might
see the same project differently, according to their own
preferences.
You start by displaying the 'Preferences' dialog (select the
'Start > Appearance > Preferences > Preferences' ribbon
option).

As you can see there are many pages of options you can set,
although not all options will be important to you. Click on
the page names on the left of the dialog to review the
options that are available. If you want an explanation of a
setting, click on the Help button to display a description of
every setting on the page.
The most visible preferences are the object colors on
diagrams. Open a diagram and then change the settings on
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the 'Diagram > Standard Colors' page of the dialog. Every
setting has an option to revert to the default color, so you
can try all sorts of combinations without losing the standard
settings.
Customize Ribbon Categories
The ribbons at the top of the work area together provide
access to almost every tool and facility of Enterprise
Architect, but as you are unlikely to use every tool and
facility you might consider tailoring the ribbons to exclude
things you do not need. You first display the 'My Ribbon
Sets' tab of the 'Workspace Layout' dialog (select the 'Start >
All Windows > Workspace > Workspace Tools > My
Ribbon Sets' option).

Click on the New button and type in a name for your custom
ribbon display. You will see that all the ribbons are now
listed in the 'Configure Ribbons' panel, and if you expand a
ribbon name the sections of that ribbon are also shown. For
every ribbon and section that you don't need, you clear the
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selected checkbox so that the ribbon or section will be
excluded from the ribbon bar.
Click on the Apply button to update the ribbon display. If
you want to reinstate the default full ribbon set, click on the
background of the 'Create Ribbon Set' panel and click on the
Reset button.
Putting Things in their Place
When you open Enterprise Architect for the first time, the
various windows are in position around the display. These
windows - and others that you open - do not have to stay in
those positions, you can simply click on the window name
and drag the window to a more convenient spot on the
display.
Alternatively, you can dock a window exactly where you
put it, so it stays there, open, across many work sessions.
As you move a window, a 'compass' icon displays in the
center of the screen and a 'compass point' icon displays on
each edge.

When you move the window over a compass point, an area
of the display turns blue. This is the area that the window
will occupy when you drop and dock it. You can then adjust
the window borders to suit.
If there is another window in the docking area another
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compass displays there, with a square in the middle. The
compass points dock the dragged window above, below, or
to the side of the other current window, whilst the square
makes it a tab of the same frame as that window.
Using the Workspace facilities
Docking a window puts one window in position at a time,
but many of the windows can be used in combination, so to
save you from working out, building and positioning those
combinations, the system provides them for you and gives
you the tools to quickly apply them! These tools form the
Workspace facility (select the 'Start > All Windows >
Workspace > Workspace Tools > Workspaces' ribbon
option).
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Before you try out some layouts, clear the 'Close on Apply'
checkbox, so that you can try different layouts without
having to re-open the dialog. Select a layout (such as
'Debug') and click on the Apply button.
You can set a system-defined layout and then move
individual windows, or otherwise create a layout that better
suits you. Having done that, you can save it as a personal
layout by selecting the 'Start > All Windows > Workspace >
Workspace Tools > Save Workspace' ribbon option, which
prompts you to give your layout a name. If you use some
other layout you can come back to yours by selecting it on
the 'My Workspaces' tab of the 'Workspace Layout' dialog.
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Going Back to Work
You do a lot of work using windows such as the Diagram
View (with several diagrams as tabs, perhaps), Relationship
Matrix and Model Search.
Having reached the end of a work session, you might want
to start your next work session by picking up where you left
off. You can capture your current work status using the
Working Sets window (select the 'Start > All Windows >
Workspace > Manage Working Sets' ribbon option).
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You right-click on the central panel of the 'Manage Working
Sets' dialog and select the 'Store Main Tab View History'
option, which captures the views that you have open as you
close down your work station. If you also select the 'Apply
When Model Opens' option, the system will automatically
open those views when you open your model in the next
work session. Alternatively, you could use the 'Open
Working Set' option when you are ready to resume that
work, if you need to do something else first.

Quick Reference
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Ribbons in Brief
Ribbons, shown at the top of the work area, provide access
to almost every tool and facility in Enterprise Architect.
Each ribbon supports a domain of work - such as designing
the model components and structure - and is divided into
segments to group the tools and facilities according to the
structure or function the tools support.

This example is the Start ribbon, which provides access to
tools for organizing your work and your work area. In
particular, look at the options in the 'Application' panel,
which provides the tools for seeing what is in your model
and where particular objects are. These tools include:
· Browsers - such as the 'Project' tab of the Browser
window
· Properties displays - such as the Properties window itself
and windows showing Notes, related Documents, Features
and Constraints
· The Trace facilities for examining and tracing
relationships between pairs of elements and sequences of
elements
Portals Window
The Portals Window displays one of eleven Portals, and
provides the facility for switching to a different Portal. The
Portals identify tasks in particular areas of work, and
provide links to the window or dialog for performing each
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task. The Guidebook and Learning Portals provide links to
online information that describes a feature of Enterprise
Architect and how to work with it. You display the Portals
window by selecting the 'Explore > Portals' option at the left
end of the ribbon bar.

Perspectives
Perspectives refine the model development facilities in
Enterprise Architect to support a particular technology or
domain, The most visible effects of setting a Perspective are
that the contents of the Diagram Toolbox are restricted to
those element and connector sets used in the domain, and
the model Patterns are tailored to generate diagram and/or
model structures of exactly the type for modeling in your
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selected area.
You can list and select the Perspectives from the
'Perspective' drop-down list in the top right of the display.

Collaboration
If you are working as a member of a team, you will need to
contact colleagues with anything from a quick question to a
list of formal review comments. Whichever type of message
you want to send, Enterprise Architect has a facility to
create and deliver that message.
You can access the facilities through the 'Start >
Collaborate' ribbon segment, selecting the 'Discussions',
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'Review' or 'Mail' options. The Discussions option gives you
a Chat facility too.

(Note that the Mail and Chat facilities operate on user IDs,
which cannot be set in the Trial Edition. The windows
display, but you cannot send a message.)
Shortcut Keys
Many of the facilities and operations in Enterprise Architect
can be selected by pressing keyboard keys as well as by
selecting ribbon or menu options.
For a list of the keyboard shortcuts you can use, access the
Learning Portal (select the 'Explore > Portals > Learning'
ribbon option) and look at the Keyboard Shortcuts and
Diagram Shortcuts topics under the 'Quick Reference'
heading.

Resources You Can Use
Help
At any time, if you want information on the purpose of a
screen or how to complete it, you can select one of these
options to display the Help topic describing that screen:
· Press F1
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Click on the icon in the screen header, or
· Click on the Help button at the bottom of the screen
Or you can access the Help by selecting the 'Start > Help >
Help > Open Help System' ribbon option.
Each Help topic displays as a web page. You can click on
the list of topics on the left of the page to explore related
and/or more detailed topics, or click on a point in the
'breadcrumb' trail above the topic to access more conceptual
topics or Help on a different subject area.
·

The Example Model (EAExample)
The Example model is a collection of model fragments,
brought together into a single model, to illustrate the many
different ways to use Enterprise Architect across a broad
range of model domains. The Example model does not
represent a model of a working system, instead it provides
samples from many disparate systems.
The example model is provided as part of the Enterprise
Architect product installation and you can open it from the
'Help' panel of the 'Start' ribbon, selecting 'Help | Open the
Example Model'.
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When you load the EAExample model, its default diagram
'Getting Started' is loaded. The 'Getting Started' diagram
contains a series of links to other diagrams that relate to
different modeling domains, such as Business Modeling or
Systems Modeling, as well as some of the tasks you might
want to perform in Enterprise Architect, such as Project
Management and Publishing. Double-clicking on a diagram
link will open the diagram. The next level of diagrams
typically contain a description and some instructions on how
to access related features in Enterprise Architect, and further
links to model examples for that area of interest.
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As an example, try double-clicking on 'Requirements
Model' in the 'Getting Started' diagram, then 'Tracing
Requirements' on the next diagram. and finally 'Traceability
Diagrams' on the diagram with the heading 'Traceability'.
This will bring you to an example of a Traceability
Diagram.

You will find a description of what is on the Traceability
Diagram, why it is useful and how to create one for
yourself. You can right-click on the diagram itself - or its
elements - and 'Find' them in the Browser window to see
where the elements come from and how they relate to each
other.
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Webinars and Video Resources
Sparx Systems has published a number of web seminars,
tutorials and video demonstrations of the use of Enterprise
Architect tools and facilities, on our website. These
recordings are often quite short and all are easy to watch.
You can access the recordings through the Learning Portal
(select the 'Explore > Portals > Learning' ribbon option) by
clicking on the 'Resources' option under the 'About' heading.
This displays the 'Resources & Tutorials' web page, which
provides three separate icons for the webinars,
demonstration videos and tutorials.
Guidebooks
For a more in-depth discussion of Enterprise Architect's
support for an area of work, you can read one of the many
PDF Guidebooks held in the Sparx Systems online library.
You can access these through the Guidebook Portal.
You can either read a guidebook online or print it.
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The 'Lite' Edition

Enterprise Architect Lite is a free, read-only edition of
Enterprise Architect that people such as project sponsors can
use to review the project without making any changes.

The Read-Only Lite Edition
Facility

Detail

Further
Access

Users of Enterprise Architect Lite also
have wider access to:
· The Model Library, where readers can
create and read documents and
discussions concerning specific
elements
· The Discussions facility, through
which readers can make direct
comments on a specific element
· The Source Code Editor, where readers
can open and edit external source code
files, debug code, and configure and
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run Analyzer scripts
· The 'File' icon
, where readers can
copy the project or create a shortcut to
access it
· The Relationship Matrix, where readers
can export the matrix contents to a
CSV file to be opened in a spreadsheet
application
· The 'Default Hours' tab to review
project metrics
You can download the Enterprise
Architect Lite Edition (as the Enterprise
Architect Viewer) from the Sparx
Systems website.
Other
Read-Only
Options
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Release Notes
As of Enterprise Architect Release 15.2, this section of the
Help presents the Release Notes identifying the changes
made to the product in each release.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.
Click on the number of the release you want to check, to
display the Release Notes for that release.

Release 15.2
Release 15.2, released August 2020.
Also see the Enterprise Architect 15.2 page of the Sparx
Systems website.
· Release 15.2, Build 1555
· Release 15.2 Build 1556
· Release 15.2, Build 1557
· Release 15.2, Build 1558
· Release 15.2 Build 1559
· Release 15.2 Build 1560

Release 16.0
(c) Sparx Systems 2022

Page 230 of 524

Getting Started

3 October, 2022

Release 16.0 released April 2022.
Also see the Enterprise Architect 16.0 page of the Sparx
Systems website.
· Release 16.0 Build 1605
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Release 15.2
Scroll through these sections to review the changes that
have been made in Enterprise Architect for this released
build.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.
For an overview of the features of Release 15.2, also refer to
the Enterprise Architect 15.2 page of the Sparx Systems
website.

Element Formal Review
Element Review Approvers - For each element in a review,
you can assign one or more Approvers who can sign-off on
any discussion topics in the review of that element. You
can:
· Quickly message one or more of the other Approvers
using the context menu of a Discussion in the 'Reviews'
main view
· Automatically message all other Approvers for an element
when changing the Discussion status
The 'Reviews' main view has also been adjusted to provide a
more streamlined interface for managing your Reviews:
· You can filter the list of reviews to show only the statuses
that you need
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The Review list now shows a much cleaner view, leaving
more room in the window for performing the review
· Review details now show the Approvers and Discussions
for each element under review
Review Status Lock - It is now possible to set up a list of
element status values that lock the formal review of an
element so that no further review comments can be posted
against it. The lock is applied automatically when the
element assumes a defined status. This helps to preserve the
decision making process for future reference.
Reviews view updates:
· When review of an element is locked because of the
element status, the element icon now displays a '!'
indicator
· When review of an element is locked because of the
element status, but the review of that element is not
approved by all Approvers, the item now include an
additional message indicating the discrepancy
An Active Review is linked to your security user ID and can
be set to persist between work sessions on the same machine
or between parallel work sessions on different machines.
See the Model Reviews Help topic and the Review Status
Locks Page Help topic.
The new Collaborations window (see New Collaborations
Window item later in this section) now provides a quick
overview of the recent Review history:
· Filter by timeframe or element status
· Show a preview of the Discussion within the history list
·
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Easily open a selected review to open the editor and
contribute
On the 'Review' tab of the Collaborations window, you can
filter the list of Review items according to:
· Whether Approvers have been assigned to the elements
under review
· Which Approvers they are, and
· What Approval state they have set
See the Discuss & Review - History Window Help topic.
·

There have been no updates to the Help in respect to these
changes:
· Lists of Approvers are sorted by name
· Review topics are sorted to display the most recent first
· The Reviews view updates when the properties of a
reviewed element are changed
· Creating an Approver for a Review is fully functional on
Firebird databases
· The Reviews view can be included in Working Sets

Collaborate Window - Chat Tab
You can now conduct a Chat with another individual user
(defined in User Security) in the model.
The notification system for monitored Chats has been
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improved, with additional options.
Chat messages posted in a conversation with a specific user
have alternating colored backgrounds, to help separate the
messages posted by yourself and by the other user. The
layout of the tab has also been improved to allow a more
compact view.
Consecutive messages posted by the same user, with no
response between them, are bundled together in
chronological order with the most recent first. If the
messages span multiple days, the posting date is also shown
against each message.
Colored text pasted into a Chat message will be changed to
the default text color for the current Theme, to ensure it
remains visible.
An additional 'visibility filter' has been added - 'Today +', to
show messages posted today and the last 20 messages
posted prior to today.
The new Collaborations window (see New Collaborations
Window item later in this topic) now provides a quick
overview of the recent Chat history:
· Filters quickly by timeframe
· Shows a list of contributions by each user in the specified
timeframe
· Incoming messages (sent to you) are identified by a red
arrow, and outgoing messages (sent by you) by a green
arrow
The 'Chat' history tab defaults to Summary mode, which
shows:
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The last message posted in each Chat group you have
communicated with
· Chat groups grouped according to the time period of the
last posted message
See the Model Chat Help topic.
·

Collaborations Support on Diagrams
Enterprise Architect offers a new centralized function for
managing interactions with diversely separated teams.
A new diagram setting called 'Support Collaboration' is
provided on the 'Element' tab of the diagram 'Properties'
dialog. If an element on the diagram is being monitored for
new Chat or Discussion posts, the option displays an icon
next to the element when a message is posted but not yet
read.
The facility integrates with the Model Chat when using
Actors with their 'Alias' set to the security user login field:
· While the 'Chat' tab is visible, the diagram selection and
active chat are synchronized
· If a 'New Chat' notification is visible the window will also
be opened, taking you directly to that conversation
The facility provides a notification icon next to elements
based on interactions available including:
· Monitored element discussions
· Unread Chat messages with a linked user
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You can initiate a new Chat directly with a user.
See the Collaboration Support in Diagrams Help topic.
A new set of options has been added to the Hamburger icon
context menu of elements on a diagram. These options
provide access to various tabs of the Chat & Mail window,
displaying posts and messages concerning the selected
element and enabling you to send messages yourself.
See the The Context Buttons Help topic.

Collaborate Window - Comments Tab
A new 'Comments' tab has been added to the Collaborate
window to help model users record ad hoc notes and
comments as a daily log on the currently selected element,
separate from the Notes window content. It has the same
facilities as the 'Journal' tab, but can be updated by any
model user.
You can define the number of comments listed, in
chronological order starting from Today.
The 'Comment' tab also allows the selected comment to be
pinned to the currently selected element (and subsequently
unpinned).
See the The Journal Window Help topic.
The new Collaborations window (see New Collaborations
Window item later in this topic) provides a quick list of
recently-posted element comments, including a 'Modified'
column showing the date and time at which an existing
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comment was modified. The window allows you to edit the
current comment in the 'Preview' pane.
The column layout of the display is preserved across work
sessions.
See the Discuss & Review - History Window Help topic.

Discussion and Review Postings
Postings in Discussions and Reviews are now listed with the
most recent Discussion at the top. Within a Discussion,
replies are listed with the most recent reply at the end.
An additional 'visibility filter' has been added - 'Today +', to
show discussions posted today and the last 20 discussions or
responses posted prior to today.
See the Model Discussions Help topic.

New Collaborations Window based on
Discussion History/Review History Window
The Discussions History window has been renamed as the
Collaborations window, with separate tabs to identify
elements against which Review, Discussion, Chat and
Comment topics have been posted. The window also
contains the Model Mail inbox - see the Model Mail section
later in this topic.
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Additional context menu options have been included in the
window to filter the types of posting and the number of days
past during which the messages were posted.
You can open the Collaborations window using the
Ctrl+Alt+9 keyboard shortcut, and refresh the window by
pressing F5.
If you double-click on an item in the Collaborations
window, it opens the appropriate tab of the Collaborate
window with that item in focus.
See the Discuss & Review - History Window Help topic.

Model Mail
The Model Mail Inbox is now a tab of the Collaborations
window, with these changes to improve usability:
· Options are selected through the context menu, not
through Toolbar icons
· Sent Mail is displayed on a tab of the main work area
· Message display and composition is through a tab of the
main work area, but you can switch to the previous
method of using the 'Model Message' dialog if you prefer
· The list of mail messages can be filtered to show only
those received during the last 30, 60 or 90 days
See the Model Mail and Create a Message Help topics.
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Dashboard Diagrams
A new 'Dashboard' style has been added for diagrams, to
automatically lay out Chart elements so that they fill the
entire diagram display area in one of a number of different
layouts. You can select a continuous style for a scrollable
view that shows a larger number of elements.
See the Using Dashboard Styles Help topic.

Focus Window
A new Focus window has been added to provide access to:
· The Model Views facility (which has been moved from
the Portals window)
· A 'Working Sets' tab to create and apply combinations of
open diagrams and facilities that you have just been
working in and/or intend to use over a period of time
(moved from the Working Sets Portal)
· A 'Quick Find' search tab for elements and diagrams
· A 'Revisit' tab listing diagrams, documents, windows and
files that you have recently opened (moved from the
Recent Places Portal)
The 'Recent Activity' Portal tab has become the 'Recent'
folder of the Model Views tree.
If you double-click on a Package in the Model Views tree,
that Package is highlighted and selected in the Browser
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window.
See the The Focus Window Help topic.

Inspector Window
The 'Element' and 'External Element' tabs of the Browser
window have been moved to the new Inspector window,
which enables you to review the characteristics of a selected
element.
The 'Element' tab has been renamed as the 'Details' tab.
A 'Trace' tab (a synchronized instance of the Traceability
window) and a 'Summary' tab (a synchronized instance of
the Summary window) have also been added to the
Inspector window.
See the The Inspector Window Help topic.

The Resources Window
The Resources window has become the 'Resources' tab in
the Browser window. This includes a number of changes to
folder names and positions - several subfolders, such as
Linked Documents, have become top-level folders.
The MDG Technologies folder now shows all System,
Model, User and Add-in technologies and allows expansion
to show the contents of each technology.
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See the Browser - Resources Help topic.

Dynamic Charts
In the Automation Interface, a JavaScript Chart library of
new classes and functions has been provided to describe
Chart types, data, and styling.
See the Chart Package Help topic.
This library can be called by a Dynamic Chart Artifact
element with the SSDynamicChart stereotype, to generate a
Chart that is filled via a script. The Behavior view (Alt+7)
can be used to view and edit the script, which will run
automatically during diagram load to display the Chart.
You can also use the Dynamic Charts technology Toolbox
page to quickly create a Dynamic Chart definition.
See the Dynamic Charts Help topic.
You can generate Charts as displays of the persistent results
of your simulations:
· Allowing the graphical results to be included in reports
· Sharing friendly results with stakeholders without
additional simulation tools

External Simulation Integration
Enterprise Architect now supports the OMG SysPhS Profile,
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which provides:
· A visual approach to setting up a simulation
· An easier, model-based method for sharing simulations
· The automatic addition of compartments on SysML
Blocks on diagrams, showing any variables and constants
defined as stereotyped Properties (Parts) in the Properties
window
· Library references containing Properties using vector and
matrix types
· PhSVariable properties that specify an initial value,
displayed in an initial values compartment
See the SysPhS Simulation Help topic.
Enterprise Architect also supports use of MATLAB
Simulink, which enables you to:
· Export a SysML model to Simulink to simulate directed
messages between Blocks
· Via the MATLAB Simscape extension, translate SysML
Internal Block diagrams into a Simulink model, allowing
simulation of physical systems described by your model
· Via the MATLAB Stateflow extension, translate
StateMachine diagrams into a Stateflow model
· In each case, run a simulation and see the results as Charts
See the Simulink Integration Help topic.
MATLAB integration provides an explicit option for the
MATLAB path to override automatic detection.
See the MATLAB Solver Help topic
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There have been no updates to the Help in respect to these
changes:
· The SysPhS Technology has been updated with a model
library, patterns, and references to existing library blocks
· Simulink libraries referenced with a SimulinkBlock
stereotype will now default to the Block name if the
'Name' Tagged Value is empty
· StateMachine export to Simulink and Stateflow has been
improved
· Simscape components now handle a multi-line
notes/description entry
· Simulink simulation scripts correctly register the start
time
· Simscape simulations now specify 'time' constraints as
unit-less; this will change 'time' to (time/{1,'s'})
· Simulink simulations still run after generated files are
modified by another application
· Readability has been improved for Simulink models
generated from models in which an IBD is not supplied:
- Port sizes are reduced
- Ports are now laid out around the required borders
· Simscape Library Block references have been improved
- Initial Values corrected
- Built-in references now match the Simscape settings
- Improvements in behavior when multiple Simscape
connectors are connected to the same physical node
· Modelica now provides support for StateMachine guided
simulation; run the simulation and see charts of the results
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Modelica integration now uses a default output of 'mat'
instead of 'plt' for compatibility with OpenModelica
In SysML Simulation, custom library references are
checked for both Modelica and MATLAB Simulink
Where an element name is the same as a Modelica or
Simulink keyword, the invalid characters are encoded
with hex code to avoid name clashes
Systems will no longer experience memory leaks after
running SysML simulations
The 'Open Simulation Directory' command allows
selection of all relevant files - Modelica, Simulink, C++
and so on
Library references containing properties with multiple
stereotypes now write the initial value consistently
Primitive Types can now be assigned to properties
Datasets can now be configured to involve nested parts
Binding Connector direction is now ignored during
generation from Parametric diagrams
StateMachines have been updated to include support for
nested Substates and History States
The Plot window in the SysML Simulation configuration
has been modified to use a tree style, with expandable
elements listing their Parts and Ports
The Simulation Plot window no longer includes the extra
level found in some models
Modelica libraries are automatically imported for
referenced Blocks
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ModelicaBlock reference dataset values are improved
Modelica type reference naming improved
Added additional logging, error checking and
pre-validation in Simulation Configuration:
- Pre-validation is optional as it will stop the
simulation for going ahead if there are errors
Support added for non-core Simulink Blocks:
- The library name to use for Blocks outside of the
main 'Simulink' branch can be found in the Simulink Help
for the Block
Simulink log output is now linked to elements, allowing
double-clicking an error in the System Output to go to the
element responsible
Simulation changes are now automatically saved

Simulation Solvers
The 'Solver' Class allows you to use the functionality of
external tools to perform complex tasks within your
simulation. Each Class integrates with an external tool to
allow easy use of the functionality within that tool and
easily interchange variables with JavaScript.
Two Solver tools are currently supported:
· MATLAB Solver - Integrate directly with the MATLAB
API to use any of its calculation or charting functions; it
supports passing arrays to and from MATLAB, and
passes strings as 'character vectors', instead of 'string
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scalars' as these are more compatible
· Octave - Integrates with an Octave interpreter to use any
Octave functions
The Solver Class also provides informative error and
warning text.
Solvers can be launched from the new Solver Console.
See the Solver Consoles Help topic, the MATLAB Solver
Help topic and the GNU Octave Solver Help topic.

Extended Math Functions in Simulation
The built-in JavaScript library has been extended to provide
access to the industry-standard Cephes library of math
functions. It is now much easier to use complex
mathematical functions within your simulations.
See the JavaScript Math Library Help topic.

DMN
To meet the DMN 1.2 Specification, Figure 8.9 - 8.11, Rule
as Crosstab orientation is now available for all Decision
Tables. During simulation a Crosstab-oriented Decision
Table will highlight related Input Entry and Output Entry
cells.
The Decision Table display now uses a consistent column
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width when changing orientations.
Merging Input Entry cells in Decision Tables has been
improved:
· You can now perform in-place editing of a merged Input
Entry item
· During simulation merged Input Entry items are now
highlighted
· Context menu options are now consistent with other cells
See the Toolbar for Decision Table Editor Help topic.
The DMN Expression window now shows a horizontal
scrollbar when the total width of the content exceeds the
current window size. You can also resize individual
columns.
See the Decision Table Help topic.
There have been no updates to the Help in respect to these
changes:
· In a Decision Table, re-ordering of the rows using
Ctrl+Up or Ctrl+Down has been improved:
- You can now move multiple selected rows
- You can now move rows containing merged cells
- Flickering while any re-ordering is in progress has
been reduced
· The behavior of the DMN Expression window when you
are selecting new elements has been improved:
- When you select a DMN element, the style and
contents of the window will update to match the element
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- When you select a non-DMN element, the window
fields will be cleared
A <<Decision>> element property is refreshed when its
invoked <<BusinessKnowledgeModel>> element name is
changed

Diagramming
MDG Technology for Microsoft Azure added, with a new
Image library to assist in developing diagrams that describe
Microsoft Azure deployments.
See the Microsoft Azure Help topic.
The AWS Image library has been updated to the latest icon
set provided by Amazon, and you can now apply the Light
and Dark theme option to AWS diagrams. Model Wizard
patterns for AWS have been updated.
See the Amazon Web Services (AWS) Help topic.
The Google Cloud Platform (GCP) Image library has been
updated to the latest icon set provided by Google. Model
Wizard patterns for GCP have been updated.
See the Google Cloud Platform (GCP) Icons Help topic.
If an element is dropped or copied onto a diagram as a link
(reference), any related Note, Text or Boundary element is
duplicated on the target diagram.
See the Drop Elements from Browser Window Help topic.
The Pop-up Image Viewer has been extended to display the
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images linked to Image Assets.
See the Image Assets Help topic.
When using Diagram Layers:
· And clicking into and out of a diagram, any selected
Diagram Layers are preserved
· On a diagram, objects contained in hidden layers will no
longer be selectable
· The 'Layers' tab of the 'Filters & Layers' dialog has a
'Layers' checkbox that selects or deselects all the defined
layers in the list; when the checkbox is cleared, you can
select individual layers to apply to the diagram
See the Diagram Layers Help topic.
Diagram Filters - initial display of the 'Filters' tab of the
'Filters & Layers' dialog shows the Filter groups collapsed.
See the Diagram Filters Help topic.
The floating 'Helper' buttons to the right of a selected
element have been redesigned and now show context menus
to provide increased functionality.
See the The Context Buttons Help topic.
There have been no updates to the Help in respect to these
changes:
· Diagrams modified by another user while you are viewing
them can now be reloaded directly from the prompt 'This
diagram has been modified by another user'
· The behavior of resizing, adding and removing
edge-mounted elements on SysML diagram frames has
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been improved
SysML Ports and Parts obey the 'Show Property Type'
option
When moving between multiple visible diagrams, the
diagram tooltips are now displayed without you having to
click inside each diagram
Diagram Tooltip widths are now scaled with DPI
The compartments on a SysML Block element will now
be automatically updated when switching a relationship
between Aggregation and Composition
BPMN diagrams with flow direction set will no longer
move Pools off the edge of the diagram
Connector 'Change Direction' commands are now enabled
and disabled in accordance with the Security setting
'Apply Locks to Connectors'
When dropping embedded elements onto a diagram in
'paste as a new element', locks on the new parent are now
propagated to the child embedded elements as well
'Paste as new' also checks the locks on the target diagram
and its owner Package or element, and is blocked from
operating if the owner is locked
The Keyboard Shortcut for 'Snap To Grid' (I) has been
discontinued
Moving attributes and operations between elements will
now also update linked connectors
Deleting attributes and operations will now move any
linked connectors to the owning element
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The displayed name of an ActionPin with an empty name
will show empty if it doesn't bind an ActivityParameter
Strict Connector Syntax and the Quick Linker now:
- Allow Control Flow for Call Actions and Events
- Have improved behavior for UML Deployment,
SysML Allocate, and SysML Requirement connectors
Strict connector Syntax now:
- Allows any element to be attached to an
unstereotyped Note or Constraint (so Boundary elements
are now valid
targets for NoteLink and Dependency connectors)
- Validates new links to ArchiMate Junctions against
the elements on the opposite side of the Junction,
reflecting the understanding that Junctions are
effectively a way to say that, conceptually, the
relationship
has multiple sources and/or multiple targets
ArchiMate connectors linking to other connectors can be
created with the Quick Linker
In ArchiMate diagrams, Aggregation and Composition
connectors are not created with an arrowhead
Package Contents now display the correct icon for
Packaging Components
UAF Exhibits connector rules have been updated to
ensure all valid source elements are allowed
UAF ServiceSpecification now inherits the SysML Block
rule for Generalizations
UAF Capability no longer restricts Dependency targets to
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other Capabilities
The Feature Linker can now be enabled on diagrams
where it has previously been disabled
New Diagram Themes have been added - 'Enterprise
Architect 15.2' (the current default), 'The Deep' and
'Ocean Depths'

Code Engineering
C++ Code Engineering now supports round-tripping the
C++ 14 constexpr specifier on a variable or function.
See the C++ Conventions Help topic.
There have been no updates to the Help in respect to these
changes:
Reverse Engineering of:
· C# now:
- Supports C# 8.0, with correct handling of Indices
and Ranges, Null-coalescing assignment, and Interpolated
verbatim strings
- Imports documentation comments into the
corresponding 'Note' fields
· C++ now allows:
- The import of C++11 noexcept functions
- The import of C++11 final classes
- Use of a decltype specifier return type (including
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C++14 decltype(auto))
· Python now:
- Incorporates type hints and parameter type
The Source Code Editor no longer displays a Class for
variables initialized using a namespace.
Code Generation Templates have been updated to support
supplying arguments to a list macro:
· Arguments are supplied by adding @arguments=(
<values> )
· In the called template you can reference them using
variables named $parameter<n>
· For the call %list="Operation" @separator="\n"
@indent="\t" @arguments=("test")%, $parameter1 will
receive the value "test"
Code Generation Templates now include inherited
Operations when using a custom operation list.
Behavioral code generation has been updated to generate an
else blockif the connector constraint is 'else'.
VHDL import has been updated to handle variable
definitions with a range constraint.

XMI Import and Export
There have been no updates to the Help in respect to these
changes:
· Discussions on Packages, elements and diagrams can now
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be round tripped using XMI 1.1, XMI 2.1 and Native
XML
Baseline Comparison has been extended to support the
comparison of Discussions
The 'Baselines' dialog now displays a newly-created
Baseline when it was created using a Cloud Connection
The 'Publish XMI' dialog now offers UML 2.5.1 (XMI
2.5.1)
Native XML Import will not report 'System resources
exceeded' errors when importing connectors into a .EAP
file
Native XML Import with Strip GUIDs will no longer
change the target of existing diagram hyperlinks
Native XML Project Transfer now automatically updates
Firebird Index Statistics
ArchiMate Model Exchange File Format 3.1 support is
now available
ArchiMate 3 Model Exchange File import over Cloud
connection no longer causes database errors
XMI 1.1 and XMI 2.1 updated to support round trip of
Element and Diagram Comments
Import of SysML diagrams from Magic Draw into
Enterprise Architect updated to ensure Enterprise
Architect uses a matching diagram type
Import of SysML into Magic Draw now imports Parts
from the containing Classifier's ownedAttributes

(c) Sparx Systems 2022

Page 255 of 524

Getting Started

3 October, 2022

User Interface
A JavaScript Console has been created to display in the
main work area:
· With a large text entry area for new commands
· With two new ribbon commands to create a console, with
a Solver object created by default
See the Solver Consoles Help topic, and the JavaScript
Console Help topic.
Constraint elements are now named elements that are listed
in the Browser window and can be shown on several
diagrams. They have a standard 'Properties' dialog, allowing
you to assign properties through the dialog as well as
through the Properties window.
See the Constraint Help topic.
Dropping multiple Packages from the Browser window onto
a diagram now prompts you to define the drop type only
once.
See the Drop Package From Browser Window Help topic.
You can now paste copied elements directly under another
element in the Browser window.
See the Copy Elements Help topic.
Model Views (the 'Model Views' tab of the Focus window)
display views provided by all technologies regardless of the
selected Perspective.
See the Model Views Help topic.
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The 'Legend Properties' dialog now supports:
· Assigning a format to all connectors regardless of type
(the <All> option)
· Assigning a format to Information Flow connectors
· Formatting based on a profile Tagged Value, as listed
under the 'Global Tagged Values' option
See the Legend Key Help topic.
Docked list windows now support drag and drop of a
selected item onto a diagram object to move that item. This
applies to these windows:
· Maintenance (see the Move Maintenance Items Between
Elements Help topic)
· Project Management (See the Move Decisions/Events
Between Elements Help topic)
· Testing (see the Move Tests Between Elements Help
topic)
· Responsibilities (see the Responsibilities Help topic)
The 'Application Look' dialog offers an 'Internal Tab style'
option to select one of a range of styles in which to display
the internal tabs of docked windows.
See the Visual Styles Help topic.
The docked Properties window toolbar has an icon to
display the appropriate dialog for any special actions the
object might have.
See the The Properties Window Help topic.
The Start Page now includes a 'Custom' item within the
'Open' section, which allows you to enter a connection string
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to directly access a project.
See the The Start Page Help topic.
Rich Text Note Editors are now scaled to 110% by default
for readability - this scale can be adjusted through the
'Default Note Zoom' option on the 'Visual Style' dialog.
See the Visual Styles Help topic.
In the Features window, for Structural Elements (Parts,
Properties, Ports, Interaction Points) the element Type can
be defined both on the relevant tab and in the 'New
Embedded Element' dialog.
See the Manage Structural Elements Help topic.
The user options and keyboard accelerator to show a web
browser inside Enterprise Architect have been removed.
The Help content documenting these options has been
removed.
There have been no updates to the Help in respect to these
changes:
· The Browser window vertical scrollbar will no longer
draw too large
· The behavior of the 'Specialize' ribbon has been improved
when opening and closing models
· The 'Change Management' and 'Project Management'
docked lists no longer display a date when none has been
set
· On the Properties window for Messages, changing the
setting of the 'Start new Group' checkbox will enable the
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Save icon in the toolbar
The docked Properties window now allows setting an
Activity Parameter as 'Control Type'
The docked Properties window now allows setting 'Type'
for Object Node-related types
The State Chart editor now allows you to rename a State
or Trigger element by pressing F2
On the 'Generate Documentation' and' Generate HTML'
dialogs, the label sizes have been improved
Display of RefGUID and RefGUIDList Tagged Values in
these windows now includes the names of the referenced
elements:
- Diagram List View
- Specification View
- Baseline Compare
The scroll behavior of the Traceability window has been
improved
The 'CSV File Specification' dialog now keeps the
currently-selected item visible when reordering items
When you are creating an Exposed Interface, the 'Exposed
Interface' dialog is initialized with the correct interface
type (required or provided)
In the Model Views tab of the Focus window, Model
Library connections are loaded as needed, when you click
on the 'Database' icon for a connection
The Element Behavior (Code) editor structure tree now
includes nested behaviors
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The Element Behavior (Code) editor now provides
additional options in the context menu:
- Edit Behavior
- Edit Internal Code
- Edit/View Source Code
The Element Behavior (Code) editor now provides code
hinting for Model Add-ins:
- Includes built-in JavaScript functions for Map,
Array, String, Object, JSON objects
- Includes members of the current Class
The docked Maintenance window in-place Create now
leaves the 'Resolved By' and 'Resolved On' fields blank
The docked Maintenance window will now be updated
when new Maintenance items are added in other locations
The 'Working Sets' dialog now displays user working sets
The Scenario editor no longer prevents merging of some
steps

Stereotypes/Tagged Values
There have been no updates to the Help in respect to these
changes:
· If a stereotype defined in the 'Stereotype' dialog has no
description, it can be removed from the dialog
· Stereotype field and property groups are now available in:
- Association End properties
- Database modeling column properties
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You can now change column stereotypes and see the
properties defined by custom stereotypes in the property
lists for those columns

Model Add-Ins
There have been no updates to the Help in respect to these
changes:
· The Element Behavior editor no longer shows unused
Operation Behavior and Class Imports code fields for
Model Add-Ins
· The Element Behavior editor now allows reloading an
active Model Add-In
· Model Add-Ins now receive the EA_Connect broadcast
during initialization, to allow for creating Workflow
Add-Ins

Other
#Branch# substitution in a Custom SQL Search no longer
performs a full load of the specified Browser branch
(Package). Instead it has parameters to specify how the
Package is loaded:
· #Branch# - Expands to all child Package IDs of the
currently-selected Package
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#Branch=GUID# or #Branch=ID# - Expands to all child
Packages of the specified Package
· #Branch=ID,ID,ID# - Expands to all child Packages of the
specified set of Packages
See the Create Search Definitions Help topic.
In the Code Behavior view, editing the JavaScript code in
behavioral models such as StateMachines and Activity
diagrams allows all the behaviors to be edited on a single
screen. The code editor includes a structure tree through
which you can navigate to and edit any child element
behavior. This is particularly useful for running systems
engineering simulations.
See the Editing Source CodeHelp topic.
A Publishing Perspective has been added, including the
technologies for creating documentation, charts and
dashboards.
See the Types of Perspective Help topic.
·

There have been no updates to the Help in respect to these
changes:
· ArchiMate 3 Model Wizard Patterns improved
· Error handling for SQL errors over direct DBMS
connections improved
· The Relationship Matrix context menu for elements no
longer generates errors when accessing the Quick Linker
· External model Collaboration information is no longer
loaded when the user ID is different between models
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The docked Properties window now can now save
updated initial values on nested properties
Note: If you have been impacted by this you will need to
run a Project Integrity check to remove duplicate
'CustomProperties'.
Editing of personal Journal entries has been restored
Workflow Events received by Add-Ins will now include
the element type and stereotype information in the Info
object
When autonumbering is being applied to a Package and
its child objects are tested for locking status, they are
correctly checked for lock type rather than just the
presence or absence of a lock
A project integrity check will no longer fail when a
connector end object is missing
Direct database connections without saved credentials will
now allow entering a password
SQL errors arising when pasting diagram-owned elements
to a new diagram have been corrected
Error handling when saving Tagged Value text that
exceeds the database field length has been improved
Behavior that could prevent structured Tagged Values
being updated from the docked Properties window has
been corrected
Project Transfer to MySQL will copy Relationship Matrix
profiles with no name
Metamodel constraints now allow you to restrict valid
owners for profiled attributes and operations using the
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umlRoles ownedAttribute, ownedOperation, and owner
Metamodel constraints referencing Decision, Synch(H)
and Synch(V) will now be exported with an appropriate
name
Metamodel constraints on classifier and type are now
applied when editing from the docked Properties window
The Model Glossary editor now allows you to change the
case of a defined term
The API 'LockPackage' functions
(Package.ApplyUserLock, Package.ApplyGroupLock and
Package.ReleaseLock) also apply locks to Boundaries and
other elements not visible in the Browser window
The 'Unknown user or password' message no longer
displays when loading a model after inspecting a watched
model
Adding elements within the Browser window will copy
the definition in the Template Package
Duplicating a Version Controlled Package in the Browser
window will remove Version Control settings from the
duplicated Package
The Execution Analyzer context menu can now be
navigated using the keyboard
The Features window no longer causes a delay when
selecting States
For Oracle casts use ten 9s with the TO_NUMBER()
function when comparing table counters
SQL Server backend support now corrects type coercion
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errors
In SQL repositories, changing between RequiredInterface
and ProvidedInterface no longer fails
Reusable Asset Server Package registration no longer
reports an error on case sensitive database types
Selecting and de-selecting embedded elements on the
'Interaction Points' and 'Parts/Properties' tabs of the
Features window will no longer update the currently-open
diagram when:
- The diagram is locked
- The current selection is not on the diagram
Glossary report generation no longer fails
The Attribute.Update API call no longer results in
additional broadcasts for changing context
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Release 15.2, Build 1555
Scroll through these sections to review the changes that
have been made in Enterprise Architect for this released
build.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.

Element Formal Reviews
These changes have been made to the management of
Review elements (Start > Collaborate > Review > Manage
Reviews):
· The Reviews View now includes a 'Priority' column for
review topics
· The Reviews View no longer displays the Review element
status and review duration below the element name
· The 'Set : General Items' label has been changed to
'General' in the Reviews View window
· Review diagrams are no longer added automatically when
a Review element is created
· The 'Review' tab of the Collaborate window no longer
shows the text '0 of 0 Approvers' when no Approvers are
defined
· In the 'Review' tab of the Collaborate window, the 'Create
Review Topic' context menu option is now 'Create
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Review'
· The properties of the Review element are now displayed
in the Properties window
See the Model Reviews Help topic.

Collaboration
·

·

·

·

Members of the 'Administrators' security group can now
join any security Chat group and get Chat notifications
See the Model Chat Help topic
In the Discuss & Review window, the context menu in the
'Journal' tab now offers these extra font options for a
selected text string:
- Set a specific font face
- Remove character formatting
- Restore the default font to the selected text
When operating in local files, the 'Check for Update
Every' context menu option on the Discuss & Review
window 'Journal' tab now provides the 'Enabled' option to
refresh the tab (or, if not selected, not update the tab with
new comments)
See the Discuss & Review - History Window Help topic
Collaboration diagrams will now display 'Chat' icons for
elements in different Packages
See the Collaboration Support in Diagrams Help topic

There have been no updates to the Help in respect to these
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changes:
· The 'Comments' tab of the Collaborations window does
not now reload multiple times when updated
· On the Collaborations window, the 'Preview' pane for the
'Reviews' tab and the 'Discussions' tab now maintains
selection during automatic refresh

External Simulation Integration
There have been no updates to the Help in respect to these
changes:
· Validation of ConstraintBlocks before simulation now
allows ConstraintBlocks composed of other
ConstraintBlocks
· Generation for Modelica Simulation now allows
generation of initial value for nested properties
· Generation of a Simulink Simulation now uses the correct
name for existing Reference Blocks
· Simulation updated to ensure that any log messages
generated are always displayed

Simulation Solvers
There have been no updates to the Help in respect to this
change:
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The Solver Class is now automatically configured to use
MATLAB or Octave under either Wine or Linux

Diagramming
·

·

·

Diagram References now provide an easy mechanism to
move elements between Packages and diagrams:
- By default when you drop an element onto a
reference you are now prompted to move
the element to the Diagram, Package or Both or to
create a link on the target diagram
- The Diagram Frame context menu allows you to
select a different default behavior
See the Diagram Frame Help topic.
The layout of Nested Ports has been improved to:
- Ensure that child Ports are always bound to an edge
of the parent during a move
- Ensure that child Ports will maintain the same edge
during a resize or move
See the Nested Ports in SysML Help topic.
Shape Scripts will now print the name of the referenced
element when printing a RefGUID Tagged Value
See the Predefined Structured Types Help topic.

There have been no updates to the Help in respect to these
changes:
· Dropping an Operation from the Browser onto a classified
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ActivityPartition will now create a CallOperationAction
Validation of State Transitions to Terminate nodes has
been improved
State Transition properties now allow you to change
between two Signals with the same name
Classifier Selection now allows the selection of
StateMachine and Interaction elements as Classifiers
Disabling of Custom compartments for a diagram will
now be set correctly
Metamodel constraints no longer:
- Add Sequence Messages to the suggested
Quicklinker items on non-Sequence diagrams
- Provide the option of creating a new Lifeline on
non-Sequence diagrams
- Provide the option of creating a new instance using a
non-instance type

Kanban
·

·

·

Kanban lanes can now be marked as 'Not-bound', which
means that adding an element to that lane will not change
the bound property for that element
Default Kanban lanes no longer assign the bound property
to the column title
Moving an element to a bound Kanban lane now shows a
menu allowing you to confirm the change
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The 'Unbound' option for Kanban lanes has been renamed
to 'Bind to Left' to better reflect what the option does
· Kanban binding can now be set as read-only, which
results in an easy overview of the binding without
un-intended changes being made
See the Kanban Options Help topic.
·

There have been no updates to the Help in respect to these
changes:
· The Kanban dialog has been improved:
- Keyboard-only navigation and editing is now
possible
- If changes are made to the Kanban diagram through
the Kanban dialog, and
the dialog is canceled, the diagram is returned to its
original state
- The dialog no longer marks the diagram as changed
when it is opened
- The Search filters list control is now consistent with
the list controls in other places
· The Kanban dialog is now available from the Diagram
context menu in the Browser window
· Diagrams bound to a Tagged Value now update the
docked Properties window automatically
· Newly added elements from Kanban search are now sized
to include the displayed Tagged Values
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XMI Import and Export
There have been no updates to the Help in respect to these
changes:
· XMI Import with Strip GUIDs now keeps synchronization
between connector properties and elements.
· Diagram Images generated during XMI Export will now
render Diagram Frames correctly.
· The Native/XMI import speed for QEAX models has been
improved.
· Import of EMX files including diagrams has been updated
to prevent issues.
· The import of MDZIP files has been improved:
- Initial and ShallowHistory PseudoState elements
now import correctly instead of becoming a
Synchronization
- State Regions are now correctly mapped with the
contained elements referencing that region
- State Transitions are now imported complete with
the referenced Trigger and Signal
- Association Roles are no longer imported as a Part
- RequiredInterface and ProvidedInterface elements
on a Port can now be imported
- The InterfaceRealization connector can now be
imported
- Imported SysML and UAFP elements and
connectors are correctly linked to Enterprise Architect's
Profile
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Other
·

·

Importing User IDs from Windows Active Directory has a
new dialog option - 'Allow non-domain users (insecure)';
this allows users outside the domain to be auto-logged on
See the Import User IDs From Active Directory Help
topic
JavaScript Simulation now truncates strings that exceed
the maximum length of a Trace message
See the Dynamic Simulation with JavaScript Help topic

There have been no updates to the Help in respect to these
changes:
· Active Directory integration improved:
- Importing Active Directory Users now uses 'User
Principal Name'
- Auto login will now attempt to match both 'User
Principal Name' and legacy NetBIOS\SAMUsername
formats
· Changes to Structured Tagged Values made in the
Properties window are now saved
· JavaScript Simulation now handles string values correctly
regardless of the case of the type
· Visibility Levels on SQL Server models no longer cause
deadlock during Native XML import and Browser copy
and paste
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The Professional Edition no longer shows menu items for
these features, which are disabled in the edition:
- Dynamic Charts
- JavaScript Console
- Custom Drawing Style
- Collaborate Links
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Release 15.2 Build 1556
Scroll through these sections to review the changes that
have been made in Enterprise Architect for this released
build.
There have been no updates to the Help in respect to these
changes.

Diagramming
·

·

·

·

Corrected display of the ActionPin property type for
CallBehaviorActions
Non edge-mounted child elements will now not move
further than expected when moving the parent element
Setting a 'Structural Feature' in a ReadStructuralFeature
action no longer fails in some situations
Corrected a display issue for a Call Behavior ActionPin
when it represents an ActivityParameter and the
Parameter Type is changed
- Also prevented overriding the Type directly on the
ActionPin in this situation, to conform with the UML
2.5.1 specification

Kanban
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Restored the 'Default' Kanban lane behavior so that it
updates the property specified in the 'Bind Kanban' field,
unless the 'Not-Bound' option is enabled
Clicking the Apply button on the Kanban 'Properties'
dialog will correctly persist Kanban Search Filters
Corrected the Kanban option 'Read-only Bind' to avoid an
element moved to a 'Not bound' lane potentially moving
back under specific circumstances

User Interface
·

·

·

·

·

·

The modal 'Properties' dialog for an attribute will
correctly persist changing the type to a classifier with the
same name
Improved the stability for the modal 'Properties' dialog for
an operation when adding Tagged Values to an operation
parameter
Prevented unintentional scrolling in the docked Properties
window when updating values
Removed the duplicate 'Concurrency' property from the
docked Properties window for an operation
The Browser window menu option 'Add as Favorite to'
corrected to ensure available groups are consistently
displayed
Improved the In-place edit behavior in the Tagged Values
tabs where certain actions could cause an application error
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User Security and Login
·

·

·

·

·

·

When using Windows Active Directory groups in the
Floating License Server you can now leave the username
and password blank in the Keystore configuration screen
- Secure Windows authentication will take place
automatically
The web browser will no longer automatically close after
OpenID authentication, to avoid issues experienced across
some browsers
Support unicode characters in the user information (such
as username or group names) returned by the OpenID
provider
OpenID group claims will now use a case-insensitive
match
Improved stability when displaying results of an OpenID
test
Security User login names will now truncate to the
database field length rather than a fixed value, to
accommodate users extending the field in the Database

External Data Integration
·

Local models using an SBPI connection will now connect
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to the providers in the Integration window
Corrected handling of menu items with special characters

Other
·

·

Round-trip using XMI 1.1 with DTD no longer reports a
validation error
Improvements have been made in adjusting variables
through the Simulation Console during simulation of an
Activity diagram, to avoid potential failures
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Release 15.2, Build 1557
Scroll through these items to review the changes that have
been made in Enterprise Architect for this released build.
There have been no updates to the Help in respect to these
changes:
· Improved conformance with the UML Specification for
some Action types
· Restored the previous behavior for showing types and
compartments for SysML diagrams, to prevent layout
changes
· Corrected the issues when closing the Operations or
Receptions pages of the Features dialog from a Sequence
Message
· User Login length is now detected correctly during
Project Transfers
· Updated the default EA Schema to support longer Login
Names
· Corrected the drawing of exposed interfaces where, under
specific situations, they might appear detached from the
parent element when the parent is not a Port
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Release 15.2, Build 1558
Scroll through these items to review the changes that have
been made in Enterprise Architect for this released build.
There have been no updates to the Help in respect to these
changes:
· Database error handling has been updated to include more
useful error messages
· Create User and Project Transfer now allow the database
to handle restrictions on user-name lengths
· XMI export with 'Generate Diagram Images' enabled now
draws Chart elements in saved images
· The automatic insertion of diagram frames for diagrams
edited in releases prior to 14.1 no longer fails when the
parent element is locked
· Database schema version 1558 and future versions, when
applied, will have the version number visible in the
'About' dialog and DB transfer log
· The system will prevent a potential application error
under the rare circumstances of saving a diagram when
the element style exceeds the database field length
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Release 15.2 Build 1559
Scroll through these items to review the changes that have
been made in Enterprise Architect for this released build.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.

Integration Plug-Ins (SBPI)
Support has been provided for RESTful API notifications
from a client Enterprise Architect to PCS-based
Integrations; notification is sent to Custom Integrations
when an Enterprise Architect element is linked, unlinked or
updated. This requires PCS 4.6 build 65.
See the ISBPIIntegrationPlugin interface Help topic.
Allow Custom Integrations to pass log messages to
Enterprise Architect; they will be displayed in the System
Output window.
Allow different icons for different menu levels and item
types.
See the Custom SBPI Services Help topic.
The Timeout duration when communicating with an
Integration Plug-in can now be customized from PCS. This
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requires PCS 4.6 build 65.
See the Add/Edit Data Provider and WebConfig - Add or
Edit an Integration Data Provider Help topics.
There have been no updates to the Help in respect to these
changes:
· When selecting to create a local element using the Trial
edition, a pop-up notification will now display to indicate
this feature is not available in this edition
· Handling of unresponsive external providers has been
improved
· The active External Data window will now recognize any
modification to Field Mappings for an Integration Plug-in
· Better messaging has been provided for when no results
are returned by an Integration Provider, to help
distinguish between failure and a valid result:
- When no sub-menu items are returned, a message is
displayed in the System Output window
- When no results are returned for a menu item, a
message is displayed in the External Data window
· Increased security has been applied to the External Data
'Remember Me' option; note that existing remembered
credentials will be lost and must be re-entered
· The display of different icons in the External Data
window is supported for each breadcrumb menu level and
for any item type
· The display of icons on high DPI screens has been
corrected
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The behavior has been corrected when selecting 'All Items
Linked to Model' and a time period is not chosen
The ability for custom integrations to support threaded
discussion has been added; this is also supported now in
the Polarion integration
Custom Integrations are now listed under their 'Group' as
defined in Pro Cloud Server configuration; this requires
PCS 4.6 build 65
Unicode characters are handled correctly when making
queries to External Data Providers
Duplicates in the External Data Type Mapping
configuration list are now prevented
The External Data window breadcrumb menu has been
corrected, by removing 'Custom Services'
Fixed the crash in CAuthorisationManager

Other
The timeout duration in Enterprise Architect when
communicating with a Pro Cloud Server can now be
configured from the 'Manage Model Options' dialog.
See the Cloud Page Help topic.
There have been no updates to the Help in respect to these
changes:
· Hovering over a Glossary item will no longer display its
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meaning with escaped extended ASCII characters
Import/Export of CSV data has been updated to correctly
handle escaped extended ASCII characters
Corrected saving Structured Tagged Values when
contained under another level of grouping
Corrected a potential application error when a connector
is moved to a new Port created via the docked Features
window
The MagicDraw import has been corrected to prevent a
Trigger being lost when using a Change Event on a
StateMachine Transition
Amazon Web Service icons have now been updated to
Release 7
The Project Integrity Check now detects Package
Baselines that have been set aside during an XMI import
and not restored, or where no matching Package exists
Corrected a potential integrity issue when restoring a
Baseline from a model connected via the PCS when
Auditing is enabled
The modal 'Features' dialog closes correctly, when opened
from the docked Sequence Message window
Included a new option 'Copy Selected Rows to Clipboard'
when displaying a Package or diagram as a list
Corrected the list of Event Types displayed from the
docked Project Events window
Changing the stereotype for an attribute or operation will
now load the defined properties into the docked Properties
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window
Corrected the 'Auto Spell Checking' behavior in Rich Text
documents to avoid a potential application error when
parsing the Table of Contents
Prevented a potential application error when running a
Script that includes an extremely long line of code
Improved detection of changes to Version Controlled
Package files, to prevent unnecessary imports
Cached Diagram Images, Image Maps and HTML for
Linked Documents will be updated when importing
Native XML
The display of Linked documents in WebEA and
Prolaborate now supports displaying the text background
color
A Visual Studio Solution import will correctly choose the
selected projects when the list is sorted
Added support for importing Visual Paradigm diagrams
from XMI 2.1
Allow saving model-based Add-In scripts when using a
Postgres model
Multiple improvements to Executable StateMachine Code
Generation
- Transition Effects will now generate the selected
operation with parentheses and a semicolon
- Corrected the compile issue for generated C code
when an operation is referenced
in a State's behavior and a Transition's Effect
- Removed unhelpful comments in the template for
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send_event and broadcast_event
Improved support when using wine 6.0 or greater
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Release 15.2 Build 1560
Scroll through these items to review the changes that have
been made in Enterprise Architect for this released build.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.

Others
·

·

The XML Import now provides the option to either merge
or restore Discussions from XML into the model
See the Model Options Help topic and the Import from
XMI Help topic
The Collaboration Chat History now reflects discussions
across all Chat groups for users within the 'admin' group,
when using the Summary filter
See the Discuss & Review - History Window Help topic

There have been no updates to the Help in respect to these
changes:
· The UML:Package section in XMI 1.1 will no longer
contain the GUIDs of Features that are classified by the
Package
· An Action will no longer lose its Trigger reference when
copy-and-pasting in the Browser window
· A Trigger will no longer lose its Signal reference when
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copy-and-pasting in the Browser window
Elements containing child objects will be correctly
copy-and-pasted in the Browser window
The Kanban Search will be correctly duplicated when
copy-and-pasting a diagram in the Browser window
The potential crash when opening multiple Cloud models
has been fixed
Support for round-tripping the Diagram Kanban Search
via XMI 1.1, XMI 2.1 and Native XML has been added
The way Collaboration diagrams interact with a new Chat
Msg Notification has been improved, to ensure diagram
selection is correctly synchronized
A rare scenario has been corrected, where changing the
active Chat could result in the loss of newly added text in
the docked Notes window
Drag and drop has been disabled while writing a new
Discussion post, to avoid a potential application error;
also:
- There is better handling of pasted text in a new
Discussion item, to ensure the row height matches the
pasted content
- When editing large Comments or long Discussion
items, the window correctly scrolls when the cursor is
moved
Reviews, Discussions and Comments in the Collaboration
window have been corrected so that they no longer use the
external model connection, if defined
Scrollbars for the Code Editor will now correctly sync to
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the position in the document when finding text
The 'Usage' dialog is now prevented from potentially
showing non-related entries when running 'Find in
Diagrams' on an element hyperlink
Text will not be stripped when copy/pasting from a
Source Code editor to a Document editor
Importing the Amazon Web Services Images ( Release 5 )
model pattern over PCS will no longer throw time-out
errors
The Tagged Values window application error after closing
the 'Features' modal dialogs has been resolved
In the Scenario Editor, the in-place edit context menu
interactions have been corrected
- Highlighting of multiple context references in the
Scenario Editor Structured Specification has been
corrected
- Context references now insert into a Scenario step at
the selected cursor position
- During in-place editing, the user can delete the text
of a Scenario Step before inserting a context reference,
and the deleted text is no longer rolled back in
afterwards
In the docked Features window, on the 'Interaction Points'
tab, the 'Add New' context menu option is enabled after
selecting an Instance object
Deleting multiple elements from the Browser window in
one selection now correctly deletes all child diagrams on
those elements
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Release 16.0
Scroll through these sections to review the changes that
have been made in Enterprise Architect for this released
build.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.
For an overview of the features of Release 16.0, also refer to
the Enterprise Architect 16.0 page of the Sparx Systems
website.

64 Bit Application Support
Provided the ability to transfer EAP/EAPX Projects to all
types of Repository in the 32 and 64 bit versions without
requiring JET/DAO drivers.
See the Migrate an EAP/EAPX File to QEA File Format
Help topic.
The system can automatically respond to an attempt to open
an EAP file in a 64 bit installation, displaying a dialog to
convert the EAP file to a compatible format.
See the Project Upgrade to QEA Help topic.
Provided the ability to transfer projects back into Firebird
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(legacy file) format when required.
See the Transfer a QEA/QEAX Repository to FEAP Format
Help topic.
Extended Replication support to QEA (SQLite) files.
See the QEA Replication Help topic, and the (Settings
Ribbon) Model Panel Help topic.
In Database Engineering, Database modeling import and
compare is now able to use SQLite.
As an example, see the Database Connections Help topic.
Add a new Register Value when loading 32 bit and 64 bit
COM objects in Enterprise Architect.
See the Deploy Add-Ins and Tips and Tricks Help topics.
There have been no updates to the Help in respect to these
changes:
· Transfers into JET can now be performed in the
Enterprise Architect 16.0 32 bit version without error.
· The Enterprise Architect 64 bit version is prevented from
attempting to open EAP/EAPX/EADB files in Linux,
even if the Access DB Engine 2010 64 bit driver is
installed.
· The GetXML() string with Xerces has been fixed to work
with unicode characters.
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Opening the Example model in the Enterprise Architect
64 bit version will now open the EAExample.feap file.
The project upgrade process when opening an EAP/EAPX
file with the 64 bit version of Enterprise Architect has
been simplified.
The speed of upgrading an EAP to a QEAX file has been
improved.
Opening an EAP/EAPX file after using a native DB
connection will no longer fail.
QEA Replication includes these fixes:
- The Database Schema used for QEA Replication
have been updated to match the latest QEA schema
- QEA Conflict resolution no longer crashes after
correcting the last item
- QEA Conflict resolution no longer shows a spurious
warning after completion in 32 bit
- 'Remove Replication' is now available for QEA files
- Changes can now be synced without closing and
re-opening the master model after creating a master or
replica
- Deletions from replicas can now be synchronized

DBMS Repositories
There is now a simplified way of connecting to new and
existing DBMS repositories using a native connection
method.
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See the Open Server Connections - Native Connection Help
topic.
There have been no updates to the Help in respect to these
changes:
· Support for MariaDB/MySQL plugins has been added.
· Data Transfer now updates Oracle Sequences
appropriately.
· Loading a project from SQLServer repositories that use
old schema definitions will no longer fail.
· Multiple queries with anonymous columns have been
updated for compatibility with Native connections.
· In custom SQL Searches over Native connections, the
handling for duplicate information returned has been
improved.

Model Governance
There have been no updates to the Help in respect to these
changes:
Security
· Users now must log into the model after a project file
upgrade where security is enabled.
· The EAP file extension is removed from EA 64 bit when
Access Database drivers are installed in the Windows OS.
· The 'Apply Locks to Connectors' option now also
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observes and applies 'FullLocks' (as well as User or Group
locks) when locking connectors.
· The 'Lock Package' option in the Browser window context
menu is always available for Model Root nodes.
· A duplicate lock error has been corrected, when setting
the visibility of inherited Ports on an element when using
'Require User Lock to Edit'.
Version Control
You can now define a single commit message for all version
control operations invoked by the command 'Add Branch to
VC'.
Auditing
· Performance has been significantly improved in various
scenarios; for example, when creating new elements and
saving diagrams.
· Auditing over Cloud connections has been significantly
improved in scenarios where Enterprise Architect no
longer needs to wait for audit updates
· Potential issues with the acquisition of audit log IDs have
been corrected
· The behavior of an ArchiMate or NIEM import has been
improved to ensure the Audit setting 'Audit XMI Import'
is obeyed.

Diagramming
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Release 16.0 introduces the new facility of Scriptlets,
artifacts defining Javascript that is executed on the fly when
a diagram is opened. For this facility, the 'Edit Internal
Code' option has been moved to the main object context
menu and the double-click behavior now brings up the
internal code editor for Scriptlet objects.
See the Scriptlets Help topic.
There is a new diagram style called 'Grid', which allows you
to set a grid with custom sized cells that objects can be
moved into.
See the Grid-Style Diagrams Help topic.
An Auto Refresh facility has been added for diagrams,
providing improved support for multiple people giving input
on the same diagram and allowing users to monitor changes
on a specific diagram.
See the Auto Refresh Help topic.
The Auto Refresh facilities are now available from the
Layout ribbon, 'Auto Refresh' panel.
See the Auto Refresh Panel Help topic.
A new Auto Reload facility has been provided to reload any
diagrams that you have open that have been updated and
saved by another user within the last 60 seconds.
See the Diagram Options Help topic
(c) Sparx Systems 2022

Page 296 of 524

Getting Started

3 October, 2022

Dashboard diagrams do not need to be 'panned and zoomed'
so the Pan & Zoom facilities are disabled for these types of
diagram.
See the The Pan & Zoom Window Help topic.
The Diagram Toolbox page for Artifacts has been broken up
into five separate Toolbox pages, each dealing with a
separate group of Artifact types.
See the Artifact Toolbox Pages Help topic.
In the diagram 'Properties' dialog, the 'Hand Drawn',
'Whiteboard Mode' and 'Show Shape Scripts' options have
been moved from the 'Diagram' tab to the 'Elements' tab,
and a 'Custom Draw' option added to the 'Elements' tab.
See the Diagram Properties - Elements Help topic and the
Diagram Properties - Detail Help topic.
The Properties window for a diagram provides:
· An option to hide or display the icon A in elements on the
diagram that have a Linked Document
· Options to set up Collaboration flags
See the Properties Window - Diagram Help topic.
The 'Collapse Embedded Elements' option on the 'Elements'
page of the diagram 'Properties' dialog has been moved to
the 'Diagram' tab, 'Appearance' section of the Properties
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window for diagrams. A new option has been added there
that allows you to show the collapsed element names as
labels on the diagram.
See the Properties Window - Diagram Help topic.
The Quick Linker has been fixed so that when the 'Filter to
Toolbox' option has been deselected the full range of
connectors and target elements available to the source
element are offered.
See the The Quick Linker Help topic.
When you open a pop-up view of a Composite element's
diagram, by clicking on the 'Eye' icon, you can open the
diagram itself by double-clicking on the pop-up.
See the Composite Elements Help topic.
New style options have been added to user preferences for
tracking handles on elements on diagrams, such as 'Rect
Style', which interacts with 'Highlighting'.
See the Diagram Behavior Options Help topic.
New options have been added to the 'Info View' dialog to
hide Notes and to use the default element colors.
See the Info View Style Help topic.
The Persistent Zoom facility has been improved, and
additional Zoom levels have been added, including a 'Clear'
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option.
See the Diagram Panel Help topic.
Diagram elements such as Navigation Cells and Text
elements are now listed in the Browser window underneath
an Annotation node, represented by three blue dots.
See the Annotations Help topic.
The 'Use Rectangle Notation' option has been moved from
the 'Advanced' context sub-menu to the 'Appearance'
context sub-menu. On a Construction diagram, the Actor
element automatically uses Rectangle Notation.
See the Rectangle Notation Help topic.
Displaying compartments on ArchiMate elements is not
possible and options to do this are disabled on the
ArchiMate element context menu.
See the Compartments Help topic.
Realizing Information Flows is only possible on UML
connectors, so the options to do this are not enabled on
ArchiMate connectors.
See the Realize an Information Flow Help topic.
The Alt key under Windows (not Windows VM or Linux)
toggles the behavior of child elements moved from parent
elements.
(c) Sparx Systems 2022

Page 299 of 524

Getting Started

3 October, 2022

See the Diagram Shortcuts Help topic (Positioning Elements
table) and the Diagram Behavior Options Help topic ('Auto
Group Elements' option).
You can now display and pan across the image associated
with an Image Asset in a pop-up window.
See the Image Assets Help topic.
When defining connector notation, the Information
Engineering (IE) notation does not work in Shape Scripts;
connector notation options are now blocked in ArchiMate
diagrams.
See the Diagram Properties - Connectors Help topic.
The N-ary Association diamond connector is now available
in the 'Elements' page of the Diagram Toolbox for Object
diagrams.
See the Object Diagram Help topic.
A Redefine connector can now be created from the UML
Profile page of the Diagram Toolbox. This can be used for
redefining stereotypes.
See the Redefine Stereotypes in Another Profile Help topic.
There have been no updates to the Help in respect to these
changes:
· Two connector Shape Script properties have been added:
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Source.RectangleNotation and Target.RectangleNotation.
Self connectors will now draw the start/end waypoints
when selected.
Aggregation and Composition connectors have been
improved to now have the same labels as Association;
they will now show {redefines} and {subsets} labels.
The handling of 'Tree' style connectors has been improved
on diagrams with hidden layers; they will no longer
suppress segments incorrectly.
Support for for Bezier line style on most connectors has
been vastly expanded, and they now draw with the correct
bend point.
Connectors with a Tagged Value of _Bezier=true now
allow multiple bend points.
'Bezier' line style will now use Shape Script styles when
applied.
A rare situation where stereotyped connectors with a
Shape Script would not render correctly, has been
corrected; this was originally reported for DFD diagrams.
Proxy connector query behavior has been corrected, when
no proxy connectors exist on the diagram at load time.
Presentation mode now highlights labels and connectors
when they are selected.
Connector validation has been corrected to avoid incorrect
syntax errors for CMMN connectors.
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A model validation error for a reverse connector when
'Strict Connector Syntax' is enabled has been corrected.
Virtualize Connector End commands now only show if
line style is set to 'Custom'.
Support for linked element features has been improved,
when pinning & unpinning connector ends.
Virtualized elements will no longer be drawn if the
connector is hidden (such as using filters or diagram
layers).
Dragging virtual connector ends has been improved when
moving around large diagrams.
The bound 'Properties' dialog now behaves correctly after
a connector is removed by an 'Undo' command and the
diagram is saved.
The issue with 'Set Connector Type' has been addressed,
when the connector's context menu is invoked over both
the connector and another underlying element.
Moving a 'realized' connector now correctly updates its
associated Information Flow connector.
UML syntax validation has been adjusted to allow
Information Flow between Provided and Required
Interfaces.
Exposed interfaces will no longer be drawn off the
element when placed near the edge of the parent element.
When dropping an Image Artifact from the Browser, there
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is now an option to show its name under the image.
A 'Reload Diagram' option has been added to the
right-click context menu for a diagram.
A 'Shallow' diagram copy now resolves embedded
elements on diagram frames.
The 'Clone Structure as New Version' option now resolves
embedded elements on diagram frames.
The 'Clone Structure as New Version' prompt displays the
source diagram name in read-only format.
When 'Hand-Drawn' mode is activated, Shape Scripts will
not render decoration sub-shapes.
Moving non Sequence diagram objects such as a Note
Link will no longer alter the position of other objects on
the diagram.
Quicklinker and Shape Scripts have been improved for
flow charts in the Strategic Modeling technology.
In the 'Communication Message' dialog, object names in
the 'From' and 'To' columns now also include the classifier
names.
Custom compartments will correctly refresh when adding
or removing child elements from the diagram.
A minor issue has been corrected, to ensure dropping
multiple Blocks as properties into a SysML IBD will
occur for all the selected elements.
The position of an edge-mounted ActivityParameter on a
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diagram frame is now saved.
Activity Partitions now maintain transparency when
switching diagram themes.
SysML diagram frames are now resized only as necessary
when displaying Ports.
Handling of diagram background tiles has been improved
to better support shared models with different user
configurations and setups:
- Diagram background tiles applied from the set that is
shipped with Enterprise Architect now load correctly
when the install
directory of Enterprise Architect is different from the
default install path
Rendering of long element names in Sequence diagrams
has been improved.
Stereotyped Compositions now have their default
properties set correctly.
Quick buttons will now draw closer to the element when
the selection rectangle is using a 'thin' border style
Model View elements will now be refreshed and put into
the selection model regardless of the element lock status.
The Structure compartment now shows the correct
information when adding a new property from the
Browser window or when hiding/showing properties from
the Features window, 'Parts/Properties' tab.
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The Dashboard diagram layout will be saved when
reloading the diagram from the diagram tab context menu.
Generation of Activity Graphs from the Structured
Scenario Editor has been improved.
A ControlFlow will connect an Action but not an
Activity; the ActionPin will bind to ActivityParameter.
The manner in which items dragged from the Diagram
Toolbox over a diagram locked to the current user are
handled has been improved.
Double-clicking a diagram preview from the Composite
diagram viewer opens the diagram.
The element name is no longer displayed under an
element after an Image Asset has been removed from that
element.
Removing a hidden diagram layer now correctly displays
any element that existed on that layer.
MessageEndpoint and DiagramGate element names are
now hidden on element creation.
When 'Require user lock to edit' is enabled and a user lock
has been applied to a diagram, existing elements can be
added to the diagram as a link.
Orthogonal movement (when using Shift + drag) of a
child element has been improved to prevent the parent
becoming selected during the 'Move' operation.
The Inspector window 'External' tab now opens without
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taking focus from the diagram.
The compartment entry for Ports will now update
immediately after a Port has been deleted from the
diagram.
Handling of parent element selection after the child
element's type has been changed has been improved.
Information Flow connections are now supported by the
Legend 'Properties' dialog.
Drawing of Wireframe progress bars when the 'block'
style is applied has been improved.
Initial creation size of elements when based on a Project
Template Package has been improved.
Display of both Enumeration literals and objects typed by
an Enumeration in an element's Runstate have been
improved.
Models using an Oracle database with large diagrams that
display related element compartments will no longer
cause an SQL error when loading.
Loading of large diagrams that display related element
compartments for an Oracle repository has been corrected.
The issue where a requirement stereotype defaults to
'Functional' when created in the 'Properties' dialog has
been corrected
Note Links to Navigation Cells will no longer leave a gap
when connecting to the bottom edge.
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When clicking on a Navigation Cell when the underlying
diagram has been deleted, an error message was
displayed; this has been fixed.
Navigation cell text has been improved when the cell is
opened on a machine without specific fonts installed.
Clicking on a Navigation Cell pin will now correctly
display the diagram image popup at different zoom levels:
- The 'Diagram Image' popup will now display at the
same zoom level as if it was drawn in the main view
Auto layout of embedded elements on a diagram has been
improved for:
- Action Pins on Actions
- ActivityParameters on Activities
- Ports on Parts
- Ports on Classes
Auto Reload Diagrams has had further improvements to
provide a more consistent experience:
- A diagram will no longer reload while an element is
selected on the current diagram
- Clicking into a diagram with Auto Reload will no
longer prompt for changes if the diagram isn't dirty
- The applications handling of a diagram reload if an
element was in context at the time has been improved
- The Quick Linker will now prompt to indicate the
diagram has changed before an object is created
- When the Auto Reload option is enabled there will
no longer be a prompt to indicate the
diagram is dirty when just clicking elements; moving
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or changing the diagram will still
prompt if required.
Text, Hyperlink and Diagram Note elements will now
apply the local color correctly when it is the only one set.
The Auto-Refresh timer will no longer be reset back to
'Disabled' when changing values.
The 'Auto Refresh' diagram settings are now saved and
loaded again.
Auto Refresh settings can no longer be changed for
locked diagrams
Diagrams will now be saved when resuming the timer
after using 'Pause & Edit'.
A small drawing issue with 'Paperclip style notes' when
the element has been hidden using a Diagram Filter, has
been corrected.
Diagram filtering has been improved to ensure 'Scope' and
'Visibility' values are correctly filtered on.
Large diagrams on JET databases will now load faster.
An issue with Diagram Sinks that could result in them
silently failing under certain circumstances has been
corrected.
Diagram objects' Z-Order can now be managed on a tab
of the docked Properties window.
Custom diagram type description is now displayed in the
'New Diagram' dialog.
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CentralBufferNode elements have been improved so they
can set and display object state.
Interactions have been enhanced to support Rectangle
Notation.
State entry/do/exit behavior has been improved to list the
correct selection type from the Properties window.
Lifelines that are instances of Node and Device can now
be owned by an Interaction element.
In Shape Scripts, the 'HasProperty()' function does not
require property names to be case-sensitive.
The Quicklinker and Validation have been adjusted to
allow a TaggedValue connector from a Stereotype
element to a Stereotype or Metaclass element.
The Quicklinker and Validation have been adjusted to
allow a UseCase connector from a Stereotype element to a
Stereotype or Metaclass element.
The in-place editor positions and size have been improved
for objects with vertical labels or using Custom Draw
style.
Elements can be re-parented on a diagram by tapping the
Alt key once during the drag, rather than holding the key
down for the entire operation.
Display of arrowheads on Aggregations and Compositions
has been improved.
UML Syntax checking has been updated to allow an
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Aggregation/Composition between Artifact and
Requirement elements:
- An Artifact element can also now parent a
Requirement by Nesting/Composition in diagrams and in
the Browser window
The in-place editor will no longer remain active when a
diagram is zoomed, panned or scrolled.
When adding a new Review element to a diagram via the
Toolbox, the in-place editor is correctly displayed on the
new element.
The 'Image Selection' dialog for a Navigation Cell
element now has a 'Clear image' button to make removing
the existing image easier.
The drawing of Kanban diagrams when CheckList
elements are included in a lane has been improved.
Kanban diagrams that are filled with a search, add
elements to the correct bound lane instead of a Not-Bound
leftmost lane.
Actors using Custom Draw style that are not set to 'Use
Rectangle Notation' now draw their notification icons in
the correct position.
The ability to enable/disable the Custom Draw style has
been added to the diagram 'Properties' dialog, 'Elements'
page.
Creating a Kanban pattern from the 'Construct > Resource
Management > Kanban > Workflow Patterns' ribbon
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options will now work as expected.
Interaction Occurrence rendering has been updated to
apply a user-selected border color.
Synchronizing the Action Pins with the Parameters of an
Activity will no longer include the Action name in each
Pin name.
Classifier rendering for attribute overrides will no longer
also show the information as a runstate.
Activity Parameters will now correctly sit on the edge of
the parent object.
The application error when Pan & Zoom scroll bars are
being rapidly clicked on larger diagrams has been fixed.
The horizontal scroll bar on Grid Style diagrams will now
correctly show/hide when resizing the view.
A Port display name obeys the 'Use alias field for role'
option.
The 'Diagram' tab of the Browser window no longer fails
when the diagram contains a Diagram Note.
SysML diagrams will now resize frames as expected
when an internal connector is attached to the frame.
The display of unsaved changes has been improved for
'Auto Refresh' diagrams:
- The facility now displays an icon with the 'Diagram'
tab instead of the * in the name of the tab
UML keywords will now be hidden with stereotypes if
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'Show Element Stereotypes' is disabled on a diagram.
Custom Draw Style has been corrected so that an element
name will be highlighted when clicked.
Dashed connectors using 'Orthogonal Rounded' style will
now draw corners correctly.
The 'View Composite Diagram' button has been moved
from above the top-left of the object to the right side of
the object, to be with the other Quick buttons.
'View Composite Diagram' now supports linked
Construction diagrams.
ControlFlow connectors to and from
InteractionOccurrence elements are allowed.

Element Reviews
Joining and leaving a Review is now simpler and more
flexible.
See the Join a Review Help topic.

Collaboration
The Chat, Chat History, Model Mail and My Diary (was
Journal) features have been separated out into the Chat &
Mail window.
See the Model Chat, Your Model Diary and Model Mail
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Help topics.
The Journal (was Comments), Discuss and Review features
are accessed through the Discuss & Review Window.
See the Model Discussions, Model Reviews and The Journal
Window Help topics.
There is now a Discuss & Review History window that
provides information on previous discussions, reviews and
Journal entries in the model.
See the Discuss & Review - History Window Help topic.
A Collaboration configurations page has been added to the
Model Options window, to enable you to define a central
model to provide collaboration facilities for other models.
See the Collaboration Page Help topic.
The 'Support Collaboration' setting can now also be changed
from the docked Properties window for the diagram.
See the Properties Window - Diagram Help topic and the
Collaboration Support in Diagrams Help topic.
On a diagram that has 'Support Collaboration' set and Actor
elements for the Chat users, an icon displays against the
Actor element for the user who is currently in a Chat session
with you, effectively the last user to send you a Chat
message.
(c) Sparx Systems 2022

Page 313 of 524

Getting Started

3 October, 2022

See the Collaboration Support in Diagrams Help topic.
There is now an option to display a modal popup editor
when creating a new Discussion or Review, or while focus
is in the Chat editor; press Ctrl+Space to open, Esc to close.
See the Model Discussions Help topic and the Model Chat
Help topic.
When viewing a read-only Journal entry, Discussion or
Review, pressing Ctrl+Space displays the popup editor and
you can select an item of text and copy it into the clipboard
for pasting elsewhere.
See the Take Part in a Review Help topic and the Model
Discussions Help topic.
On the Discuss & Review window and the Discuss &
Review History window it is now possible to set the current
tab as the default tab to show whenever the window is
opened in a new work session.
See (for example) the Discuss & Review - History Window
Help topic.
There have been no updates to the Help in respect to these
changes:
· Corrected the issue that prevents Discussions created in a
Firebird model by Enterprise Architect 16 from loading in
both Enterprise Architect 15 and 16.
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Elements in different Packages will now correctly display
'Chat' and 'Leave' icons if 'user lock' is enabled for a
Collaboration diagram.
The 'Collaborate | Journal' (was 'Comment') load on
window activation has been optimized.
The Collaborations Reviews & Discussions Preview
window displays the current preview after a timer refresh.
Removed the ability to drag and drop text out of in-place
editors such as the 'Journals' tab or Discussion editor, as it
could potentially result in a crash.
Clicking on a hyperlink to a diagram in, for example, a
Chat message shows a pop-up floating menu providing
the options to find the diagram in the Browser window
and to display the Properties dialog.
The Review History and Discussion History windows
now have a 'Topic Author' column.
Chat and Discussion have these changes:
- The scenario where changes to the docked Notes
editor might not be saved
when changing the active Chat using the Msg button
has been corrected
- The behavior where loading a new Chat using the
Msg button resulted in the Chat
disconnecting or staying on the previous Chat has
been corrected
- Monitoring for new discussions on a security Chat
group when
simply connecting to it is now prevented
- Drawing in the in-place editor when editing
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discussions over Remmina has been
improved; for example, using Ctrl+Enter to add a
new line could result in all the text
temporarily vanishing
- Extra space to scroll in the 'Discuss' tab has been
provided so you are not
always pushed against the bottom of the control
when needing to write a reply
- A number of small redrawing and sizing issues have
been corrected in the in-place editor
for Discussions, Journal entries and the Specification
Manager, where the editor could
get sized incorrectly after pasting, deleting text,
undo/redo and so on
- Scrolling issues in the Discussions editor have been
corrected in situations where using
arrow keys to navigate, paste text, undo/redo
changes or delete text
The Manage Reviews window has had major updates,
including:
- Speed improvements
- An enhanced filtering system
- New columns to provide a better overview
- 'Expand' and 'Collapse' menu options
Reviews and Discussions now have additional statuses.
The display of Review and Discussion topics has been
adjusted, placing the most recent post at the top under a
Discussion.
Review Sets can now be instantly created by dropping a
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Nav Cell into your Review diagram, adding the diagrams
the Nav Cells point to to the Review Set.
Loading of the Discussion Preview has been improved
and streamlined.
There is a new capability to manage and share small files
and images through Chats, Journal items and Discussions.
Images can be copied and pasted from the clipboard and
directly inserted as a hyperlink to the internally stored file
for a Chat, Journal or Discussion entry:
- Ctrl+click the hyperlink to download and view the
image or file locally
- Each tool provides a 'Manage Documents' window
for viewing, deleting
or re-sending previously inserted files
- The 'Manage Documents' window allows filtering of
files sent by you or others and
inspecting other details, including file size, type and
date sent
- Files attached to a Journal or Discussion item will be
exported and round tripped
with that element or diagram
New unread Model Mail messages will now appear under
the 'Msg' notification button, displayed top right next to
the 'Perspective' button.
Modified Collaboration diagram behavior to no longer
synchronize selection when changing the active Chat.
Improved drawing of in-place editor for discussions when
using a remote desktop client.
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Hovering over a diagram hyperlink in the Chat window
will display a floating toolbar.
Diagrams with 'Support Collaboration' enabled that are
displayed as an alternative view will still support the
behavior this option provides.
The 'Collaborate | Review' drop-down list now displays
the Quick Access Review element popup list for 'Join
Review':
- Added an option to disconnect from the active
review on logout
- The EAReview element 'Special Action' context
menu option opens the 'Manage Reviews' main tab view
The Journal and Diary windows save edited text when
clicking away into blank tab space or a title bar.
When selecting a new Discussion notification message
from the 'Msg' button, it correctly selects the new
topic/post in the Discussion window.
The brightness of the Discussion text in Dark mode has
been reduced to improve readability.
Pasting an element into a Journal or Diary entry that was
copied from a diagram, will now insert a hyperlink to the
element and not an image.
Security Chat Groups will now display an alternative
color for your Chats to help identify them.

Simulation
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Support for Simple SysML Parametric Simulation has been
restored.
See the Simple Parametric Simulation Help topic.
The DMN Simulation Examples have been fixed, by
changing the Data Set name from 'Default' to 'default'.
See the ItemDefinitions and Data Sets Help topic, and the
Data Sets Help topic.
Simulation UI (dynamic dialogs) have been enhanced to
support showing a Picture control using an image stored in
the model image library.
See the Supported Win32 UI Controls Help topic.
For Executable StateMachines, the order of execution for
multiple StateMachines has been improved.
See the

There have been no updates to the Help in respect to these
changes:
· Standard simulations now have improved support for
more complex data types and enumerations during
execution:
- Simulation can now show attributes with empty
values
· The interaction object name is now editable.
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The User Interfaces Radio Button and Check Box now
support OnClick in simulation.
Executable StateMachine code generation has been
improved to handle 'Conflict Transitions' correctly.
Executable StateMachine: the issue that composite States
show GUIDs on the diagram during simulation has been
fixed.
Executable StateMachines now provide the means to
access Signal attributes from transition and state.
When an Executable StateMachine is running, the
diagrams no longer flicker.
In the activation of Executable StateMachine menu items,
minor inconsistencies have been corrected when selecting
the Executable StateMachine Artifact in the model.
New Executable StateMachine model patterns have been
created for:
- Multiple Ways to enter a State
- History Pseudostate
- Event Macros
Model Pattern names have been updated to expand ESM
to 'Executable State Machine' for readability.
In JavaScript, when running an Executable StateMachine,
the possible failure of debug breakpoints has been
corrected.
Dynamic simulation with Win32 dialogs now preserves
the Z-order of the diagram for the created dialogs.
The DMN Simulation window no longer escapes Unicode
characters.

(c) Sparx Systems 2022

Page 320 of 524

Getting Started
·

·

·

·

·

·
·

·

·

·

·

3 October, 2022

For Loop expression is now supported in DMN modeling
and simulation.
Copy and paste of Simulation artifacts (BPSim, DMN,
SysML) has been corrected to ensure they retain their
internal configuration.
The 'BPSim Result Chart' and 'Custom Result Chart' now
load the data.
The problem of the BPSim Engine not starting due to
socket not opening has been fixed.
The problem of the BPSim Engine not starting with Zero
Configured Enterprise Architect has been fixed.
The BPSim Engine can now operate using Java 7.
Execution of the BPSim simulation and process
optimization tools has been modified to use the native
Linux Java libraries instead of the Windows/Wine ones,
due to restrictions in installing the latest Java runtime
under Linux/Wine.
BPSim now supports more detailed and improved CSV
export of information from the BPSim Resource window
via a new menu, accessible from the toolbar 'Step' button.
The BPSim Model Wizard pattern previews have had
minor updates and improvements.
In BPSim Simulation Step Replay:
- The inaccurate Resource Release issue has been
fixed
- CSV export for resource allocation/release details for
each token on tasks is supported
BPSim Artifact configuration for Package browsing has
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been improved:
- A meaningful message prompt is provided when no
parameters are configured
- The message no longer prompts twice
- The configured Package is now selected when
opening the browsing dialog
In the Simulation docked window the console editor
height has been increased so that it takes into
consideration high DPI settings.
More-detailed error messaging is supported when running
a simulation, including identifying the script that failed to
execute.
Dot and hyphen in the Vertex name (for example,
State.A-1) has been updated and improved.
The Simulation & Event window will now display when
running a diagram simulation.

Code Analyzer View
The Code Analyzer window has been given two tabs to
separate the Code Editor from the Query facility, and a
'Default to Analyzer' menu option to automatically connect
the Code Analyzer to the Code Miner service configured for
the active Execution Analyzer Script. A Code Analyzer icon
has been added to the Develop > Source Code ribbon panel
to access the feature.
See the Code Analyzer Help topic.
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Search, query and inspect your Code Base with incredible
speed and detail:
· Compile your code base into a Code Miner repository.
· Use one of the supplied language grammars (or write your
own!).
· Use the mFQL query language to search and inspect your
code.
· Results are returned in milliseconds, even for large code
bases.
· Connect with Enterprise Architect's code editors to
provide on-the-fly Intelli-sense.
· Expose a code base as a service - either local or shared.
· Fast, minimal-impact updates compile new changes and
additions only.
· Create your own grammars to parse any structured
information.
· Incremental updates to Code Miner repositories are
supported, along with an auto-update feature using the
Intel Service.
· Code Analyzer is available from the Develop ribbon >
Source Code panel.
There have been no updates to the Help in respect to these
changes:
· The Code Explorer view is no longer provided.
· Incremental updates to Code Miner repositories and
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auto-update feature in intel service are supported.
Code Miner C++ Grammar has been improved to support
variadic template classes and functions.
Code Miner C# grammar has been updated to fully
support language features introduced in versions 7 - 9.
Shortcuts have been added for mFQL, such as 'byName'
for 'getByName'.
A Code Miner database compilation can now be built
from multiple directories.

Documentation and Reporting
Custom Documents - One of the major innovations in
Release 15 is now enhanced to provide an even more
compelling solution for building highly customizable
reports:
· You can select and apply a template on initial document
creation
· More details are provided on setting the sections
· The Content list has been improved to contain the element
and template being used for each dynamic section
· A Progress bar has been added to provide better feedback
during document generation
· Warnings are now displayed in cases where data would be
lost upon updating a dynamic section
· Custom Document elements can now be created via the
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Diagram Toolbox
· There have been numerous enhancements and usability
updates
· The easily-reached Help information has been expanded
See the Custom Documents Help topic.
There have been no updates to the Help in respect to these
changes:
· The 'Last Run' field reporting 'InvalidDatTime' in
Generated Test documentation has been corrected.
· The Document Generation 'reportpackage' stereotype can
now correctly generate a document to an Artifact element.
· Document Generation will now correctly size elements
when using bitmap images to ensure that text remains
within the elements.
· The HTML generator now correctly writes images to a
Unicode path.
· The HTML generator no longer generates corrupted
Structured Scenario sections.
· HTML generation templates now support
#CREATEDATESHORT# and #MODDATESHORT#
for Element and Diagram templates, to give the date only.
· The HTML template editor now allows customization of
'Page Body - Header' and 'Page Body - Footer'.
· HTML Reports will now append the Port & Part property
type to the element name in the Browser window.
· Document Generation 'Exclude' filters now support the
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SQL substitutions #Package# and #WC#.
'Print to PDF' rendering has been improved when
Diagram Frames are included.
Rendering of connector labels in documents and saved
images has been updated to use the correct background
color.
'Generate Element Report' (from Start > All Windows >
Publish) no longer fails silently if an appropriate element
is not selected in the Browser window or active diagram.
The 'Diagram Report' option (from 'Start > All Windows
> Publish') has been renamed to 'Generate Diagram
Report'.
Document Generation now allows Reviews to be
included.
Document Generation now allows filters to be defined for
Attributes.Notes.
New document templates available through Model Wizard
(accessed from Document Publishing perspective).
64 bit Enterprise Architect has been updated to support
reading the legacy rich-text .SSE format:
- This document format was not widely used and thus
writing to this format had not previously been supported
in the 64 bit edition
Report Generation has been notably enhanced with new
patterns and templates to target specific documentation
scenarios and goals:
- The Publish | Report Builder, Custom Documents
and Model Documents can all take advantage of these
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new tools and templates
The base/default HTML Publishing templates have been
updated with a fresh new design, allowing them to be
compatible with modern browsers for local viewing.
The ability to document Comments of an element has
been added.
Generating to a Document Artifact is now ensured, using
'Create Document to Artifact' on a <<report package>>
stereotyped Package element.
Several non-critical message box pop-ups that could occur
while editing notes and documents have been redirected to
the System Output window
Image generation during document generation has been
improved, to prevent bitmap elements potentially
displaying with text overlapping edges
When generating 'selected items', we now always use the
'Template' sorting option
Documentation of Reviews is now available in generated
reports
The generated Scenario test words 'Alternate', 'Continues',
'Exception', 'Rejoin', 'Result' and 'When' have been added
to document generator substitutions
The filtering behavior of element and connector excluded
types has been improved
The 'IsStatic' property for attributes and operations is now
reported correctly
Tagged Values of type URL are now created as a
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hyperlink when published to HTML
When you are deleting a CSV Specification, a prompt has
been added to seek confirmation of the deletion
Scenarios generated as Scenario Tests will be set with the
Scenario Test Type

Database Engineering
There have been no updates to the Help in respect to these
changes:
· Invalid SQL messages when changing the datatype of a
new column have been corrected.
· 'Native' connections have been introduced as a method of
reading a database schema during data modeling.
· Display of the 'Foreign Key Properties' dialog under
different Visual Themes has been improved.
· The Model Wizard Database Engineering Patterns have
been expanded and improved.
· The 'Create New Custom Template' dialog now displays a
warning when all the required values are not supplied.

Kanban
There have been no updates to the Help in respect to these
changes:
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Kanban diagram settings will be correctly copied when
copy-pasting the diagram in the Browser window
Checklists in Kanban lanes will no longer cause constant
redraws of the diagram
Kanban diagrams will now sort elements into the
appropriate columns as the element status changes
Keyboard navigation has been enabled for the Kanban
diagram 'Properties' dialog
The 'Kanban' dialog restores the diagram state when
canceled
The 'Search filters' dialog list control has been upgraded

Execution Analysis
The Code Miner page of the Analyzer Script Editor now
provides an option to switch the F12 'Find in Files' option
between using the defined Intel service and the Find In Files
window.
See the Client Configuration - Configuring Enterprise
Architect to Use a Code Miner Service Help topic.
A description of the Code Miner mFQL has been added to
the Enterprise Architect Help.
See the The mFQL Language Help topic.
The Console window has been changed in use and in access,
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as a script editor for JScript, VBScript and JavaScript code.
See the Console Window Help topic.
A new Analyzer Services View has been implemented to
display the status of each of the services being managed by
the active Analyzer Script and of any local services
managed separately using the service configuration file.
See the Analyzer Services Window Help topic.
The Profiler has a new 'Hit Analysis' tab to show the number
of samples taken in which the specified function was
executing.
The Profiler also provides the 'Process Time (estimated)'
field to show an estimate of how long the process being
profiled has been running.
See the Profiler Call Graph Help topic.
The Debugger Stop button now provides options to stop the
debugger and process, detach from the running process or
quit from the application.
See the Run the Debugger Help topic.
The Debugger ActionPoint statements can now use the jmp
command to switch execution to a different line; this is
effectively the same as the goto command but acts through
instrumentation instead of breakpoints.
See the Actionpoints Help topic.
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It is now possible to debug JavaScript in diagram Scriptlets
and Dynamic Charts.
See the Chart Definition using JavaScript Help topic, and
the Scriptlets Help topic.
The Execution Analyzer window toolbar options now act on
the Analyzer Script currently selected in the tree. If no script
is selected, the options continue to operate on the active
Analyzer Script (with a selected check box).
See the Managing Analyzer Scripts Help topic.
The Sparx Intel service program provides a means for
development projects and players to gain valuable insight
into the code bases and software frameworks they are
working with. The service allows access to Intelli-sense in
code editing and insightful search results in search tools. It
is part of the Sparx Satellite Services umbrella and allows
multiple Enterprise Architect clients to access and query the
same information from many different software domains
and frameworks.
See the Sparx Intel Service Configuration Help topic and the
Sparx Intel Service Automatic Update Help topic.
A Job Queue feature has been added. When an Analyzer
Script context menu option is executed (for example,
'Build') it is placed in a job queue; multiple jobs can be
queued, and other work performed while the jobs are
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processed. Running jobs can also be easily canceled using a
context menu option.
See the The Job Queue Window Help topic.
A facility has been added to the Analyzer Scripts whereby a
Model Mail message can be sent to a defined user group
when a job or task has completed.
See the Analyzer Script Editor Help topic (Job Settings table
item).
There have been no updates to the Help in respect to these
changes:
· The 'Execute' Quick Access Page (Alt+4 or Start > All
Windows > Execute) now includes the Analyzer Services
View.
· When using the GNU Debugger, avoid passing empty
args if none have been specified.
· The Code Analyzer and Grammar Editor have had
performance enhancements.
· The Code Analyzer Source editor UI is set to the
application UI theme.
· Variables of unsigned char type are represented as both
character and integer content in the Debugger windows.
· Watched items can now be renamed from the docked
Watches window.
· The Profiler report now has a 'Depth Analysis' tab.
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Modeling Languages - General
Where Enterprise Architect supports more than one version
of a tool such as BPMN, SyML or ArchiMate, the latest
version is automatically offered in the Perspectives. To use
earlier versions, either select the 'All <toolname>
Perspectives' option or create a custom Perspective.
For example, see the (BPMN) Getting Started Help topic.
There have been no updates to the Help in respect to these
changes:
· Enterprise Architect 16 continues to expand the library of
re-usable patterns and content that drives efficiency and
productivity, with new patterns for:
- DMN
- AUTOSAR
- SysML
- Dynamic Simulation Win32
- Modelica case studies
- SysPhS library
- Octave Solver
- Scriptlets
- Wireframe
· The UAF Security Toolbox has been updated with
changes made for the specification.
· Metamodel rules targeting ActionPins no longer result in
validation errors when used.
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The FACE Profile for UAF v1.0 is now supported:
- Available in the Unified or Ultimate Editions, or
other editions with a separate UPDM license
The connector 'IsAComponentOfThePlanFor' has been
added to the BMM profile.
The 'Create Metaclass' dialog can create both Property
and Part metaclass elements.
The 'Create Metaclass' dialog no longer lists 'Defect' and
'Test' twice.
UAF Signal stereotypes have been added to Toolbox
pages.
The 'Signal' keyword is now omitted for stereotyped
Signal elements.
The TOGAF Model Wizard pattern has been updated to
remove out-of-date URLs.
Operation definition using a referenced Behavior is no
longer restricted to the same owner.
'Abstract Action' kinds are no longer offered during the
creation of an Action.
The UML Standard Library Auxiliary stereotype has been
corrected.
Constraint elements can be owned by other elements.
Model validation for a Use Case 'extend' and 'include'
relationship has been corrected to prevent it being
reported as 'not legal'.
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ArchiMate
Connector notation options are is now blocked from use in
ArchiMate diagrams.
See the Diagram Properties - Connectors Help topic.
Displaying compartments on ArchiMate elements is not
possible and options to do this are disabled on the
ArchiMate element context menu.
See the Compartments Help topic.
There have been no updates to the Help in respect to these
changes:
· Fixed the issue when importing ArchiMate triggers an
SQL error with string length overflow.
· Quick Linker commands and validation rules have been
added for ArchiMate connectors:
- 'Path'
- 'CommunicationNetwork'
- 'DistributionNetwork'
· All ArchiMate connectors have been prevented from
realizing UML InformationFlows.
· Toolbox pages where the name is shared across multiple
Toolboxes have been updated to include the layer to help
differentiate them in the 'Pinned Toolbox Pages' dialog.
· The ArchiMate importer has been updated to improve the
handling of trigger values close to 255 characters.
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The ArchiMate importer has been updated to import the
original identifiers into Tagged Values:
- archimate_element_identifier - Used for anything
mapped to an Enterprise Architect element
- archimate_connector_identifier - Used for anything
mapped to an Enterprise Architect connector
Word wrapping in drawing ArchiMate shapes has been
improved.

BPMN
There have been no updates to the Help in respect to these
changes:
· The resizing of Pools and Lanes that have child Pools or
Lanes has been corrected.
· The dialog that is displayed when creating new a BPMN
2.0 Process will now correctly display text.
· The connector validation rules for Associations to Text
Annotations have been improved.
· The diagram editing behavior when pasting element(s) as
links using the right mouse context menu has been
corrected; the elements are now pasted relative to the
position of the mouse cursor when invoking the context
menu.
· You now import the BPMN2.0::DataAssociation when it
is directly connected to BPMN2.0::Tasks.
· BPMN Association Shape Scripts have been improved:
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- The line is now dotted, arrowheads show when
bi-directional, and the Line Style is now Orthogonal
Square

DMN
Decision Model and Notation - Implemented the DMN List,
Relation and For Loop objects.
See the Relation and Boxed List Help topics.
There have been no updates to the Help in respect to these
changes.
Enterprise Architect now supports DMN primitive types for
Modeling and Simulation:
· The primitive types 'date', 'time', 'date and time', 'days and
time duration', 'years and months duration' are now
supported.
· These built-in functions are now supported:
- duration, date, time, date and time
- value_dtd, value_dtd_inv (inverse function of
value_dtd)
- value_ymd, value_ymd_inv (inverse function of
value_ymd)
- value_t, value_t_inv (inverse function of value_t)
- value_dt, value_dt_inv (inverse function of value_dt)
· These type operations are now supported:
- date - date = duration
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- date +/- duration = date
- time - time = duration
- time +/- duration = time
Auto-Complete Behavior for DMN Decision Tables has
been improved and is now available on:
- The Input Clause's allowed value cell; the
auto-complete list can list the
'allowed values' of a connected InputData element's
ItemDefinition
- Input/Output Entry cell; it works correctly when the
user selects the
auto-complete item using Up/Down Arrow and Enter
key
- Input/Output Entry cell; it can filter out the number
range value from
the auto-complete list correctly
The DMN Simulation Window is now updated when the
DataSet changes.
The DMN ItemDefinition's AllowedValues have been
adjusted to enable them to be set correctly.
DMN's List and Relation are now supported, including the
GUI, code generation and simulation.
The 'Template Package' dialog has been enhanced to help
facilitate correct tree item selection.
DMN Decision Table validation has been improved with
regard to Input Entry data type validation:
- Now the validation can detect incorrect Input Entry
value data types
- Now the validation no longer wrongly raises a
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warning if the Input data type is assigned
a type other than 'string', 'boolean' and 'number'
DMN Decision Table validation handling of discrete
allowed values has been improved.
Component names that contain a space have improved
support; now the InputData runtime value will show if a
Component has a space in its name.
Setting the InputData's typeRef to ItemDefinition has
been adjusted; it will now update the Expression View.
'At Literal' for a DMN date/time/duration expression is
now supported.

SysML
Simple methods of simulation of SysML Parametric models
have been reinstated.
See the Simple Parametric Simulation Help topic.
There have been no updates to the Help in respect to these
changes:
· SysML ValueType now supports
Generalization/Specialization Quick Links.
· The display of multiplicity in SysML compartments has
been corrected; it is no longer displayed when no type is
available.
· SysML directed features (prov, reqd, provreqd) in
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compartments now show their directional prefix.
The allocatedTo and allocatedFrom compartments have
been improved; they now display classifier or property
type if the related element has one.
Ports and Parts in compartments now show the roles, if
set.
Aliases now display correctly in SysML Block
compartments.
The edit selection of a newly created SysML Requirement
element in the diagram has been corrected.
Edge mounted elements will no longer be added to the
diagram as selected when using 'Synchronize Structural
Elements' on SysML IBD and PAR diagrams.
Adjusting the Regions on SysML State/StateMachine
diagram frames has been improved.
Port specification group properties are now persistent in
the docked Properties window for the current and IBD
diagrams.
SysML properties are nested correctly on drag-and-drop
to a classified parent.
A Legend can now be applied to an Information Flow
connector.
You can now update the value of the Runstate of a SysML
QuantityKind or Unit.
The movement of child Ports on Ports has been improved.
The movement of Ports with child Ports has been
improved.
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The SysML Primitive Value Types pattern has been
improved to define 'Number' as Abstract, in accordance
with the specification.
The SysML Unit and Quantity Kind pattern has been
corrected to no longer include an example instance and set
attributes' multiplicity.
A new ISO-80000 library pattern has been added for
quantities and units.
In the SysML1.3 to SysML1.4 migrator:
- The tag isEncapsulated from InterfaceBlock is now
migrated correctly
- When multiple stereotypes are applied, the primary
stereotype will now be migrated
The Quick Linker will now offer Composition between a
Constraint Block and Block.
An Allocated connector is now permitted between all
named elements.
A stereotype wildcard is now allowed in a Quicklinker
metaconstraint (for example, set source and target to
'SysML1.4::*').
Self-connectors on elements that are contained by SysML
diagram frames will now move, undo and redo correctly
when the frame itself is moved.
In a SysML Parametric diagram, parameters with or
without stereotypes show as a square box on the inner side
of a ConstraintProperty's border.
The ItemProperty selection type of a SysML itemFlow
connector has been corrected.
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The SysML 1.5 DirectedFeature stereotype now also
extends Reception.
Setting the type of a SysML Port to a Block that has a
Flow Property will now correctly update the directional
arrow when saved.
In-place editing a SysML child element compartment item
now handles spaces in the name of the type.
SysML ConstraintBlock editing will no longer give
database errors on Oracle.

SysPhS
The Package Import connector has been added to the
SysPhS Toolbox page.
See the Using the SysPhS Toolbox Help topic and
Referencing the SysPhS Simulation Libraries Help topic.
There have been no updates to the Help in respect to these
changes:
· Multi-dimensional arrays in Simulink have been improved
so that SysPhS constant initial values now support
negatives, scientific notation, and so on.
· The SysPhS compartment display of 'physical
interactions' has been improved.
·
·

Modelica simulation has been improved, with better
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handling of child parts (especially in specialized
Constraint Properties).
The export and rendering of diagrams within Modelica
has been improved in situations where the base Enterprise
Architect diagram is missing or incomplete.
Modelica Parametric Simulation patterns have been
updated and improved.
The OpenModelica simulation issue in EAExample has
been fixed.
OpenModelica simulation has been updated to provide
better support for models with flow properties.
The detection of 'signal' or 'physical' Ports has been
improved.
The layout of Ports in Modelica has been improved.
The listing of plottable items in Modelica Simulations has
been improved.
The Registry key used to store a custom path to Matlab
has been moved (user re-configuration required).

UML
In Diagram Toolbox pages, the Activity Region element has
been replaced by separate Expansion Region (except
SysML) and Interruptible Activity Region elements.
See the Expansion Region and Interruptible Activity Region
Help topics.
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Action Pins are now assigned or reassigned to Action
elements through the Properties window for the Action
element.
See the Assign Action Pins Help topic.
On the Decision element, it is possible to set and display
InputDecisionFlows and InputDecisions.
See the Decision Help topic.
There have been no updates to the Help in respect to these
changes:
· The Quicklinks for UML Communication diagrams has
been adjusted to allow valid UML connections.
· The UML Component diagram starter Model Wizard
pattern has been enhanced.
· The correct Action Pin name and type are now displayed
on diagrams.
· Superfluous patterns in the Model Wizard are now hidden
for non-UML Perspectives.
· The Model Wizard pattern: 'UML Activity with Pins' has
now been corrected.
· Disallowed the 'Convert to Instance' command for
RequiredInterface and ProvidedInterface elements.
· The 'Construct Picker' dialog action for Triggers has been
modified.
· ActivityPartitions now don't inherit Ports and Parts from
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the classifier that they represent.
Action Pins typed by Activity Parameters will now take
their multiplicity from the Activity Parameter as required
by the UML Specification.
Nesting connectors are now permitted between any
Namespace elements (including Class).
Messages on Communication diagrams can now have a
change of lifecycle.
Names of Component instances are now underlined.
Interrupt flows can now target Activity Nodes.
The name of 'Big Data' on the GCP Analysis toolbox has
been changed to 'Big Query'.
The '<none>' option has been removed from the 'Select
Trigger' dialog for a Transition, as a Trigger can be
removed using the Delete button on the 'Transition
Properties' dialog.
Action Pins now display the correct name and type on
diagrams.
Non-UML Perspectives in the Model Wizard have been
refined; they no longer show superfluous patterns.
ActivityPartitions with a classifier have been corrected
such that they no longer inherit the Ports/Parts of their
classifying element.
New <<redefines>> and <<removed>> stereotypes have
been added to the EAUML profile.
'Unmarshall' is now an option in the 'New Action' dialog
when choosing 'Other'.
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UML Activity Partitions with 'isExternal=true' now show
the external keyword in the swimlane header.

Technology Authoring
Support has been provided for in-Package definition of
Tagged Value types for a profile, using Data Type elements.
See the With Predefined Tag Types Help topic.
When adding custom Model Wizard templates to an MDG
Technology file, the location of the template XML file and
RTF file has been clarified.
See the Incorporate Model Wizard Templates Help topic.
The diagram.MDGView property has been added to element
and connector Shape Scripts, allowing the Shape Scripts to
test the value of the diagram view type.
Also added diagram.author and diagram.version properties
for Shape Scripts, to supply the author and version of the
current diagram.
See the Display Element/Connector Properties Help topic.
The facility has been added to use wildcards in Quick
Linker constraints.
See the Define Metamodel Constraints Help topic.
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Support has been implemented for groups in Azure AD with
OpenID.
See the Walkthrough: OpenID with Azure Help topic.
There have been no updates to the Help in respect to these
changes:
· The Cyber Security technology has been updated:
- The 'Data flow' connector now defaults to Custom
style instead of Bezier style
- The 'Threat trace' connector is now allowed from
'Process' and 'Human Actor' elements
· The SQL error on saving an empty UML Profile has been
fixed.
· Scripts provided by MDG Technologies no longer
interfere with editing the original script in the source
model.
· Saving a diagram as a Profile for the first time will fill in
the Name, Version, and Notes.
· You can now save a UML profile when no profile
Package is supplied; an empty UML profile stub will be
generated.
· The issue experienced mainly when both developing and
testing an MDG Technology in the same model has been
corrected:
- The scripts in the generated MDG Technology could
hide the
original development scripts in the model, resulting
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in the inability
to edit the development script and update the MDG
Technology
Synchronization of constraints from a Profile has been
improved to ensure constraint values are correctly
escaped.
The Model Wizard has been modified to allow custom
Technologies to specify a full path to the RTF files
detailing the Pattern's purpose and usage:
- Searching the Technology's base location has also
been added
Diagram Toolboxes created from a Technology Profile
can now support dropping objects that extend the base
stereotype 'EnumerationLiteral'.
Creation of Metaclass elements has been corrected so they
are created with the fully qualified stereotype.
Properties in the 'Profile Helper' dialog have been
re-ordered so that they match the order in the
'Compartment Visibility' dialog.
The Extension relationship has been added to the
Quicklinker for a Stereotype to Metaclass connection.

External Integration
·

·

Field mappings will now inherit the default values when
modified for the first time for a specific type.
Detailed OAuth errors are now displayed to provide more
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assistance in determining the cause of an error during
log-in.
When closing the External Data window, you can
force-close any outstanding requests to prevent a potential
wait time-out.

Code Engineering
In an Enterprise Architect code editor, when the 'Search
Intelli-sense' context menu option is chosen Enterprise
Architect no longer displays a sub menu containing all the
mFQLl queries named in the Sparx query library, but acts
on the search term using whatever query is selected in the
'Intel' tab of the 'Find In Files' control.
Also, there are two new menu options to copy the cursor
position or a text string as a hyperlink to paste into an RTF
editor, such as a Chat message, to return the message reader
to the selected part of the code file.
See the Code Editor Context Menu Help topic.
Complex Function Macros can include the function body in
braces, in which case Enterprise Architect skips over the
token including everything inside the parentheses and inside
the braces.
See the Language Macros Help topic.
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Improvements to support new C++17 language features, and
round-tripping the constexpr specifier on a variable or
function.
See the C++ Conventions Help topic.
Enterprise Architect now supports C# 9.0 with the 'record'
stereotype and the 'PositionalParameters' Tagged Value.
It also provides the extensionAttribute Tagged Value, which
helps support the import of .cs files.
See the C# Conventions Help topic.
The async keyword can now be used in the Python
conventions, to support Python up to version 3.8.6.
See the Python Conventions Help topic.
Java 16 support provided with the addition of the
'CompactConstructor' and 'record' stereotypes, and the
'RecordHeader' Tagged Value.
See the Java Conventions Help topic.
Improvements have been made to importing a MONO
Solution into your model.
See the Import Projects Help topic.
In writing Model Transformations, the Object code now
includes the objectType MergeNode and the objectProperty
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nType.
See the Objects Help topic.
There have been no updates to the Help in respect to these
changes:
· C code generation no longer generates definitions for
automatically realized functions into the header file.
· C# parsing has been updated to handle nullable array
types.
· C# reverse engineering has been updated to correct a
number of parse errors.
· C# code import has been improved to better handle direct
access to an object returned by a method; for example,
GetCustomer().Name.
· The C# code generator has been updated to include
support for TemplateBinding connections.
· C# code engineering has been improved to handle the
attributes in an extension method definition.
· C++ Code Engineering now supports the import of code
that declares Classes with inner 'using' clauses.
· C++ Code Engineering has been improved to support:
- Import/generation of 'member variable template'
(C++14) and 'member function template'
- C++14 'digital separator'
- C++14 new binary literal
- All string encoding prefixes - u8, u, U, L
· The Code Editor and Code Engineering have been
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improved to support C++ attributes that can appear in
various places in C++ code.
Code Engineering and the Code Editor have been updated
to better support C++/CLI:
- Code Engineering and Code Editor now handle
C++/CLI 'partial'
class/struct definition correctly
- Code Engineering now handles the C++/CLI pointer
'^'
in parameter type correctly
- Code Editor now handles C++/CLI 'sealed' Class
definition
and C++/CLI property definition correctly
Code Engineering and the Code Editor have been
improved to better handle the C++ complex template
parameter:
- In reverse engineering, a complex template
parameter with default value
will no longer cause a parse error when it is imported
- In the Code Editor, the consecutive right-angle
bracket '>>' in the template
definition/instantiation will no longer cause a parse
error in the structure tree
C++ reverse engineering has been improved to correctly
handle a template parameter with type only.
Code Engineering has been improved to support new
Python 3 language features (up to Python 3.8.6):
- Python 3.5: Dedicated infix operator for matrix
multiplication (PEP 465)
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- Python 3.5: Additional Unpacking Generalizations
(PEP 448)
- Python 3.6: Underscores in Numeric Literals (PEP
515)
- Python 3.8: Assignment Expressions (PEP 572)
- Python 3.8: Positional-Only Parameters (PEP 570)
Python Code Engineering has been improved to support
Variable Type Hint and the Async/Await function.
The Code Editor now updates the scrollbars correctly after
searching for text; the warning popup that no text was
found has been removed.
The Code Editor structure tree now correctly displays for
an Interface defined with "MIDL_INTERFACE".
The 'CONST' and 'PURE' keywords for 'STDMETHOD'
method will no long cause a parse error in the structure
tree of the Code Editor.
The Code Editor has been updated to handle data types of
'long double' and 'long long int' correctly.
The element Behavior code editor structure tree menu has
been improved.
The Enterprise Architect code importer can import Java
methods where the generic type parameters are either
before or after the annotations.
LoopNodes and ConditionalNodes in an Activity will now
generate code.
A new option, 'Enforce Synchronization', has been added
for implement/override methods:
- When applied to an element, changing the signature
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of any operation owned by that element will apply to all
overrides
- When applied to an element, deleting an operation
from that element will also delete all overrides
The Grammar Editor Profiler has been improved to handle
forced token syntax in MBNF grammar correctly.
In Package Code Generation, suppressed namespaces are
skipped.
Synchronization of code updates into the model will now
remove annotation Tagged Values when the annotation is
removed from code.
The Enterprise Architect auto generate path has been
improved to use CodeOption DefaultSourceDirectory as
the path.
Support for a new Macro format of "Function Macro"
with a function body has been added; for example,
"INTERFACE_IID_() {}".
Code generation from Templates which include macro
lists of "@arguments" has been corrected and improved to
allow referencing the arguments as "$parameter1,
$parameter2,..." during generation of code.
The bug causing Enterprise Architect to lose #include
enumeration file clauses for referring attributes and
operations has been fixed.
The system now ensures you do not generate/synchronize
code from single element types other than
Class/Interface/Enumeration.
Enterprise Architect Model Transformation now supports
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Allow Duplicates of attributes of Class elements and
notNull of columns of Table elements.
Import XSD now allows selecting files on network paths.
Model Transformations now support including Element
Constraints in the Transform process.
Model Transformation behavior now supports 'Activity
Initial' and 'Activity Final'.
Accessing, customizing and utilizing the user
configurable code generation templates has been
improved for the various languages prefixed with STM_.
Code Engineering has been updated to better handle Java
Enum definition:
- The Code Editor structure tree can now display the
Java Enum definition
- The "implements" clause for the Java Enum
definition will be generated correctly
Code engineering support has been added to the Java new
language features (up to Java 15):
- Java 14 "Switch Expression" (JEP 361)
- Java 15 "Text Blocks" (JEP 378)
The Code Editor has been updated to support the Java 16
new feature - Pattern Matching for instanceof (JEP 394).
Code Engineering support has been added for the Java 16
new feature - Records (JEP 395).
A new option has been added to Technologies to allow
them to specify code generation into a single file:
- The option 'GenToSingleFile' is Technology-specific
and not accessible
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through the normal 'Model' or 'Code Options' pages

Schema Composer
There have been no updates to the Help in respect to these
changes:
· When generating JSON schema using the Schema
Composer, attributes will no longer generate an array if a
Min and Max quantity are defined, but are equal.
· Generation of XSD from CIMDatatypes has been
corrected and improved especially with respect to creating
ComplexTypes in preference to SimpleTypes.
· Handling of the Tagged Value Notes property has been
improved in generating JSON Schema from the Schema
Composer.

XMI Import/Export
Support has been added for NIEM 5.0, and the Help updated
to reflect NIEM 5.0.
See the National Information Exchange Modeling (NIEM)
Help topic.
A new feature allows round-tripping Packages in Native
format (XEA) using the QEA file as the data transfer
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medium.
See the Export to XMI and Import from XMI Help topics.
Package Control processes now support the use of Native
Format (XEA).
See, for example, the Configure Packages Help topic.
An option has been added to the 'Cloud' page of the 'Manage
Model Options' dialog, to block XMI import to models on a
Cloud connection. This is to prevent import problems in
situations where the connection might be at risk of failing.
See the Cloud Page Help topic.
There have been no updates to the Help in respect to these
changes:
· The CSV Import/Export dialog has been updated to
ensure the code page is valid under Wine.
· CSV import of Tagged Values has been improved to
better handle tag types that include a profile Namespace.
· Checking if the database user has ALTER and DROP
permissions in MySQL now has no impact on a project
transfer.
· Correct checks of Security permissions for MySQL and
SQLServer databases are run prior to a project transfer.
· Post processing of a project transfer into case sensitive
SQL Server database has been corrected.
· A BPMN import issue where a Boundary Event's parent
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could become the lane has been corrected.
When exporting a cloned diagram via XMI the link to the
base diagram is maintained.
Project Transfer via Native XML, on completion, will
automatically load the default diagram into the model.
Project transfer to MariaDB has been improved, when the
database user name includes the underscore character.
Native XML Import will no longer truncate element
Notes.
Error handling when importing reference data to the
model has been improved.
When importing from a Native/XMI file, the correct
confirmation message is now shown.
Round-tripping internal documents associated with
Discussions & Journals via XMI & Native Formats is now
supported.
Native XML Import will no longer cause an error when
inserting an empty value for the 'image' type column in
SQL Server over SQLAPI.
In XMI 1.1 and XMI 2.1 with 'Strip GUIDS' selected, the
type for a Connector has been updated.
The import of Rhapsody model files has been improved,
to better manage global Classes defined in the imported
model; it doesn't generate multiple TopLevel Classes.
The custom map 'CMapDOMNodeToString' has been
corrected, as it was breaking proper Native XML
roundtripping.
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Magic Draw import issues for Packages and elements
have been corrected, including:
- The import of a Magic Draw SysML project has
been improved
- Concerning a Port's RequiredInterface and
ProvidedInterface:
- The Interaction Point window will now work
with ProvidedInterface and RequiredInterface on a reused
Port
- MD import will create ProvidedInterface and
RequiredInterface on a Port
- MD import will create ProvidedInterface and
RequiredInterface on a reused Port
- MD import will set isReference for SysML
reference properties
- MD import will import a hyperlink as a
Navigation Cell
- InterfaceRealization connectors can be imported
- For State regions
- For a StateMachine's Transition Trigger with Signal
Event
- For reused properties and connectors; arbitrary level
of nested properties (Parts/Ports) show on IBD diagrams
- The missing ContainmentLink, now imported as a
Nesting connector in Enterprise Architect
- Sequence diagrams support the import of Lifelines
and fragments, and draw the Sequence flows at the correct
position
- SysML Requirement elements:
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- Now import as a Requirement instead of as a Class
element
- Removed duplicated Tagged Values
- Support SysML 1.5 projects
· No more missing Trigger with a Change Event on a
StateMachine Transition.
· Native XEA file exchange format has been implemented:
- A new fast and convenient alternative to XMI and
XML format for
the speedy data exchange of large Packages
- Using XEA format helps to streamline model
archiving and the
export and import of Enterprise Architect
repositories
· The ECore exporter now supports:
- The property ID to eAttribute
- The property documentation to eClassifiers,
eAttribute, eOperation
- Output of XML format

Automation
GetElementByGrid, GetElementByName and
GetObjectByGrid methods added to the Diagram Class in
the Automation Interface.
See the Diagram Class Help topic.
Added the MoveElementToGridPosition method to the
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element interface for future use.
See the DiagramObject Class Help topic.
The Project Automation Interface of Import Directory for a
Visual Studio Solution has been improved:
· Only prompt once during import to confirm that we are
creating a Package per Namespace
· 'ImportVisualStudioSolution' has been added for
importing a solution to the selected Enterprise Architect
Package
See the Project Class Help topic.
Scripting - the Javascript content for EAScriptLib and
LocalScripts has been updated. The Scripting Console has
also been streamlined into the Javascript Console window
and the separate Scripting window.
See the Scripting Help topic, the JavaScript Console Help
topic, and the Scripting Window Help topic.
There have been no updates to the Help in respect to these
changes:
· Reloading a diagram via automation has been improved.
· The EA_MenuClick response to Gantt, List and
Specification views has been fixed.
· The misleading menu 'location' with reference to
EA_GetMenuState, in the context menu of the 'Project'
and 'Context' tabs of the Browser window, has been fixed.
· When Attribute.Update is called, it doesn't change the
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context.
The 'SQLQuery' to output both date and time portions for
the 'DateTime' field value has been improved (originally it
only output the date portion).
Diagram.SelectConnector will now immediately reflect
the connector section on the diagram.
EA_OnContextDoubleClicked will now be called when
double-clicking an element without children in the
Browser window.
Multiple JavaScript Add-Ins with a dependency on a
common Class will now load the code from that Class.
Element.ClassifierName and Element.ClassifierType will
not give values for all element types.
Element.Update no longer causes Custom Table elements
to show their label again.
JavaScript is the new default scripting language in
Enterprise Architect 16; as part of this change, the
existing libraries for VB Script and JScript have been
migrated into JavaScript.
JavaScript execution during simulations has been
corrected; previously, setting a breakpoint in an
unrelated/unused file could trigger a fatal exception.
Excel support in automation scripts has been improved.
Within IChart, 'AddSurfaceColors' can now be called
from within scripts.
JScript and VBScript debugging is supported in the 64 bit
edition of Enterprise Architect.

(c) Sparx Systems 2022

Page 362 of 524

Getting Started
·

·

·

·

·

·

·

3 October, 2022

When Broadcasting EA_OnNotifyContextItemModified
for an attribute, the correct type and GUID are passed
through.
The Automation Interface 'SQLQuery' has been improved
to output both the 'Date' and 'Time' portions for the
'DateTime' field value (originally it only output the 'Date'
portion).
The Add-In double-click broadcast has been restored in
the Browser window.
The minor refresh issue has been corrected to ensure
Diagram.SelectedConnector is immediately displayed on
the diagram when set.
Diagram.Update now obeys its read-only status when a
diagram is not checked out while using version control, or
not locked when using 'Require User Lock to Edit'.
The Diagram Object setting 'Show Notes' now defaults to
the maximum character count of 1000, when enabled.
When dropping an Item from the Toolbox into the
Browser window, OnPostNewElement is called after the
stereotype(s) have been applied.

User Interface
The Start Page now provides direct access to the Model
Wizard ('Create from Pattern' tab), Process Guidance facility
('Guidance' tab) and Add New Diagrams facility ('Add
Diagrams' tab), as well as the original project access features
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('Open Project' tab - the default).
See The Start Page Help topic.
In notes text in the Notes window, Specification Manager
and other text editing views it is possible to show or hide the
Glossary definition and Translation indicators (underlines),
using the 'Highlight Glossary Terms' context menu option.
See the The Notes Window Help topic.
The Specification Manager now has an option in the
Specification-Specify ribbon to automatically synchronize
the Specification Manager display to the Package selected in
the Browser Window. As you click on different Packages in
the Browser window, the Specification Manager changes to
display the content of the currently-selected Package.
See the Display Panel Help topic.
The Specification Manager has an additional column and
indicator to show whether an element has any Journal
comments on it.
See the Indicator Columns Help topic.
You no longer have to use the 'Download Libraries' dialog
to download Learning Center Libraries into your model.
See the Learning Center and Manage Libraries Help topics.
It is now possible to link a specific Toolbox page to a
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Package in the Browser window, so that when that Package
is selected in, say, the Specification Manager, that Toolbox
page displays as well.
See the Toolbox Appearance Options Help topic.
When specifying reporting options for the generation of
reports, you can now set the sorting of elements in the
document to no particular order, by specifying 'None' in the
'Elements by' field.
See the Document Options Help topic.
The security dialogs have been re-configured as View tabs
in the main work area, and the filters on the 'Group' and
'Users' columns on the 'Manage Locks' and 'My Locks'
dialogs have been changed.
See the Configure Model Users, Configure Model Groups
and Viewing and Managing Locks Help topics.
In managing ribbons, a 'Minimal Text Mode' option has
been provided to reduce the visible content of the ribbons by
hiding the text underneath icons so that it only displays
when you mouse-over the icon.
See the The Ribbon Menu Help topic.
In the Settings ribbon 'Security' panel, user-specific options
have been moved from the 'Administer' icon to the new 'My
Account' icon.
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See the Security Panel Help topic.
The 'Dictionary' panel has been moved from the Publish
ribbon to the Design ribbon, and its 'Glossary' icon now
provides an option to display the Help topic that describes
how to set up a model Glossary. The Glossary can also now
be quickly accessed from the Collaborate Window Selector.
See the Dictionary Panel Help topic, and the The
Collaborate Window Selector Help topic.
Various adjustments have been made to the Design ribbon
to streamline work on Packages, diagrams and elements,
including removing the 'Impact Analysis' panel and adding
its options to other sections of the ribbon.
See the Design Ribbon Help topic.
New options have been added to the Specialize ribbon to
provide access to a Console window for editing JavaScript,
VBScript and JScript.
See the Specialize Ribbon Help topic.
In User and Group Security there is now a security
restriction feature, to block the user from deleting model
objects when they have a restriction against it, such as
DeleteDiagram.
See the List of Available Restrictions Help topic, the
Configure Model Groups Help topic and the Configure
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Model Users Help topic.
In administering your own user security, you can now block
the display of the 'OpenID Authentication' dialog when you
open the current project.
OpenID logins can now use 'id_token' for user
authentication, allowing automatic user management with
Azure groups.
See the User Button and Security Panel Help topics.
In the Browser window, you can create elements of the
same type in the same location using the Ctrl+Shift+N keys.
See the Add Elements Directly To Packages Help topic.
You can now create Views of type Package that, in the
Browser window, have the normal Package icon at View
level.
See the Model Views Help topic.
A tab of Priority and Status indicators has been added to the
Inspector window, to help you quickly inspect and review
the status and priority of all elements in a diagram.
See the Inspector - Status Help topic.
The Diagram Relation Matrix does not include un-named
elements.
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See the Diagram Relation Matrix Help topic.
The 'Auto Name Counters' dialog now:
· Allows an auto-naming convention to be set up according
to element stereotype
· Has both a Save button and a Save & Close button to
allow flexibility in setting up a number of auto-naming
conventions
See the Auto Names and Counters Help topic.
There is a new Construct History window, which provides a
summary of all project management transactions over a
given period, with separate tabs for Tests, Resource
Allocations and Maintenance objects. The Construct History
window's load has been corrected for Firebird and Oracle.
See the Construct History Window Help topic.
The list controls in the Audit View have been updated to
reflect the current theme.
See the Auditing Help topic.
The Testing window now has a 'Full Test Suite' tab that
displays a read-only list of all the Test items on the element,
grouped by type.
See the Test Management Help topic.
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We have added a new button - 'Show Linked Document' - to
the pop-up Toolbar displayed when hovering over a
Hyperlink, if the item supports it.
See the Hyperlink Help topic.
The JavaScript Console has been improved to provide a
better visual and interactive experience, helping you to
quickly and effectively write and execute JavaScript code
within Enterprise Architect.
See the JavaScript Console Help topic.
There have been no updates to the Help in respect to these
changes:
· A number of Perspectives - such as for ArchiMate,
SysML, BPMN, NIEM and UPCC - have been modified
so that the current version of the technology (for example,
ArchiMate 2.0) is independently selectable, while older
legacy versions of the Technology are grouped together
and accessible under the 'All' Perspectives group.
· The selection, display and filtering of Perspectives have
had a number of enhancements within the 'Create from
Pattern', 'New Diagram' and 'Diagram Toolbox' (pinned
pages) areas.
· 'Dark Sapphire', a new dark visual theme, has been
designed to minimize visual contrast and provide a
relaxed reading experience; the new theme can be applied
to all windows and visual controls in Enterprise Architect.
· The 'Sapphire' theme colors have been modified to
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improve their overall look.
The 'New diagram' dialog has been updated to better
support view specifications:
- Profiles with view specifications extending diagrams
from external technologies are now listed as their own
page
- View specifications displayed for a diagram type are
now filtered by perspective
- UML diagram types now only display UML views
within this dialog
While dragging one or more Items in the Browser, you
can now correctly release the drag by pressing the Esc
key.
Hyperlinks now support applying a Matrix Specification
Artifact as the profile, which are available from the
'Hyperlink' dialog Matrix Profiles list.
When using the modal 'Test' dialog to set a run date, the
'Run By' and 'Checked By' combo boxes will default to
the current user.
The 'Risk', 'Effort' and 'Metric' modal dialogs will now
have a default type selected when creating a new item.
The Inspector window will display a new Risk, Effort or
Metric when created via the modal dialog.
The docked Notes window remains in sync with 'Risk',
'Effort' and 'Metric' modal dialog changes.
The 'Stereotype' dialog will now allow the removal of
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stereotypes that have been incorrectly assigned to the
wrong type.
The Start Page 'Add Diagram' and 'Guidance' tab creation
controls are now disabled when no project is loaded.
The Project Transfer screen now provides the option to
reset all GUIDs.
The Pan & Zoom window has been improved to handle
both Dashboard diagrams and the new Grid Style
diagram.
In the 'New Package' dialog:
- The 'Select and Apply Pattern' button will now
display the Start Page 'Create from Pattern window' tab
- The size and spacing of controls have been improved
and the window is re-sizable
Editing an 'Interaction' object name is now supported,
using F2.
When the lock state of the selected Package, element or
diagram is updated, the Read/Write state of the Properties
and Notes windows will now be updated immediately.
An issue with the docked Properties window not
immediately reflecting a change to the Classifier property
of an Object Node or any type derived from an Object
Node has been corrected.
The correct icon for a Packaging Component is now
displayed in the Browser window.
Diagrams with an applied metamodel view can now be
used as a template in the Project Template Package.
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A new keyboard accelerator has been added to the
Browser window, Ctrl+Shift+N, which will create a new
item of the same type as the current selection.
The positioning of owned and embedded objects on a
parent when the parent is resized has been corrected and
improved; this affects Internal Block Diagrams, State
Charts and others.
The Resources window has been updated to ensure it
displays the correct element icon for UML profile items.
The Specification Manager has been enhanced to show
the element metatype in the 'Type' column, if one has
been defined.
When assigning Pins via the docked Properties window,
the 'Select' dialog will list only Input Pins or Output Pins
as appropriate.
The 'Traceability' view has been updated to show the
correct reading direction for stereotyped Generalizations.
Handling of the upper-bound Multiplicity value for a Port
has been improved, when using the element Properties
page.
The 'Resources' tab of the Browser window is made
visible when accessing via a shortcut, if the tab was
previously hidden.
The multi-user modeling experience has been improved
by maintaining the element feature sort position between
users.
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The 'Set Visible Relations' dialog list control has been
updated to provide a better user experience when
changing selection.
The handling of Property Type when editing the initial
value of a property compartment entry.
An issue arising when saving an element Attribute that
has a Constraint with a single embedded apostrophe has
been corrected.
In the Class modal 'Properties' dialog, 'Detail' tab - the
'Cardinality' field has been changed to 'Multiplicity'.
The Construct docked Lists and Properties windows have
undergone usability improvements, including support for
auto-complete:
- The Construct docked Properties window drop-down
list types have been set to read-only selection
The name of the 'Alias' field in the 'Properties' dialog and
Properties window has been corrected.
Embedded elements set the stereotype in the docked
Properties window on creation.
The Help page links on the Feature window tabs for
Attributes and Operations have been updated.
The 'Arguments' properties tab for Action Call Operations
has been made more robust to prevent a potential
application error.
The ability to double-click an external Requirement in the
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element 'Properties' dialog to show its properties has been
restored.
A minor issue for the Tagged Value window has been
corrected to ensure new Tagged Values added via the
shortcut Ctrl+Shift+T are reflected immediately in the
window.
The Special Action for a Use Case has been corrected; it
will now display the Structured Scenarios editor view.
The docked Test Cases window now includes an overview
tab 'Full Test Suite'.
A new option has been added to display View nodes in
the Browser window with a normal Package icon.
Corrected a minor issue when attempting to access the
Help via the F1 key on the 'Exclude Filters' page of the
'Document Generation' dialog.
The docked construct Properties window has been
modified to support auto-complete where project
people/resource names and resource roles are used.
In-place editing of Package element names in the Browser
window has been corrected, to avoid potentially
modifying an existing stereotype.
New docked Properties window shortcut keys have been
added for entering the edit state:
- Spacebar, Enter to action checkbox, combobox,
browse and time property types
- Spacebar, Enter or F2 to edit non action property
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type
The handling of element File details has been corrected,
especially the 'File Size' and the 'LastWrite' fields, which
could fail to be stored in some situations.
'Find in all Diagrams' is now available for element
features in the Browser window when using the Enter key
to access the Quick-menu.
The 'Create Link' dialog - accessed via the Browser
window context menu Add | 'Create Link...' - has been
updated to improve the contents of the Link Type and
Target Type combo boxes when a perspective is applied.
A spurious 'Set Classifier' command for a
CreateObjectAction element has been removed; the
Classifier property should only be set from the Properties
window.
The 'Audit View' main tab list controls have been updated
to support the applied theme colors and style.
The layout of the 'Audit Settings' dialog has been updated
to enhance readability, giving the options more breathing
room.
The layout and ordering of the 'New Element' dialog has
been improved, when viewing a 'Type' list.
The 'MDG Technologies' dialog list control has been
updated to support the applied theme colors.
Tests across Enterprise Architect have been adjusted to
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have a default type of 'Standard' unless they are of 'Basic
Path' if available in the test types configured list.
The filtering in the 'Model Pattern' dialog has been
corrected, and also new 'Expand' and 'Collapse' options
have been added.
The behavior of the small floating toolbar over a
Hyperlink in a Note or other editor has been updated such
that the selected element becomes the context element;
this also resolves some issues with inconsistent selection
in a multi-user environment.
A new hyperlink type has been added, designed to open a
file to a specific line or search for text.
The Inspector window 'External Data' tab; has been
enhanced; it now shows external reference element
comments.
The system allows you to change the text color via the
dockable Notes window toolbar control when showing
notes for non standard items such as Tests and
Maintenance items.
When using the hyperlink option 'Find in Diagram' to
locate an element, selecting the 'View Composite
Diagram' icon for that element - if available - will
correctly open the diagram.
The 'Recent Places' Portal tab has been reinstated, along
with the ribbon menu button to activate both the Portals
window and page.
The 'Save As File' dialog under Linux has been modified
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to ensure that the selected filetype extension is appended
to the current filename.
Under Wine, drag-and-drop of text from an external
source onto a diagram is allowed.
A new, customizable Quick Access toolbar has been
added; you can quickly add your favorite and often-used
commands (including menu buttons) from the ribbon to
this new Quick Access toolbar:
- Build your own collection of useful tools
- Right-click on an ribbon item and choose 'Add to
Quick Access Toolbar'
- Put the things you need frequently front and center
- Simple and effective
'Auto Refresh' diagram options have been added to the
Layout ribbon.
DMN modeling menu items have been added to the
'Design > Impact > Decisions' ribbon option.
A Structured Scenario ribbon and menu options have been
added for quicker access.
A Pro Cloud Server connection diagnostics menu item has
been added under the 'Help' button on the 'Start' ribbon.
A dynamic drop-down 'Working Set' menu has been
added to the 'Start > Desktop > Workspaces > Select
Working Set' ribbon option.
The 'Linked Document' ribbon commands have been
amended to ensure the option to create a Model Hyperlink
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is enabled during editing.
The 'Locking' options invoked from the ribbon to handle
multiple selection in the Browser window and diagram
have been corrected.
The 'Construct > Change Management > Overview'
ribbon option has been changed to 'Maintenance'.
Duplicate ribbon menu items have been removed from the
'Design' ribbon.
The icon 'Design > Diagram > Toolbox' has been moved
to the first item in the panel.
The 'Add' buttons on the 'Design' ribbon panels now
include the item being added; this makes determining the
action easier when locating these buttons from a search.
The Structured Scenario editor no longer contains a blank
space at the bottom of the window when applying high
DPI settings.
An issue where some hyperlinks in the Model Wizard
Pattern documents failed to execute has been corrected.
The 'Msg' notification button will no longer display an
existing unread Model Mail as a new notification when
changing the load limit of the Model Mail window.
The 'Status' tab of the Inspector docked window now
displays a column header with columns for the Status and
Priority icons.
Saving recurring events in the Calendar has been
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corrected.
(Right Alt+Ctrl+N) does not now trigger the 'New
Element' dialog for a Polish keyboard when the focus is in
the view.
The 'Save Project Shortcut' dialog now allows saving
shortcuts in other supported file extensions.
The 'Create Project Issue' dialog has been corrected to
ensure the Resolution Date/Time controls are no longer
hidden.
When showing the docked Notes and Properties windows,
they display the latest changes to a construct item.
The resource compartment for an object on a diagram is
updated after modifying the percent complete in the
Resources window.
Visual display of the Journal/Diary window has been
improved when using Office Dark Gray 2016/19.
The Journal and Diary windows will use the current
theme colors for the text and background to provide a
more integrated look:
- Copying text from controls that use the current
theme colors will no long apply that as a default text color
when pasted
- Ctrl+Space on a Chat item will display a read-only
notes editor, allowing you to copy out a specific piece of
text
- The text size in the pop-up Notes window has been
corrected, when using Ctrl+Space from the Chat editor
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The docked Notes window will correctly theme the text
and background when changing between a dark and light
theme for Office or Visual Studio 2019.
Restrictions to Perspective sets by Security Group will
now appear under 'Personalized' in the 'All Perspectives'
menu, rather than at the top level.
The 'Paste As' dialog now remembers the selection
correctly when dropping elements onto Sequence
diagrams.
Various missing dialog/window help links have been
added.
While viewing a Package with the Specification Manager,
drag and drop in the Browse window correctly moves the
selected item(s).
Performing a drag in the Browser window will no longer
select the first visible item in the tree in specific scenarios.
Diagram Legends shown in the Browser window will
display their names instead of Note text.
Loading of the Relationship Matrix has been improved
when source and target objects have multiple links to
objects not displayed in the view.
Opening a Script Console in the main view will now
display a tab name that matches the console type.
Missing ribbon item tooltips have been added.
The Start Page 'Diagram' tab default size has been
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reduced.
The Copy/Paste menu group at Root Package level has
been corrected.
The drop menu of available Chat groups for the 'Send
Chat' popup dialog, which could fail to populate in
specific conditions, has been corrected.
The system now allows a space character to be used when
filtering text in the docked History windows.
The 'Translate' context menu items are no longer
displayed for the Chat, Journal, Discussion and Diary
editors and when translations are disabled for a model.
Element features with a new line character in the name
will correctly update when modifying the notes via the
docked Notes window or the popup Notes window.
The 'About' dialog has been increased in size.
When connecting to a Chat group with unread messages,
it always obeys your choice.
The 'Copy and Paste' action is consistent between
shortcuts (Ctrl+C / Ctrl+V) and context menu options in
the Browser window and on a diagram.
The Discuss & Review window correctly loads new
discussions when the element is already in context.
The behavior preventing a code position hyperlink being
inserted into an in-place editor like the Journal,
Discussion or Diary window, has been corrected.
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The Open Server Connection screen:
- Populates Firebird databases with the default
credentials of SYSDBA/masterkey
- Allows the connection name to be renamed without
forcing another Test
The look and layout of the Window Selectors have been
improved.
New tooltips have been added to the Window Selectors
(Alt + <1 - 7>), displayed on mouse-over.
A new Construct Window Selector has been added to the
Start > All Windows ribbon panel
Opening a Date Picker in the docked Properties window
with the Space key no longer keeps focus on completion.
Labels for Maintenance items in the docked Properties
window are now consistent when changing between types.
The 'Model Mail Preview' control will no longer consume
the entire available space when making the docked
window smaller.
A toolbar with a drop menu has been added to the Model
Mail window for easy menu access.
Loading of Charts that have stored snapshot data has been
corrected.
A model integrity error when copy/pasting child elements
in the Browser window has been prevented.
RefGUID, RefGUIDList and DiagramRef Tagged Value
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types now detect property changes when you select a new
item with the same name.
·

·

·

·
·

·

·

·

·

·

·

The Quick Access Toolbar 'Customization' dialog
usability has been improved.
The docked Properties window for States can now set the
behaviors for States.
Opening an RTF file from the Find in Files window no
longer causes a potential, unexpected application error.
The loading of Time Series Charts has been improved.
Property lists will now draw group headers with a
highlight color to make them more noticeable.
Diagram types in the 'Core Extensions' technology can
now be included in restricted Perspectives.
The sort order for the 'New Diagram' dialog and Model
Wizard, when 'All Perspectives' is active, has been
improved.
UML Perspectives will now show model patterns in
translated versions.
All Perspectives will now show all available diagram
types in translated versions.
Model Wizard patterns for Dynamic Chart elements have
been improved.
In the Responsibility window:
- Requirements list properties are now saved correctly
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- Requirements list context menu item state has been
corrected
- External Requirement properties are now loaded
- Context item selection efficiency has been improved

Others
When performing work through the Pro Cloud Server you
can check the connection through the 'Start > Help > Help >
Pro Cloud Server connection' option. The results are
displayed in the System Output window.
See the Help Panel Help topic and the PCS Troubleshooting
Help topic.
Updated the Help page describing the Features window.
See The Features Window Help topic.
The <perspective> option in the top right of the screen now
sets the baseline Perspective across the model; you can set
individual dialogs to a different Perspective for that dialog
alone, or select the 'Active' option from the drop-down
menu to set the Perspective to the baseline.
See the Using Perspectives Help topic.
Added auto-complete in Construct docked lists (Testing and
Maintenance) and the item Properties window, to complete
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the names of defined users. In these windows, other
drop-down list types are set to read-only selection; that is,
you select from the list and do not type in alternative values.
Also resolved the issue where double-clicking a docked
construct list item changed the combo selection.
See the Create Maintenance Items Help topic and the Create
Test Records Help topic.
On the 'Test details' dialog, the 'Run By' and 'Checked By'
fields now default to the name of the current user.
See the Create Test Records Help topic.
The Resource Allocation window is now displayed in Gantt
chart format. Also:
· The Resource property will only validate with
project-configured Resources and Authors
· The Role property will only be selectable from project
configured Roles
· The Role property is now read only
See the Resource Allocation Help topic.
Watched items in the Watches window can now be
edited/renamed in place, by pressing F2.
See the View Variables in Other Scopes Help topic.
There have been no updates to the Help in respect to these
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changes:
· The 'Find Orphans' search located under 'Diagram
Searches' has been optimized for large models.
· The Tags window, property Value button-click has been
stabilized.
· Property type will now be persistent on editing the initial
value of a property compartment entry.
· Enterprise Architect will no longer crash when:
- Closing Enterprise Architect under Wine in
SScripter
- Deleting the Diagram Notes element on a diagram
- You select the parent element after the element type
is changed for the child element
- Immediately deleting an annotation element (such as
a Navigation Cell) if it
was the first annotation element added to that
Package
- Saving an attribute constraint having a single quote
- There are long lines of code in the Script Editor
- Creating a Port via the Features window and then
moving a connector to it
·

·

·

In the Class modal 'Properties' dialog, 'Details' tab, the
'Cardinality' field has been changed to 'Multiplicity'.
Wireframe progress bars will no longer overdraw at
certain sizes when the 'Block' style is applied to them.
The system no longer sets the alias when creating a
stereotyped Package from the Diagram Toolbox.
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Added support for generating web pages from Enterprise
Architect models.
Improved StateTable to display text in the vertical center
of the Transition and State/Event enumeration cell.
Improved the font color for StateChart Tables when in a
dark visual theme.
Fixed regression with Async queries so they run
asynchronously.
Model Search will now correctly handle searches that use
queries that assign a different Class table such as
't_diagram' as CLASSTABLE.
Enterprise Architect now allows a document with
Dynamic content to be updated when used in a Pattern.
The system now prevents Xerces from appending a
default XML Declaration when serializing DOM.
Added missing code to construct the Gap Analysis
window as a View Handler.
Corrected the use of uppercase object names
SYS.COLUMNS and SYS.TABLES for case-sensitive
SQL Server databases.
Project Transfers into case-sensitive SQL Server database
no longer throw multiple errors.
Project Transfers ensure that security checks are
performed for MySQL targets.
The Portals window will no longer break icons with a
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transparent background when an item is disabled.
·

·
·

·

·

·

·

·

·

·

·

·

Removed superfluous loading of the Enterprise Architect
metamodel.
Fixed the SQL error in setting fields with invalid text.
Corrected the reading direction for stereotyped
generalizations.
Corrected the issue concerning clearing the upper bound
for Port multiplicity.
For a SysML StateMachine, when adding a Trigger,
Enterprise Architect no longer prompts for a referencing
Signal element.
Corrected the Event Status-types list in the docked Project
window.
Element-type auto counters are now applied as required
over a Pro Cloud connection.
In the element Features window, the sort position is
maintained between multiple user accesses.
The layout of a Dashboard diagram will persist when
reloading the Diagram tab.
In Data Modeling, an invalid SQL message no longer
displays when changing the datatype of a new column.
On the 'Set Visible Relations' dialog, the unexpected
multi-selection behavior has been removed.
Optimized the element auto count SQL to one query for
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both Name and Alias.
Improved Structured Tagged Value data handling.
Setting the element properties stereotype tag group holds
the vertical scroll position.
Removed the duplicate 'Concurrency' property from the
docked Properties window for operations.
The Browser window 'Add as Favorite to' menu now
consistently loads groups.
The Property Type will now persist on editing the initial
value of the property compartment entry.
Creating an annotation element (such as a Navigation cell)
in a Package that doesn't already have an annotation
Package will now correctly create the annotation Package.
Corrected the SQL in the 'Usage' dialog that could have
displayed incorrect diagram usage under certain
circumstances.
Corrected the 'InvalidDatTime' error for the 'Last Run'
field in Generated Test documentation.
Return EAViewType::vtHelpPage to 'enum' even though
the window is removed to ensure a consistent viewtype
between 15.2 & 16.
The system now ensures that the auto count record is only
updated with a changed value.
Navigation cells no longer throw an ASSERT when
loading a Kanban diagram.
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The treenode display name no longer repeats a stereotype.
An element created through a project template Package is
no longer displayed in a default size.
Resolved the document 'Auto Spell Checking' application
error when first scrolling through the document.
In multi-user models, diagram sinks will now work even
if the element hasn't been loaded into the Browser
window.
Fixed the error in object selection on an orthogonal move
of a child object in the diagram.
Structured Tags contained in a _tagGroups save correctly.
Fixed the failure of JavaScript Add-Ins on the Cloud
under Postgres.
Corrected the issue where exporting controlled Packages
to XMI 1.1 caused an XML error when the 'Report Cross
Package Reference Deletions (XMI 1.1)' option was
enabled.
Corrected the error in the 'Arguments' tab of the
Properties window for Action Call Operations.
Fixed the issue with connector Shape Scripts not being
drawn.
Multi-selected elements dropped under the option to
'Paste as Property' will now adhere to that paste selection.
Initial values have been put back into the
CDockedExternalSource ExternalData::RowData header
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file.
The Proxyconnector element in the Requirement Matrix
view will no longer show an irrelevant context menu.
Dragging virtual connector ends when moving around
large diagrams has been improved.
Deleting a hidden diagram layer will now correctly show
elements on that layer again.
The feature to display External Requirement properties on
double-click has been restored.
Document generation will now correctly size elements
when using bitmap images to ensure the text remains
within the elements.
Linked external datasource diagram objects hold the
selection focus on the first click.
Tree-style connectors on diagrams with hidden layers will
no longer incorrectly suppress segments.
The compartment entry of a Port will now update
immediately after the Port is deleted from the diagram.
When converting from RTF to HTML, the text
background color is now correct translated.
There is no longer a database error when you select the
'Clear the Checklist' option for a 'Checklist' Artifact
element.
Corrected the issue on adding a Tagged Value using
Ctrl+Shift+T.
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Models on an Oracle DB with large diagrams that display
related element compartments will no longer cause an
SQL error when loading.
Broadcasting the contextItemModified event will now
trigger the correct item GUID and Type to the Add-In.
XML parser error reporting has been restored.
Excessive memory usage in XMI 2.1 export has been
fixed.
Logging for Active Directory Sync and Single Sign-on
login attempts has been improved.
Active Directory Authentication handling of nested
security groups has been improved.
Switching between models with auditing enabled will no
longer cause an error.
Synchronizing Database Table definitions has been
updated to fix multiple potential failures.
External Data bindings to profile Tagged Values now use
the correct name.
The Image Manager has been updated to correct an SQL
error on case sensitive databases.
Cloning a composite element now ensures that the
referenced composite diagram is the latest diagram
version.
Corrected the SQL in a UPDM search for a QEA model.
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The Windows new document menu no longer lists
Enterprise Architect project types on fresh installs.
SQLite project types now show the correct Windows
explorer icon.
The 'Auto Reload Changed Diagrams' facility is now
available in supported models regardless of security
settings.
Disabling 'Auto Refresh' on a diagram will now
automatically save any pending changes rather than
prompting to save.
File management of Chat, Journal and Discussion internal
documents has been improved.
SQL errors for some built in searches when run on an
EADB file have been corrected.
The 64 bit Professional Edition will now allow upgrading
of EAP/EAPX projects to QEA/QEAX.
Exporting the internal document of an element via the
API will now return a correct boolean value.
The External Data Integration (SBPI) will now sync fields
to a newly created item.
The 'Spell Checker' dialog now correctly displays
accented characters.
Dragging multiple children of an Annotation node to a
Package without an existing Annotation node has been
enabled.
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Enterprise Architect will now check that the current user
has write permissions to file before attempting to open a
.QEA/.QEAX file.
Changing the name of an Operation by using the
'Sequence Message' dialog in an Interaction/Sequence
diagram has been optimized to immediately update the
Browser window instead of requiring a reload.
The 'Auto Reload Changed Diagrams' functionality has
been improved.
The 'SQLServer' option on the Native Connection screen
for Linux Users has been disabled.
The behavior of the Console Output window has been
improved; it now opens the correct help links for
MATLAB & Octave.
The creation of new elements has been improved, when a
model-level Template Package has been defined but that
Package is also locked; in some cases this could cause
errors and/or error messages when adding a new element
to the model that was based on an element in the
Template Package.
The 'Specialize | Tools | System Integration' option has
been simplified by removing unnecessary sub items.
Tooltips for the System Integration window's navigation
breadcrumb control have been improved.
Package elements will no longer show Nav Cells on a
diagram when the 'Show Package Content' option is
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enabled.
The report generator's handling of images that require
resizing has been improved to ensure they are displayed in
the final document.
The Registry location used to search for and load Add-!ns
for the 64 Bit edition of Enterprise Architect is now
different to the 32 Bit edition; the two key values are:
- 32 bit Edition
HKEY_CURRENT_USER\Software\Sparx
Systems\EAAddins
HKEY_LOCAL_MACHINE\Software\Sparx
Systems\EAAddins
- 64 bit Edition
HKEY_CURRENT_USER\Software\Sparx
Systems\EAAddins64
HKEY_LOCAL_MACHINE\Software\Sparx
Systems\EAAddins64
The menu options for Project Transfer under the 'Settings
| Transfer' ribbon have been modified to better support the
common Project Transfers, and to provide easy access to
the 'Migrate to QEA' command used to move EAP files to
the new QEA format.
The issue with setting Action Kind type in the Properties
window has been corrected; previously, assigned Action
Pins would not be saved until the Action was reloaded.
In SBPI, creating an item in an External Data Provider
such as Jira has been improved to provide better mapping
and better fallback and default types; additional messages
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round out the overall function usability.
The behavior when trying to open a DOCX file under
Wine if msxml isn't available has been improved; we now
display a prompt.
SetLineStyle will now work with DrawNativeShape for
Shapescripts applied to objects.
A potential application error has been eliminated when an
Add-In closes the model during the load broadcast.
Highlighted text in a linked document is always displayed
when viewed via WebEA or Prolaborate.
Standard headers have been added to HTTP requests for
compliance.
Simple Decision Table modeling has been enabled in the
Corporate edition ribbon.
On the 'Perspectives Sets' dialog, a new page allows
limiting Perspectives by Security Group, if security is
enabled.
Group workflow is now run only for security-enabled
models.
The broadcast notification of EA_AllowPropertyUpdate is
now additionally sent from the Diagram List View and the
Specification Manager, when required.
The Relationship Matrix view has been corrected to
include ActivityPartition and its child elements.
Adding an element using the Specification Manager will
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now apply any element properties defined by a Template
Package.
The handling of SSL certificates that expire while
connected to PCS has been improved.
Retrying of failed requests to PCS has been improved.
In Windows Authentication, the checkbox 'Allow
non-domain users' now shows the actual value of this
option for pre-existing installations.
Pro Cloud Server connection details are now encrypted in
the initial communications between Enterprise Architect
and Pro Cloud Server.
Implementation of Enterprise Architect in a Docker
container is better supported.
The Start page context menu option 'Open in New
Instance' for Cloud and Server based connections has
been improved to ensure they are successfully loaded in
the new instance.
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Release 16.0 Build 1605
Scroll through these sections to review the changes that
have been made in Enterprise Architect for this released
build.
Where a change has been described or illustrated in the
Enterprise Architect User Guide, a link is provided to the
appropriate topic.

Diagramming
There have been no updates to the Help in respect to these
changes:
· Adding an embedded element to an object in the tree will
no longer add it to the diagram as well if the parent object
is not on the diagram.
· Loading of diagrams has been improved.
· [Internal] - Additional DB calls have been prevented from
being made for disabled compartments.

SysML
There have been no updates to the Help in respect to these
changes:
· Quick Linker behavior has been corrected when creating a
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new SysML Requirement using the 'deriveReqt', 'satisfy',
'verify' and 'refine' link types.

UML
There have been no updates to the Help in respect to these
changes:
· When '<none>' is specified as the default language for
Code Generation, the system ensures that a new attribute
defaults to 'Integer' and the 'Type' combo only provides
UML Primitive Types
· The docked Properties window for SendSignalAction now
allows you to edit 'Signal', 'Argument' and 'Condition'
· Self-connectors on Sequence diagrams have been
improved to provide easier-to-use selection handles
· The rule that a UML Class can own a UML
CollaborationUse has been added
· The Feature window 'Interaction points' tab will now list
the target Pin of an Action(SendSignal)

User Interface
There have been no updates to the Help in respect to these
changes:
· Duplicate entries from the 'Select Connector Type' listbox
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have been removed.
Creation of new profile relationships in the Matrix View
now includes the intended stereotype.
The element 'Properties' dialog has been updated to
display properties from profiles containing an alias on the
correct page.
The docked Properties window now auto-saves tab
changes when switching context.
In the docked Properties window, editing of stereotype
properties no longer fails for some stereotypes.
The 'Swimlane Details' dialog has been improved so that
the Swimlane classifier is assigned when the dialog is
opened.
Operation Parameter Tagged Values that are applied by a
stereotype will correctly display and be editable from the
Tagged Value windows.

Reviews and Discussions
The Manage Reviews window and Discuss & Review
window have been updated to include new columns that
allow filtering on Review Approver and Topic names.
See the Manage Reviews and Discuss & Review - History
Window Help topics.
There have been no updates to the Help in respect to these
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changes:
· The readability of element Discussion and Review
compartments has been improved by removing HTML
format tags and ensuring items are displayed in the same
order as their respective docked windows.
· [Internal] - Changing the priority of an Approver Topic
will no longer create a log item (post) under that topic, as
it will never be displayed.

Technology Authoring
There have been no updates to the Help in respect to these
changes:
· Shape-scripted labels will now be loaded and drawn
correctly for extended elements in a profile.

Simulation
New Model Wizard patterns have been added for Matlab
Solver, Octave Solver, Executable Business States and
Win32 UI simulation, contained in Perspectives in a
separate Simulation Perspective category. This category also
includes Perspective Sets for SysML with Modelica,
Executable StateMachine, BPSIM and Decision Modeling
Perspectives.
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See the Model Perspectives and Types of Perspective Help
topics.
There have been no updates to the Help in respect to these
changes:
· 'At Literals' are now supported for DMN Decision Table
input and output.
· The DMN Expression Parser has been enhanced to
support multiple 'At Literals' in the Expression.
· DMN simulation performance has been improved by
avoiding repeated evaluation of dependent decisions.
· Simulation:
- SysML Simulation has been updated to handle new
versions of Modelica/OpenModelica
- SysML Simulation has been updated to conform to
the latest SysPhS 1.1 specification
- A new 'pre-process' option has been added to SysML
simulation; when enabled
this will pre-process the model according the SysPhS
specifications
- Various improvements have been made to SysML
Simulation using SysPhS
· DMN Simulation and Debugging have had multiple
improvements:
- Runtime evaluation on all variables is supported by
explicitly defining variable scope before usage
- DMN Decision Table's priority order is supported
for output with number type
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The DMN Validator has been enhanced to capture 'At
Literal' expression errors and mistyped class and member
function names.
The issue with SysML Modelica Simulation that could
result in necessary Modelica Simulation files failing to
generate has been corrected.
A new 'Simulation' perspective category has been added,
grouping all simulation perspectives in one menu.

Code Engineering
There have been no updates to the Help in respect to these
changes:
· Intellisense has been improved:
- The keyboard shortcut Ctrl+Shift+Space now shows
a method signature
parameter list instead of an autocomplete list
(Ctrl+Space can still be used
for the autocomplete list)
- Method signature tooltips now always show full
parameter information
- Method signature tooltips highlight the current
parameter under the text cursor
- When the tooltip auto show and hide are applied has
been improved
- When to show autocomplete has been improved
· The Code Editor and associated Structure Tree have had
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general improvements.
In Data Modeling, the Import DDL Schema browser
button now supports the selection of any supported
database.
[Internal] The Language option on the 'Object Options'
dialog has been corrected to show the object's own
options other than user preference options.

Publishing
There have been no updates to the Help in respect to these
changes:
· Group elements will be correctly generated in an
ArchiMate Model Exchange File.
· The HTML report generator has been updated to ensure a
default diagram is included on the index page when the
'Default Diagram' option has been specified.
· Deleting an HTML Style template now removes all
modified sections (only applies to EAP files):
- Renaming an HTML Style template correctly moves
all modified sections
· Document generation using metafiles with diagram
frames will now correctly add padding between the
diagram and frame.
· The Document Generator has been updated to correct rare
instances of Unicode characters in notes rendering badly.
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Execution Analyzer
There have been no updates to the Help in respect to these
changes:
· Debugging 64 bit applications with the GDB debugger is
now supported.
· The option to 'Break When Variable is Modified' when
debugging 64 bit apps has been improved:
- Memory Viewer has been improved to show the full
64 bit address when debugging 64 bit apps
· Debugging in Linux/WINE with too many threads has
been fixed.

Automation and Scripting
There have been no updates to the Help in respect to these
changes:
· The Automation option 'SuppressSecurityDialogs' will
now be obeyed when connecting to a Cloud model
through automation and will allow suppressing credential
and security warning pop-up dialogs when enabled.
· [Internal] Assertion is now prevented from deleting the
last script item under a Package in the Execution
Analyzer.
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Security
There have been no updates to the Help in respect to these
changes:
· The situation where checked-in Packages were not locked
until the model was reloaded after version control was
first applied in a model, has been corrected.
· The time required to apply a recursive lock to a large
Package over a Cloud connection has been significantly
reduced.
· Project Root Packages that are hidden with security
locking have been improved in these ways:
- The Packages become immediately visible when
security is disabled or the locking mode is changed to
'Require User Lock to Edit'
- The Packages have their visibility updated when
changing the current security user for the loaded model
- Applying a non-recursive lock to a Root Package has
been updated to ensure the selected Package is also locked
· The locking behavior of the Information Flow Connector
has been updated such that Conveyed Items can be added
and removed if, and only if, the connector's source
element is editable. The connector's target element is no
longer considered.
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Other
There have been no updates to the Help in respect to these
changes:
· Existing trial periods have been reset to allow new trials
of version 16.
· The 64 bit Professional edition no longer stops the
opening of .EAPX repositories.
· MDG Technologies loaded from URL now handle https
connections.
· Model Wizard documentation has been improved.
· Model Wizard pattern documents have been updated and
improved for multiple technologies.
· The 'Gang of Four' technology Model Wizard pattern
groups have been given names that are more searchable.
· External Data Type and Field Mapping have been
improved:
- The correct stereotype is matched when the same
name exists in multiple technologies
- Only allow mapping to known stereotypes
- Use display names for technology types and Tagged
Value
- Tagged Values are filtered to only show those
allowed by the selected type/stereotype
· SBPI: The loading time of the 'Comments' tab in the
Inspector window has been improved.
· The Review History window has been updated to include
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new filtering options for Review Topics and new columns
'Topic Author' and 'Role'.
Handling of the Cloud connection when resending slow
messages has been improved.
A Wine-specific issue has been corrected, where opening
the linked document of an element via the modal
'Properties' dialog could result in recent changes being
lost.
Another SSWideCharToMultiByte has been added, which
takes an HGLOBAL. This behavior is consistent with that
of other connector types in Enterprise Architect.
[Internal] 'Database Version' and 'Date' have been
removed from the About screen.
[internal] File closing in the LITE version has been
improved.
[Internal] SBPI: The memory leak has been fixed.
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Help and Support

Enterprise Architect has three main help and information
systems to assist you in using the product:
· Help
· Learning Center
· The Sparx Systems website
In addition we recommend that you fully explore the sample
project supplied with the Enterprise Architect installer. It
assists you in learning to use Enterprise Architect and offers
tips on getting the most out of the product features. Click on
the 'EAExample' option in the 'Recent' list on the 'Start
Page'.

Getting Help and Support
Facility

Description

Enterprise
Architect
Help

Enterprise Architect Help provides
comprehensive documentation of
Enterprise Architect and addresses every
aspect and facility of the product. To
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access Help within Enterprise Architect:
· Click on the 'Help' icon ( ) in the
various toolbars, or
· Select the 'Start > Help > Help > Open
Help' ribbon option, or
· Click on the Help button on a dialog
(for Help specific to that dialog), or
· Press F1 on a screen or view
The Help System is maintained as a set of
HTML pages hosted on the Sparx
Systems company web site. The
appropriate Help displays as an HTML
web site page in your configured
browser.
For those with limited internet access, the
Help System can be downloaded and
installed locally on your current machine.
Information on obtaining this installation
file is available in the registered user area
of the Sparx site. If you want to revert to
the web site access to the Help, simply
uninstall the local Help; Enterprise
Architect then automatically references
the web site. You can also download a
PDF version of the Help from the
website, and print sections of it as
required.
Enterprise Architect Help is extensive; if
you cannot quickly locate the topic you
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require through the content 'breadcrumb
trails', you can use the web site search
facility (in the top right corner of the web
page) and select to search the EA User
Guide for a specific text string.
If you have installed the local version of
the Help, you can perform a file based
search for key terms using the 'Start >
Help > Help > Search Help' option, and
clicking on an entry in the result set.
Learning
Center

The Enterprise Architect Learning Center
provides guidance and demonstrations to
help you understand any area of
Enterprise Architect that you are
interested in. You can access the
Learning Center using the 'Start > Help >
Libraries > Learning Center' ribbon
option, showing the Introduction To The
Learning Center topic. You can select
other topics or task areas by clicking on
the appropriate part of the topic path
('breadcrumb trail') at the top of the
window, and selecting from the
drop-down list.

Sparx
Systems
Website

The Sparx Systems web site is also
extensive, and provides information and
announcements concerning the company
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and its full range of products, as well as
tutorials, white papers, templates and
solutions.
It also provides a user forum, community
site and support network. Sparx Systems
are highly responsive to user feedback
and requirements, and the web site
enables rapid communication concerning
problems, solutions and enhancements.
You can access the web page and user
forum within Enterprise Architect from
the 'Start > Help > Home Page' ribbon
option.
Sparx Systems Website
Sparx Systems User Forum
Community
Site
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The Sparx Systems web site also hosts
the Sparx Systems Enterprise Architect
Community Site. This is a central
location for the Enterprise Architect
community to publish resources and
share experiences.
From this site you can download the
latest news, tutorials, resources, best
practices, tips, techniques and
user-generated content for Enterprise
Architect. You can also, as a registered
author, contribute content and share your
expertise with the wider community.
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Community Website
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Available Help File Formats
Sparx Systems provides Help documentation for Enterprise
Architect in .PDF and .HTML formats. You can choose to
either search the online Help on the Sparx Systems web site
or download the full set of Help files to your local computer
to avoid accessing the Internet when consulting Help topics.

You can directly access the latest Enterprise
Architect Help files from these locations
Format

Access

.PDF

On the Sparx Systems website:
http://sparxsystems.com/
· In the header: Select 'Resources | PDF
Library | <document category> |
<document name>', or
· In the footer: Select 'Resources' title;
then from the 'Resources' page, select
the 'User Guide Library' icon

.HTML

For your installation of Enterprise
Architect:
· Ribbon: Start > Help > Help > Open
Help System
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Context Menu: Right-click on an
object | Help option
· Keyboard: Click on a screen window
or display | Press F1 key
· Other: On a dialog or toolbar, click on
the Help button or icon
For the latest release of Enterprise
Architect:
http://sparxsystems.com/
· In the header: Select 'Support | User
Guide/Help', or
· In the footer: Select 'Support | Online
Manual'
·
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Learning Center
The Learning Center window provides quick access to a
range of context-specific task guides in a number of specific
work areas, such as Getting Started, Modeling or Testing.
Through the 'breadcrumb' path at the top of the Learning
Center window you display the short task guides, which
describe how to achieve specific objectives in a work area.
The guides contain links to Help topics and other useful
sources of information.
To open a guide in the Learning Center window, click on
the task name in the drop-down lists in the 'breadcrumb'
path. The document immediately displays in the window.
The Learning Center facilities can be extended to present
separate hierarchies of topics on working with any MDG
Technologies loaded with Enterprise Architect. Your
Technology Developers would create and incorporate these
additional sets of topics.

Access
Ribbon

Start > Help > Libraries > Learning
Center

Keyboard
Shortcuts

Alt+F1
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Switch Between Work Areas
Click on the black arrow to the right of 'Enterprise Architect'
in the document path and select the required Enterprise
Architect work area from the drop-down list. Click on the
work area and select either a further division of the subject
area or the title of a guide on that topic.
If you have additional sets of topics for in-house extensions
of Enterprise Architect (Add-Ins and MDG Technologies),
you can access them by clicking on the black arrow to the
left of Enterprise Architect in the document path, and
selecting the required product area from the drop-down list.

Switch Between Topics
In the 'breadcrumb' path, either:
· Click on the black arrow to the left of the current topic
title and select a different topic, or
· Click on the large Right Arrow and Left Arrow icons at
the start of the ribbon, to scroll through the topics within
the work area in sequence (these arrows do not scroll out
of the work area to the next or previous work area)
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Set Default Topic
You can select the currently-displayed topic in the Learning
Center window as the default topic. To do this, click on the
first black arrow in the 'breadcrumb' path and select 'Set as
Default Topic'. When a topic is set as default, it will
automatically be shown when the Learning Center window
is opened.

Add and Manage Learning Center Libraries
You can download an Enterprise Architect Learning Center
Library from:
https://www.sparxsystems.com/resources/libraries/index.ht
ml
You then install it using the 'Manage Libraries' dialog. You
can also enable or disable Learning Center Libraries using
this dialog. Libraries disabled using this dialog will not be
visible in the 'breadcrumb' path once the Learning Center
window is restarted. The 'Manage Libraries' dialog can be
invoked by:
· Clicking on the first black arrow in the 'breadcrumb' path
and selecting the 'Manage Libraries' option, or
· Selecting the 'Start > Help > Libraries > Manage Library'
ribbon option
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Notes
·

If an Add-In or MDG Technology loads its own Learning
Center topics, when Enterprise Architect is shut down the
Technology Learning Center topics are not retained and,
in subsequent work sessions, must be reloaded; if the
Technology is deactivated during a work session, its
Learning Center topics are still available until Enterprise
Architect is shut down
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Create Learning Center Pages
As a Technology Developer, it is possible for you to create a
set of Learning Center pages to support any MDG
Technology that you have developed and loaded into
Enterprise Architect. You create each Learning Center page
as the Linked Document of a Document Artifact element.
These elements are organized into a hierarchy of Packages,
where the Package name becomes the name of a folder of
topics in the Learning Center. You then run two scripts; the
first to generate the Learning Center folders and topics, and
the second (as part of your Add-In or Technology
activation) to import your Learning Center structure into the
file location from which Enterprise Architect can load it.
The original process of developing a Learning Center
Profile as part of an MDG Technology definition is no
longer recommended.

Set Up a Linked Document Template for
Learning Center topics
Whilst not mandatory, it is recommended that you create
one or more Linked Document templates for your Learning
Center documents, to provide consistent standards for the
layout, structure and content of your Learning Center pages.
Ste Action
p
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1

Plan the content of your Learning Center topics, and
consider:
· How you should present explanatory or descriptive
text
· How you should lay out steps in direct-action tasks
· How you should refer and/or link to information in
other documentation, web sites and file directories
· What corporate styles, standards and logos you
might need to incorporate

2

Open the 'Resources' tab of the Browser window
('Start > Application > Share > Resources') and
create the appropriate Linked Document templates
for your topics.

Set up Package hierarchy to organize the
Learning Center topics
Ste Action
p
1

Create the root Package for your Learning Center
documentation. The Package name will be the
starting point for the documentation folder structure,
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as Enterprise Architect is for its product Learning
Center topics.
2

Display the Properties window for this Package
element (select the 'Design > Package > Manage >
Properties' ribbon option) and, in the 'Filename' field,
type the file location into which to generate the
Learning Center documentation.

3

In the Browser window, create a child Package for
each category of Learning Center documentation you
intend to create, and within each of those create child
Packages for any further subcategories of
documentation. You can create child Packages to as
many levels as necessary, but it is recommended that
you try to limit the structure to fewer than five
levels.
Consider also that you can have topics (Document
Artifact elements) and folders (Packages) at the
same level in your Learning Center document
structure.

Create the Learning Center Topics
You have a number of options for creating Document
Artifact elements in a Package, but creating a Document
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diagram and adding the elements to it is a simple method
that gives you an immediate visual impression of the content
of a subject area.
Ste Action
p
1

Working from the Browser window, within each
Package that is to contain Learning Center topics,
create a Document diagram; that is:
1. Right-click on the Package name and select the
'Add Diagram' option.
2. On the 'New Diagram' dialog, type an appropriate
name in the 'Diagram' field, click on the 'Select
From' header and select the 'Manage > Show All
Perspectives' option, then click on 'Extended' in
the panel beneath the header.
3. Click on 'Documentation' in the 'Diagram Types'
panel.
4. Click on the OK button.

2

From the Diagram Toolbox, drag a Document
Artifact icon onto the diagram and give it the name
of the topic it will contain.
This name will display at the top of the document
and in the Learning Center topic access path, where
it will act as a link to open the topic.

3

Double-click on the element and select your
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Learning Center document template (or any other
appropriate template) from the 'New Linked
Document from Template' dialog.
4

Add the description and/or procedure text to the
document. When you have finished, save the
document and repeat this procedure for the next
Document Artifact element/Learning Center topic.

5

In the Browser window, check the order in which the
Document Artifact elements are listed. This order
determines the sequence of the Learning Center
topics.
If you want to present the Learning Center topics in
a different order, adjust the sequence of the
corresponding Document Artifact elements in the
Browser window accordingly.

Compile the Learning Center documentation
Ste Action
p
1

In the Browser window, click on the root-level
Package for your Learning Center documentation.
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2

Select the 'Specialize > Tools > Scripting' ribbon
option.
The Scripting window displays.

3

Expand the Local Scripts folder and click on the
VBScript - Create Learning Center Books script
name.

4

Click on the 'Run script' icon ( ) in the Scripting
window toolbar.
The script generates the Learning Center
documentation to the file path specified in the
'Filename' field in the root Package properties.
The script also generates:
· An order.txt file from every Package in the
document hierarchy, to define the order of display
of child folders or topic names in the folder
generated from that Package; you can directly edit
this file to change the topic order in the Learning
Center, if necessary
· An index.txt file in the root folder that provides an
index for every topic, derived from the GUID of
the Document Artifact element from which the
topic was generated; this index is used to identify
the topic in references and hyperlinks to the topic,
regardless of where the topic might be moved to
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Load the Learning Center documentation
The Learning Center documentation you have created for an
Add-In or Technology is loaded into the Learning Center
using the Repository method 'AddDocumentationPath'. You
would normally write this into the activation script you
created to load the Technology itself, but you could also test
the documentation using a simpler script that just loaded the
documentation. The call resembles this:
{
Repository.AddDocumentationPath('ToolGuide','C:\\Temp\\
ToolLC',0)
}

Notes
·

If the same Learning Center documentation is loaded
more than once during a work session, each load is
presented as a separate set of pages; the original
documentation is not overwritten
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Manage Libraries
You use the 'Manage Libraries' dialog to :
· Enable or disable installed Learning Center Libraries
· Install new Learning Center Libraries, and
· Set the default Library topic, which will be displayed
when the Learning Center View is opened

Access
Ribbon

Start > Help > Libraries > Manage
Library

Manage Libraries
Option

Action

Available
Libraries

Lists the installed and enabled Library
files. Deselect the checkbox against any
Library that you want to disable.

Show
Disabled

Select this checkbox to show disabled
Libraries in the 'Available Libraries' list.
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Libraries

Select the checkbox against any library
that you want to enable for access.

Default
Library

(Optional) Click on the drop-down arrow
and select the Library from which the
default topic is to be selected. The default
topic is automatically displayed when the
Learning Center View is opened.
Only enabled Libraries will be listed in
this field.

Default
Topic

Click on the button to open the 'Select
Default Topic : <default library name>'
dialog to select a topic from the default
Library to set as the default topic. The
full, expanded hierarchy of topics in the
default library displays. Scroll through
the structure and select the checkbox
against the topic to use as the default,
then click on the OK button.

Install New
Library

Click on this button to locate and select a
new set of library files to install. A
submenu displays; select:
· From File System – to install a new
Library from the file system: a browser
displays, through which you locate and
select the library folder
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OK

Click on this button to save and action the
library you have defined in this dialog.

Close

Click on this button to close this dialog
without activating any changes to the
library defined in the dialog.

Help

Click on this button to display this Help
topic.

Notes
·

·

·

Disabled Libraries will not be visible in the 'breadcrumb'
path at the top of the Learning Center View
Once a new Library is successfully installed and enabled,
you can view it in the 'breadcrumb' path of the Learning
Center window
If the Learning Center window is already open when you
download a new Library or enable/disable a Library, close
and then re-open the Learning Center window to make
your changes visible in the 'breadcrumb' path
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Support
Technical support for Enterprise Architect is available to
registered users. Responses to support queries are sent by
email.
Sparx Systems endeavors to provide a rapid response to all
product-related questions or concerns.
· Registered users can lodge a support request, by visiting:
https://sparxsystems.com/registered/reg_support.html
· Trial users can contact Sparx Systems with questions
regarding their evaluation at: support@sparxsystems.com
· An online user forum is also available for your questions
and discussions, at https://sparxsystems.com/forums/smf/
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Creating a Project
It is easy to get started with Enterprise Architect, and within
a few minutes, you can have a project set up, and in just a
few hours, you can have your model populated with your
own content and be well on the way to getting
unprecedented value from the tool. A project is really a
repository, a more technical word for the container where
you will place your modeled content. Productivity tools will
get you off to a flying start and allow you to derive
immediate value from your models. Still, the first thing is to
create a repository that will store the elements, diagrams,
documents, and discussions that you add as you work in the
tool.
Enterprise Architect conveniently allows you to create a
file-based repository that you can set up yourself without
involving your Information Technology department. You
can happily work with other modelers by placing the file on
a network drive where other team members can access it.
Conveniently, as you progress with your modeling and
perhaps as others join your modeling project, you can easily
transfer the file-based repository to a server-based
repository either on your premises or in a cloud
environment. A server-based repository allows more
rigorous repository management such as automated database
backups, richer collaboration opportunities, and web-based
views of your models.
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The Start Page
The Start page opens when you launch Enterprise Architect.
It allows you to create a local (file based) repository, by
clicking on the option 'Create New'.

Create New option available on the Start page
This will open a 'New Project' dialog where you specify the
file name and location of your new repository. Remember if
you want to work with a small number of other team
members (up to five or six) you can place this file on a
network drive or you can move it at any time when you
want to work with other people. Once you close the dialog
Enterprise Architect will load your blank repository.
In the Browser window (pressing F2) rename the 'Model'
node using a suitable name e.g. 'Your Organization Name'
or 'Your Project Name'

Browser window with the default root node, which is the
starting point of your repository structure
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You can continue to add other Packages to the Browser
window either before you start adding content such as
elements and diagrams or as you go along. The structure
will depend on what type of enterprise or projects you are
working on and how you want to structure your work. Two
common ways of working are:
· A single repository that contains organizational level and
all project-level content
· A single organizational level repository and a separate
repository for each project
These are just two common ways of structuring your
repositories, but there are many other ways of working that
can be hybrids between them, and the best way for you will
depend on your individual context. Rest assured, service
companies and partners can advise you on the best setup for
your circumstances.
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Setting your Perspective
Enterprise Architect is a feature-rich tool and provides a full
range of facilities for almost any modeling context,
including Strategy, Requirements, Business modeling,
Enterprise and Solution Architecture, Information and
Database modeling, and Systems Engineering, to name a
few. The tool has many features that will help you stay
focused on what you are doing and give you the freedom
and flexibility to use other facilities.

Perspectives
To ensure you get the best out of the tool and stay focused
on what you are doing, Enterprise Architect provides
Perspectives that allow focused modeling contexts. Once
you have selected a Perspective, the other features are never
far from hand, and any time you want to use other items, it
is as simple as choosing another Perspective.
Selecting and changing Perspectives is straightforward using
the icon in the top right-hand corner of the application
window.
The perspective selector.
Let's say, for example, that you want to do some
Requirement modeling - you select the Requirements
Perspective, which will allow you to focus on Requirement
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Modeling and Management. Whenever you add diagrams,
you will only see the Requirement diagram options, but
remember all the other tool features are close at hand - all
you need to do is change Perspectives. You can even create
your own Perspective that contains a number of facilities,
such as Requirements, Business Process Modeling, and
Mind Mapping.

List of available perspective sets and perspectives they
contain.

Ribbons
The ribbons provide a welcomed and familiar interface to
the tool features and can be customized to suit the way that
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you work. The ribbons have been carefully designed by
modeling experts and place the rich features at your
fingertips in any modeling context. For example when
working with diagrams you will be able to use the Layout
ribbon to align diagram objects, change colors, and styles
and create expressive layouts that will make your diagrams
compelling and communicative.

Commonly used panels of the Layout ribbon.
While the ribbons make it easy to find the features you are
looking for, there is a universal way of locating a tool
feature that allows you to search using a keyword such as
'Baseline'. The 'Find Command' option is conveniently
located at the end of the ribbon bar next to the last ribbon
(usually 'Settings').
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The Find Command used to locate the baseline tool.

Workspaces
When you open Enterprise Architect for the first time, the
application will open the default window layout (or
workspace). The tool has a large number of workspaces that
have been carefully designed to provide the most useful
windows for a given modeling context. For example,
suppose you are doing Requirements modeling. In that case,
you can choose the Requirements workspace available from
(c) Sparx Systems 2022

Page 437 of 524

Getting Started

3 October, 2022

the Design group, which will open several windows helpful
for specifying, viewing, and organizing requirements.

Workspace portal with selected workspace.
You can also create and save any number of your own
workspaces with window and tool features that are instantly
reopened when you select the saved workspace from the My
Workspaces section of the Workspace portal.
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Adding Model Content
Enterprise Architect allows you to add content in a variety
of ways. Regardless of what type of modeling you are doing
there are a number of convenient ways in which you can get
your content into the model. The content you add will
depend on what type of modeling you are doing; for
example, a strategist might add drivers, goals and
objectives; a requirement engineer could enter text-based
requirements; and a database owner would typically add
database objects such as tables and views. The method you
chose will depend on your modeling context; for example, at
the time you are setting up a repository it would be usual to
import lists of elements from a spreadsheet. The commonest
ways to add content to a repository are:
· Diagramming using the Toolbox pages
· Using the Browser window
· Model from Patterns
· Specification Manager
· Importing from a spreadsheet
· Importing images from files or the clipboard
· Copying from another repository
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Diagramming
Creating diagrams is one of the easiest and most common
ways to add content to your repository. When you add
elements and connectors from the Toolbox to a new or
existing diagram, these elements and connectors are also
created and added to the Package that contains the diagram.
The added elements will be immediately visible in the
Browser window. In this example, a modeler has added a
new Requirement and Use Case to the diagram and
connected them using a UML Realization relationship.
REQ00333- The system must allow
social media content to be
amalgamated and searched

Analyze Social Media
Feed
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Diagram showing how elements and connectors can be
created with diagrams.
As the elements are added from the Toolbox they are
simultaneously added to the Browser window and will
appear in the same Package as the diagram. (Connectors are
not displayed in the Browser but in a series of other
windows.)

Browser window showing element and diagram

Using the Browser
The Browser window is the key mechanism for navigating
through a repository and is also important when adding
content. You select a location in the tree (typically a
Package or element) and this will be the point in the
repository where new content is added. There are four things
that you might want to add to your repository:
· Patterns
· Packages
· Diagrams
· Elements
There is a convenient toolbar at the top of the Browser
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window that provides options for inserting new items into
the repository, as well as a number of other options for
moving items up and down the tree.

Browser toolbar and tabs showing useful icons such as the
New Package and New Diagram icons.
The Hamburger menu provides more options, including to
insert an element directly into the repository without using a
diagram. The Browser window has a number of tabs that
conveniently let you focus on particular parts of your model,
including the:
· Entire Project
· Item in Context
· Current Diagram or
· Resources

Model from Patterns
Enterprise Architect has a productivity tool that will get you
started modeling quickly and ensure your models comply
with industry and tool best practices. Experts at Sparx
Systems have created a catalog of pre-built model fragments
called Model Patterns. Regardless of what you want to
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model, there will invariably be one or more patterns
available to get you started. The pattern documentation
shows you what to expect from the pattern and how to work
with it. You can then choose a location in the Browser
window and insert the pattern, including elements and
diagrams, into your own repository. Typically the elements,
connectors, and diagrams in a pattern will have generic
names that you can change to suit your project. The pattern
library is a living catalog and new patterns are added as the
industry develops new standards and best practices.

Browser toolbar and tabs showing the New Model From
Pattern icon.
Whenever you change perspectives the available patterns
will conveniently be displayed, or you can directly launch
the Model Wizard at any time from the Browser window
toolbar or from the 'Model Wizard' icon on the 'Package'
panel of the Design ribbon.
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Model Wizard showing patterns from the Requirements
perspective.

Specification Manager
The Specification Manager is a great tool for viewing or
adding content to the repository using a familiar word
processor or spreadsheet-style interface. It is particularly
useful when you have a list of items that contain descriptive
names and textual descriptions, such as Requirements and
Capabilities, but it can be used for any element, including
information classes, processes, decisions, and more. It is a
refreshing alternative to working with diagrams and a
welcomed method for many business and technical team
members who create or view catalogs of items. You can
switch to other views from the Specification Manager, such
as lists, diagrams, and Gantt views.
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Specification Manager showing inline (spreadsheet) view of
elements, notes and editable properties.
For those modelers or stakeholders accustomed to working
with spreadsheets or word processor documents, the tool
will seem natural and emulates both these modes of
visualization, allowing you to toggle between spreadsheet
mode and document mode quickly.

Importing from a Spreadsheet
Enterprise Architect has a useful facility to import (or
export) content from a spreadsheet using a comma-separated
values (csv) file. Any data in your favorite spreadsheet can
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be exported to a csv file and imported using a simple and
intuitive interface where you specify which properties you
want the data to be added to. You can also export data from
Enterprise Architect into a spreadsheet if required. There
are a number of tools that enable you to do this, but the most
straightforward of these is available from the Publish
ribbon.

Facility to specify the fields to be exchanged between
Enterprise Architect and a Spreadsheet.
For more Information, see the CSV Import and Export Help
topic.

Importing Images
Using Enterprise Architect, you can create expressive
diagrams that comply with standards and industry best
practices and also include compelling vector or raster-based
images that will bring your diagrams to life and delight your
audience. Many newcomers to modeling feel that they are
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straight-jacketed by the modeling languages and cannot
create the type of diagrams that will appeal to their
customers or managers, but with Enterprise Architect, you
can have the best of both worlds.
Using the tool, you can add any number of images into a
library or directly into the repository and then use those
images freely on any diagram. You can import your images
as a set at the start of a project or just as you need them for a
particular diagram.

Image Manager showing a range of generic images in
vector format including the marketing metafile being
displayed.
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Copying from another Repository
You can import modeled content from other repositories
into the current repository in a number of ways, including:
· Simple copy and paste using the clipboard
· Exporting and importing a section of the model using xmi
import/export
· Model transfer, which will copy an entire repository
(including reference data)
Content can also be injected into a repository from a
Reusable Asset Service, which your administrator or
librarian would set up. You can also exchange reference
data such as status and priority codes by exporting them
from one repository and importing them into another using
the Transfer options on the Settings ribbon.
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Viewing Your Content
Enterprise Architect provides a range of ways to view the
content that you and others have added to the repository,
and many of these views also allow you to create content.
Some views are suitable for the full range of technical and
non-technical stakeholders from strategic levels down to
engineering levels. The great thing about the views is that
when you update information in one view, it is immediately
reflected in all the other views.

List of alternative views available from the diagram
Properties window.

Diagram View
Diagrams are the most expressive and ubiquitous of all the
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views in the tool and, when constructed well, will appeal to
both technical and non-technical stakeholders. We looked at
Enterprise Architect's diagram feature in the Adding Model
Content Help topic, and you will know they can be used for
both creating and viewing elements and connectors in the
model. You can access various styles and presentation
options, including whiteboard, hand-drawn, and custom
style.

Roadmap diagram showing color used to visualize the status
of the applications.

List View
You can use the List View to visualize the contents of a
Package or a diagram as a list of elements. It is a useful
alternative view to a diagram and allows element properties
to be viewed and edited in a convenient spreadsheet-like
view. Many analysts will prefer to view elements in a list,
and when you make changes, these will be visible
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immediately in every other view of the element, including
diagrams and the Browser window. There are also several
options for filtering, sorting, and grouping elements in the
list based on a range of system- and user-defined properties.

List view showing elements grouped by status and
sub-grouped by type.

Matrix
The Relationship Matrix is a tool for visualizing the
relationships between elements in a visually compelling
view, resembling a matrix or spreadsheet. You can use the
matrix to view the relationship between any two elements;
for example - between Stakeholders and their Requirements,
how Use Cases relate to Business Requirements or
Functional Requirements, how Capabilities relate to
Business Drivers, or which Components implement a set of
(c) Sparx Systems 2022

Page 451 of 524

Getting Started

3 October, 2022

requirements. The matrix has great appeal for non-technical
stakeholders and can be included in documentation and
viewed through WebEA, and even saved to a spreadsheet.
You can also create relationships through the matrix and
visualize which elements are loners and don't have any
connections.

Relationship matrix showing 'lone' elements (no
connections - green and pink squares) and options.

Specification Manager
We looked at the Specification Manager in the Adding
Model Content Help topic, and you will know that it can be
used for both creating and viewing elements in the model. It
is particularly useful when a team member is not familiar
with diagrams and is perhaps even a little intimidated by the
modeling languages such as UML or ArchiMate and just
wants to read things in plain English in a familiar word
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processor or spreadsheet view.

Specification Manager showing requirements and editable
properties.

Traceability
The Traceability window will be your friend and help you
keep track of how elements in your model are connected. It
gives you a hierarchical view of element connections and
allows you to query and visualize traceability as you
traverse elements in the model, including using diagrams
and the Browser window. Your colleagues might enter
relationships to elements you have created, which will
appear in the Traceability window when you select the
element. The tool is particularly useful because a modeler
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will often choose to hide diagram relationships in particular
circumstances, but by selecting an element in the diagram
and viewing its connections in the Traceability window, all
its relationships will be displayed.

Traceability window showing the hierarchy of elements and
their connections.

Charts and Graphs
Using Dashboard diagrams, you can create high-quality
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charts and graphs that display repository information in a
visually compelling way, such as the ratio of a Requirement
Priority like Status in a Pie Chart, or the task allocation in a
Time-Series Chart. There is a Toolbox page of
pre-configured charts and graphs, but you are free to create
and save any number of charts, sourcing data from
anywhere in the repository. The charts and graphs provide
valuable summary information that helps you manage all
aspects of the repository, including properties like Status
and Resource Allocation.

Charts showing team tasks and testing status.
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Publishing Your Content
Sharing your models by either giving people access to your
repository or, if your models are hosted by the Pro Cloud
Server, giving people browser-based views through WebEA
or Prolaborate, is an easy way to publish the content. There
will, however, be circumstances when you need to create
formatted documentation for regulatory or contractual
reasons, and Enterprise Architect has a range of publishing
mechanisms that make it easy to generate first-class
corporate documentation in a range of formats.

Custom document feature used to create documents that are
flexible, intuitive and dynamic.
The easiest way to get started with document publishing is
to use the Custom Document facility. Using this feature, you
can create a document based on a template and add any
content, formatting it as you go based on the template styles.
You can then inject content into the document from the
model. For example, you could have a set of Requirements
in the repository and simply drag these from the browser
onto the document; by selecting a template, the
Requirements would be rendered in the document based on
the formatting and styles specified in the template.
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An example document showing the dynamic content panel
and inserted logo and title.
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Navigating and Searching
A well-organized repository will go a long way to helping
you find the elements and diagrams you are looking for, but
as the tool gets traction in your organization, models will
grow in size and, before you know it, a repository might
contain tens if not hundreds of thousands of items.
Fortunately, Enterprise Architect has some useful tools
available for locating content, including:

Browser
The Browser window is your go-to place for navigating
around a model. Think of it as your favorite explorer tool for
finding files on your computer, except that you use it to find
things in the repository. It is a tree view, and nodes can be
expanded and collapsed to locate items such as Packages,
diagrams, and elements and their features (attributes,
operations, receptions).
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Browser showing business process Package and element
hierarchy.

Navigator Bar
The Navigator Bar is like a breadcrumb trail that indicates
your position in the hierarchy of Packages in the repository
but with the additional feature to select the available
Packages at any point in the trail. It is a convenient way of
traversing the Package hierarchy without viewing all the
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Packages in an expanded tree view. Some modelers use this
as their primary navigation mechanism.
Navigator bar showing Package hierarchy.

Navigation Cells
Enterprise Architect allows you to create any number of
navigation diagrams that contain Navigation Cells that a
user can click on to go straight to a diagram regardless of its
location in the repository. These same cells are available
through the web-based tools WebEA and Prolaborate. They
make it easy for a user to find a diagram without using the
other navigation methods. The diagrams can be nested,
where a navigation cell on a high-level diagram will take
you to another page of cells, targeting specific diagrams.

Top level navigation diagram showing clickable navigation
cells.
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Model Search
The Model Search is a fully-featured facility to find almost
any content in the repository. You can use it as a simple way
of finding a word or phrase, or you can create sophisticated
searches that can find the answer to complex questions. As
your models grow in size, particularly when several people
contribute content, it will become harder to locate items
quickly as the model might contain hundreds or thousands
of elements. Let's say you knew there was some information
in the repository to do with issuing a refund when a medical
certificate is submitted. You could launch the 'Search in
Model' feature and, using the default settings, enter a
keyword or phrase such as 'refund' or 'medical certificate',
and the search tool would locate and list any objects with
the name, alias or notes that contained these words.

Model Search window showing a search for the word
'Refund'.
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Collaborating and Sharing
Enterprise Architect is built from the ground up as a
collaboration platform and while it is possible to work in
isolation, great power of expression will come from
collaborating with other people, including colleagues,
customers, specialists and others. The tool has the power to
create relationships between content that is typically
disconnected and often kept in silos. The ability to see
information from disparate disciplines and view points
provides a refreshing and compelling view which is unique
to Enterprise Architect and you and your team will see
model connections and share ideas that you might not
otherwise have been able to visualize.

Collaboration features at your finger-tips on the
Collaborate panel of the Start ribbon.
There is a range of features that facilitate collaborative
modeling and can be used in isolation or together, creating
unprecedented value in a project or an enterprise as people
share knowledge, ideas and provide critical analysis of a
model or concept. Regardless of where you are in the world
or what language you speak, your colleagues are not far
away and the tools allow you to collaborate as though
working in the same office. These tools include:
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Discussions - discuss ideas and concepts
Reviews - review model content with any number of
people
Chats - conduct informal and immediate chat sessions
Mail - in the Model Mail system for detailed
conversations and linking to model content
Calendar - keep track of important project dates
Library - a catalogue of important project documents and
references

Discuss & Review window showing two separate
discussions
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Getting Help
Enterprise Architect has an extensive Help system that
provides answers to help you throughout your modeling
journey. The content you are reading is, in fact, the Getting
Started topic of the Help system and is a very lightweight
coverage of the information you need to get started. The
other topics in the Help system will do a deep dive into all
the details on how to get value from the tool, and how to use
the many features in the product.
The Help System is in fact an online resource but can also
be downloaded as a series of pages that you can access
without an Internet connection. To launch the help from the
tool simply use the Help icon on the Start ribbon or choose
the Help button from tool windows:

There are three ways that you can find information in the
Help system:
1. Browse through the topics using the index, expanding and
collapsing topics as you go.
2. Use the Search facility to locate a term or phrase of
interest.
3. Select the Help button on a window or tool feature.

Browsing through the Index
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When you launch Help, it will open a browser window, and
the default welcome page will be displayed. You can select
a topic from the list of navigable topics displayed down the
left-hand side of the page. Items will expand and collapse as
you click through, and a breadcrumb on the top of the page
will conveniently keep track of your location in the Help
system.

Help web pages showing the index of items down to
'Baselines'

Using the Search
While it is possible to browse the index topics, a faster and
more direct way of finding content is by using the Search
facility. When you enter a keyword or phrase, the search
will return a results list. For example, you could be looking
for information about how you baseline your content, so
entering the word 'baselines' in the search box will return a
list of entries related to baselines.
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SImple model search feature looking for a user word or
phrase 'Baselines'.
The result page conveniently shows a number of tabs with
information about your keyword (e.g. Baselines) available
in other resources:
4. Website
5. User Guide
6. Document
7. FAQs
8. Related Videos
9. Advanced Search

Selecting a Help Button
Enterprise Architect has rich and ubiquitous
context-sensitive Help, so no matter where you are in the
tool or which window or facility you are using, help is at
hand. Simply launch the Help system from the 'Help' icon,
typically at the far right of a toolbar or in another prominent
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position, and the search will display the relevant Help topic
in your default web browser.

The Help icon available on the Scenario window.

(c) Sparx Systems 2022

Page 467 of 524

Getting Started

3 October, 2022

Where to Next
By now, you will have some content in your repository and
be able to view it in different ways, search for items, publish
sections of the repository, collaborate with colleagues, and
know where to get help. Now is the time to plan the
evolution of the repository and how you will add additional
content, and ensure it provides value to your enterprise and
project stakeholders. These sections list some things to
consider as you further develop your models.

Creating Model Views
As your repository grows in size, understanding and being
able to locate specific content will be come more difficult,
and casual users of the repository might find the sheer
volume of content overwhelming.
While the Browser is the most common way to navigate
through a repository the tool has another useful feature
called Model Views, which allows you to create tailored
personal and team views of repository content. Using Model
views you can create:
· Lists of favorite elements and diagrams
· Lists of elements based on a search
· Slide shows of diagrams
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Creating the Browser Package Structure
You can take two different approaches to creating a Package
structure:
· Create a Package structure up front and then populate it as
you work
· Create the Package structure as you go, adding Packages
in response to the needs of the stakeholders
Regardless of the approach, a well-organized Package
structure will make navigation and updating easier and will
facilitate document creation. It would be best to make some
decisions about the content of your repository. There are
two basic patterns for the content:
· A single repository - that contains both Enterprise and
Project content
· Two separate repositories - One for the Enterprise and the
other for Projects.
· Multiple repositories - One repository for the Enterprise
content and additional repositories for each Program or
Project.

Defining your Navigation Pages
Navigation pages with well chosen Navigation Cells will
streamline repository navigation and give advanced and
novice repository users easy access to diagrams. Consider
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having a single home page that then launches sub pages.
Another strategy is to divide your sub pages in different
dimensions; for example:
· A page for each project which then has cells for each
discipline
· A page for each discipline - for example, requirements
that cut across projects

Importing Additional Content
Populating your repository with content and providing
useful views of the content is critical to the success of the
project and its acceptance by stakeholders. Where possible,
endeavor to make Enterprise Architect the system of record
for the data you import. In some situations other systems
will remain the system of record, and in these cases it is best
- if possible - to use the integrations available through the
Pro Cloud Server to access the content. For example, you
can integrate with Jira or SharePoint, allowing elements
such as User Stories and Documents to be sourced from the
external tools but made available in Enterprise Architect. In
other cases, the content might exist in documents or
spreadsheet files; these are best imported into Enterprise
Architect and the original sources decommissioned, thus
making Enterprise Architect the system of record. Some of
the items you might consider importing are:
· Requirements
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Principles
Capabilities
Processes
Business Rules
Applications
Interfaces
Services
Security Controls
Data Models
Servers
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A Tutorial Modeling Session

Welcome to Enterprise Architect!
This quick-start tutorial helps you get up to speed with
Enterprise Architect.
As you read through this tutorial, it is recommended that
you have Enterprise Architect open so that you can try out
the tasks described. By the end you should be able to begin
modeling your own business/software projects with
Enterprise Architect.
Throughout the descriptions there are hyperlinks to more
detailed information on a range of topics.

Basic Tasks
Task
Creating a new project
Adding Views to your model
Adding Packages to your model
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Adding diagrams
Adding elements to your model Packages
Creating links between model elements
Refining the model
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Startup
When you install Enterprise Architect on your system, two
items are created:
· An Enterprise Architect icon on your Windows desktop
· A new program folder called Enterprise Architect
<version number> in your Windows 'Start > All
Programs' menu; this folder contains the execution option
'Enterprise Architect'
You can start Enterprise Architect by clicking on either of
these objects. After a short pause, the Start Page displays,
from which you can:
· Open a project file (.eap file, .eapx file, .qea file, .qeax file
or .feap file)
· Create a new project (.eap file, .eapx file, .qea file, .qeax
file or .feap file)
· Connect to a DBMS repository (Corporate and extended
editions)
· Connect to a project via the Cloud (Corporate and
extended editions)
· Return directly to one of the projects you most recently
opened
· Open one of a number of Portals to a set of facilities that
support an area of work in Enterprise Architect

Notes
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If you changed the default system folder name during
installation, the Enterprise Architect <version number>
folder in the 'All Programs' menu will have the name you
provided
By default, when you install Enterprise Architect, an
empty 'starter' project called EABase.qea is installed, as
well as an example project named EAExample.qea; we
recommend that new users select the EAExample file and
explore it in some detail while they become familiar with
UML and software engineering using Enterprise Architect
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Create a Project
A project is a single file or repository-based store for one or
more models. The first step in getting started with Enterprise
Architect is to either open an existing project, or create a
new one.
In this example you:
· Create a new file-based project
· Add a template-based model to kick-start your modeling
Once your new project has been created you:
· Have a simple Use Case model to explore and tailor to
your requirements
· Can re-open your project at any time by double-clicking
on it in a file browser
· Can see it in the 'Recent' list on the Start Page

Create a New Project
Step

Description

1

Start Enterprise Architect.

2

When the 'Start Page' displays, click on
the option:
· Open > Personal Project > Create New
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This displays the operating system file
browser dialog.
In the 'Save as type:' drop-down you have
the option to create a repository of
file-type:
· .qea extension (the default)
· .qeax extension
· .feap extension
· .eap extension (JET 3)
· .eapx extension (JET 4)
Select one of these.
3
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Locate a suitable folder for your project
then:
· In the 'File name' field, type in a
distinctive name
· Click on the 'Save' button to continue
Enterprise Architect creates a new project
file, places it in the specified location and
then opens it automatically.
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The Browser window's 'Project' tab now
displays a root-node named 'Model'.

4

To create a starter model:
· Click on the 'Model' root-node
· Click on the
icon in the Browser
window toolbar
The Start Page 'Create from Pattern' tab
(Model Wizard) displays
· Click on the
button and select 'UML
> Behavioral' (a Perspective)
· Scroll down to 'Use Case Diagrams'
· Select 'Basic Use Case Model'

Click on the Create Model(s) button
Result: The Model Wizard automatically
creates a new Use Case model for you,
with an initial diagram, some notes and
default elements to help get you started.
·
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From the Browser, click on the 'Basic
Use Case Model' diagram to open the
diagram.

Your diagram is now ready for making
any alterations.
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Add a View to your Model
A View is a top level Package within a model. It can be
categorized by purpose, such as Use Case View, Component
View or Deployment View, the purpose being indicated by
using different types of icon. Views are used to add an
optional level of grouping of Packages, diagrams and
elements - the building blocks of your model.

Add a View
Ste Instruction
p
1

In the 'Project' tab of the Browser window,
right-click on the 'Model' icon (the model root node)
and select the 'Add View' option.
The 'New Package' dialog displays.

2

In the 'Name' field, type an appropriate name for the
new View.

3

To select an icon for the View, click on the button to
the right of the 'Name' field', then click on the icon
you wish to use in the displayed list (we suggest
Simple).
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Click on the OK button.
The 'New Package' dialog closes.
The new View is created as a child of the Model root
node.

Notes
·

There are six types of View, which represent conventional
ways of categorizing the purpose of a Model View; these
types of View represent different structural or behavioral
aspects of the same model
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Add New Packages
A Package is a container of model elements, and is
represented in the Browser window as a 'folder' icon.
· A Package holds the model building blocks, such as
diagrams, elements and other Packages
· To begin developing your model, you create an initial
Package to hold your first diagrams and model structures

Access
There are numerous ways in which you can add a Package
to your model. Start by selecting the parent Package (or
View or Root node) in the Browser window.
Then choose any of the methods outlined here.
Ribbon

Design > Package > Add Package

Context
Menu

Right-click on parent Package | Add a
Package

Keyboard
Shortcuts

Ctrl+W

Other

Browser window tool bar |
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Add a Package to your model
On the 'New Package' dialog, complete the fields as
instructed.
Option

Instruction

Owner

Displays the name of the
currently-selected Package or View, to
which you are adding the new Package.
If this is not the required owner Package,
click on the button and select the
correct Package.

Name

Defaults to Package1. Overtype this with
the name of the new Package.

Select and
Apply Model
Pattern

Click on this radio button if you want to
create the new Package from a Model
Pattern.

Create
Diagram

Click on this radio button if you want to
immediately create a child diagram for
the Package.

Package
Only

Click on this radio button if you want to
just create a Package.
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OK

Click on this button to create the Package
in the Browser window.
If you selected the 'Select and Apply
Model Pattern' radio button, the Start
Page 'Create from Pattern' tab (Model
Wizard) displays. Select the appropriate
Perspective and Model Pattern to import.
Click on the Create Model(s) button.
If you selected the 'Create Diagram' radio
button, the 'New Diagram' dialog
displays. Type in a name for the diagram
and select the appropriate Perspective
Group and Perspective (in the 'Select
From' panel) and the required diagram
type. Click on the OK button.
The new Package is inserted into the
Browser window under the selected
parent Package or View.

Cancel

Click on this button if you want to abort
the changes you have made and close the
dialog.
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Create a New Diagram
A diagram is a visual representation of the elements of your
model and:
· Their attributes and characteristics
· How they are connected and/or interact with each other
Different diagram types show different aspects of the model
and the relationships between elements.

Add new diagrams to your model
Ste Action
p
1

Click on a Package or View in the Browser window,
then either:
· Click on the Browser window
button, or
· Press Ctrl+Insert, or
· Select the 'Design > Diagram > Add Diagram'
ribbon option, or
· Right-click on the Package or View and select the
'Add Diagram' option
The 'New Diagram' dialog displays.

2

Enterprise Architect provides a default diagram
name that is the same as the parent Package name.
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Overtype this with your preferred diagram name, if
necessary.
3

Click on the 'Select From' header and select the
Perspective Group and Perspective most appropriate
to the area you are working in.
The panel below the header displays a list of
diagram groups; click on the required group.

4

In the 'Diagram Types' panel, click on the type of
diagram to create.
A description of the selected diagram type displays
in the field underneath this pane.

5

Click on the OK button.
· The 'New Diagram' dialog closes
· A new diagram is created as a child of the
currently selected Package
· The new diagram is opened in the Diagram View,
ready for editing

Notes
·

When you create a Package, if you leave the 'Create
Diagram' option selected, the 'New Diagram' dialog
displays automatically
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Create New Elements on a Diagram
Models are constructed from elements, each of which has its
own meaning, rules and notation. Generally, when you
create a new element in your model you want to use that
element on a diagram. The simplest way to do this is to
create the element directly on the diagram. In this
procedure, we will use a Requirement element as the
example.

Create a new element on a diagram in your
model
Ste Action
p
1

Display the Properties window; select the 'Start > All
Windows > Design > Create > Properties' ribbon
option.
Also display the Diagram Toolbox; select the
'Design > Diagram > Toolbox' ribbon option.

2

Display the diagram on which the elements are to be
created, in the Diagram View.
To open the diagram, double-click on the diagram
name in the Browser window.
The diagram opens and the Toolbox is updated to
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display the categories of elements and relationships
that are applicable to this type of diagram.
3

In this example, we must change to the
Requirements Toolbox page.
First, change to the 'Requirements' Perspective.
Click on in the Toolbox window, choose 'Change
Perspective', then choose 'Requirements |
Requirements'.
Now, choose the Requirements Toolbox page. Click
on again and choose 'Requirements'.

4

Click on the appropriate icon on the Toolbox page to
select the type of element to create (in this example,
the Requirement element).
The element type is highlighted in the Toolbox.

5

Click on the diagram at the location where you want
to place the element.

The new element is created as a child of the Package
that contains the diagram, and is placed onto the
diagram at the cursor position.
The element's initial details are displayed in the
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Properties window.
6

Use the Properties window to define the element's
name and other properties it should have.
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Right-click on the diagram background and select
the 'Save Current Changes' option.

Notes
·

·

·

You can also drag or paste existing elements onto a
diagram from the Browser window
If you are creating several elements of one type, after
creating the first just press the Shift+F3 keys or Ctrl+click
to create the next element of that type
You can also create elements using shortcuts to the main
facilities of the Toolbox, using the 'Toolbox Shortcut'
menu; to display this menu press the Insert key or
Spacebar, or hold the left mouse button and click the right
mouse button (the 'Toolbox Shortcut' menu that is
displayed corresponds to the currently selected Toolbox
page)
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Add Connectors
Connectors define specific relationships between specific
elements, so you usually create them directly on the diagram
by dragging the required relationship type from the Diagram
Toolbox. As for elements, the Toolbox automatically
presents the connector or relationship types appropriate to
the type of diagram currently displayed.

Define a relationship between two model
elements on a diagram
Ste Action
p
1

Display the Diagram Toolbox; either:
· Select the 'Design > Diagram > Toolbox' ribbon
option or
· Press Ctrl+Shift+3
Also, if it is not already displayed, open the
Properties window ('Start > All Windows > Design >
Create > Properties' ribbon option).

2

Open the diagram containing the elements to be
connected, in the Diagram View (double-click on the
diagram name in the Browser window).
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The selected diagram opens and the Toolbox is
updated to display the categories of elements and
relationships that are applicable to that diagram type.
3

Click on the required icon in the Toolbox to select
the type of connector to draw.
The connector type is highlighted in the Toolbox.

4

Click on the source element in the relationship, then
drag the cursor across to the target element.
A connector of the selected type is drawn between
the two elements.
The connector becomes the focus of the Properties
window.

5

Use the Properties window to define the
characteristics of the connector as required.

Notes
·

·

If you are creating several connectors of one type, after
creating the first press the F3 key then click and drag from
the source element to the target
As you drag a connector path, you can press the Shift key
to create a bend in the connector; if necessary, you can put
several bends in the connector line, pressing the Shift key
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every time you want to change direction
To roll back the bends, keep holding the left mouse button
down and press the Backspace key as many times as is
necessary
To find out more about the type of connector you have
dragged on to a diagram, right-click on the connector and
select the 'Type Information' option, which displays a
Help page on the connector type
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Modify Properties
When you create an element and connect it to another
element, you usually have to define various characteristics
of both the element and the connector to identify the
purpose and function they represent. You do this using the
Properties window.
When you create elements, Enterprise Architect
automatically names and numbers them by type - for
example, Class1, Class2 - so you should at least change the
'Name' field to more easily identify each element. Enterprise
Architect does not automatically name connectors, but for
many connector types you can provide a name that describes
the purpose of the connection.

Modify the characteristics of a model
element or connector
Ste Action
p
1

Select the 'Start > All Windows > Design > Create >
Properties' ribbon option. The Properties window
displays.
Click on the element or connector for which to
define properties. The initial details for that object
display in the Properties window.
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2

Modify the element or connector characteristics as
required.

3

Click on the diagram background.
The element or connector details in the window are
saved; the diagrams that contain the element or
connector are updated as necessary, as is the
Browser window.

Notes
·

·

You can also modify the properties of an element or
connector using the 'Properties' dialog, which is specific
to the selected object; select:
- For an element, the 'Design > Element > Editors >
Properties Dialog' ribbon option or
- For a connector, right-click on the connector and
select the 'Properties' menu option
On the 'Properties' dialog, click on the OK button to save
the changes and close the dialog

(c) Sparx Systems 2022

Page 496 of 524

Getting Started

3 October, 2022

Save Changes
Throughout much of your work in Enterprise Architect, any
changes you make are automatically saved when you close
the dialog (data entry window) on which you made the
changes. In some cases the dialog contains a Save button or
Apply button, which you can click on to save your changes
and then keep working on the dialog.

If there is no specific dialog
If there is no work dialog, such as when you create a
diagram, you can save your work by:
· Pressing the Ctrl+S keyboard keys, or
· Right-clicking on the diagram and selecting the 'Save
Current Changes' menu option
Often, Enterprise Architect does not let you close a screen
without confirming that you want to save or discard your
changes. You can also save your diagram changes
automatically, by selecting the 'Auto Save Changes'
checkbox on the 'Diagram Behavior' page of the
'Preferences' dialog.
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Copy Elements
You can quickly and easily duplicate one or more elements,
with their child elements and diagrams, under other
elements or Packages. You can insert a copy of an element
under one or more other elements or Packages, in the same
project file or any other project file.
It is not possible to duplicate an element on the same
diagram, but you can generate representations of the
element at the ends of connectors, called virtual connector
ends. See the Virtual Connector Ends - Represent One
Element Several Times on a Diagram Help topic.

Operations
Operation

Actions

Copy the
Elements

In the Browser window, select the
elements to copy, right-click on one and
select:
'Copy / Paste | Copy to Clipboard |
Full Structure for Duplication'
Alternatively, click on a selected element
and press Ctrl+Shift+C.
The 'Copying Selected Element(s) to
Clipboard' dialog briefly displays while
the copy operation completes.
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In the Browser window, right-click on the
element or Package into which to paste
the copied elements, and select the 'Copy
/ Paste | Paste Element(s) from Clipboard'
option.
Alternatively, click on the Package and
press Ctrl+V.
The 'Pasting Element(s) from Clipboard'
dialog briefly displays while the paste
operation completes.
The target element or Package is
expanded and the pasted elements are
exposed in the Browser window. If you
are pasting the elements within the same
model as the copied source, the source
parent Package is also collapsed.
If the target element or Package already
contains:
· An element of the same type with the
same name as a pasted element, the
pasted element name has the suffix Copy
· An element with the same type and
name as the pasted element including
the - Copy suffix, the suffix becomes Copy1 (or - Copy2, - Copy3 and so on,
as copies of the element accumulate in
the target element or Package)
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You can keep the same element names as
the source, or you can rename each
element either by clicking twice on it and
editing the name in the Browser window,
or by double-clicking on it and editing the
name in the 'Properties' dialog.

Notes
·

·

·

If you want to copy any elements to paste under another
element, the target element must be capable of receiving
the child elements; for example, you cannot paste a Class
element as a child of a Port
A copy of an element does not have the external cross
references of the source element; that is:
- if one element is copied it has no connectors
- if more than one element is copied, only the
connectors between the copied elements are
retained
- however, if those elements come from a Sequence or
Communication diagram and the diagram
itself is not copied, the message connectors between
the copied elements are not retained
You cannot paste an element into an element or Package
that is locked by another user or that is checked in; the
'Paste...' option is grayed out in the context menu
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Move Objects Around
You have created a project containing Packages, diagrams
and elements, and you have connected the elements.
How do you change where things are?

Move diagrams, elements and connectors
Task
Change the Browser window list order - re-arrange the
order of items in the Browser window
Move elements between Packages - move diagrams,
elements and child Packages from one parent Package to
another
Move elements on a diagram - re-arrange the position of
diagram elements
Move elements between diagrams - cut an element from
one diagram and paste it onto another
Move connectors on a diagram - re-link a source element
to a different target element
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Move Objects Within a Package
In the Browser window, the contents of a Package are listed
in the order: diagrams, child Packages, elements.
· Elements are further arranged in order of type (but see
Notes)
· Within a type, components are initially listed in
alphabetical or numerical order
· You can change the order in which items are listed within
their groups

Adjust the order in which items are listed in
the Browser Window
Ste Action
p
1

Click on an item in the Browser window, then click
on or in the toolbar at the top of the window.
The selected item is moved up or down in the
Browser window accordingly, but remains within its
particular group of items.

2

To revert to listing components in alphabetical order,
in the Browser window right-click on the Package
and select the 'Contents | Reset Sort Order' option.
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Notes
·

You can re-arrange elements in your preferred sequence
regardless of type, by selecting the 'Allow Free Sorting'
checkbox on the 'General' page of the 'Preferences' dialog
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Move Objects Between Packages
When creating the various diagrams, elements and Packages
that make up your model, at some point you might create
one of these objects under the wrong parent Package. It is
quite simple to relocate a model object from one Package to
another, either to a higher level Package, a lower level
Package or a different Package at the same level.

Move objects between Packages
Ste Action
p
1

In the Browser window, click on and drag the model
item to be relocated from its existing position, and
drop it onto the new parent Package.
The dragged item and all of its child items are
relocated to the target Package.

Notes
·

Moving elements in the Browser window does not affect
the use of elements in diagrams
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Moving an element or Package has no effect on any
relationships that the element, Package, or elements
within the Package have
Moving a diagram generally does not affect the location
of elements in Packages
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Move Elements in a Diagram
To improve the understanding of a diagram or to simply
improve the presentation, you might want to adjust the
position of the elements on your diagram.

For coarse adjustments
Ste Action
p
1

Click on a diagram element and drag it to its new
position.

For fine adjustments
Ste Action
p
1

Click on a diagram element to select it.

2

While holding down the Shift key, press the
keyboard arrow keys to move the selected element
one pixel at a time in the direction of the arrow.
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Move Elements Between Diagrams
If an element is present in one diagram but actually belongs
in another, you can simply move the element from the first
diagram into the second. You can also cut multiple elements
from one diagram and paste them into another. When you
cut elements from a diagram, the elements are held on the
clipboard but are not cleared from the source diagram until
they are specifically pasted into the target diagram. A
moved element is not affected in any other way.

Access
Open the diagrams:
· Containing the element(s) to be moved, and
· Into which the elements(s) will be moved
Keyboard
Shortcuts

With the element selected in the source
diagram:
· Ctrl+X
With the cursor in the target diagram:
· Ctrl+V or Shift+Insert

Other

Display the 'Default Tools' Toolbar
(Explore > Portals > Show Toolbar >
Default Tools) and:
· On the source diagram, click on the
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·

element to be moved and on the
icon in the Toolbar
Click on the target diagram and on the
icon in the Toolbar

Notes
·

By selecting more than one element at a time, you can
move multiple elements in the same operation
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Connect to a Different Element on a
Diagram
When creating connectors in your diagrams, at some point
you might connect the wrong pair of elements. Enterprise
Architect provides a simple method to help you to move the
end of a connector from one element to another; that is:
· Change the source element of a connector from the
current element to another, or
· Change the target element of a connector from the current
element to another

Change a connected element
Ste Action
p
1

In the diagram, click on the connector to select it.
The connector is highlighted with 'handles' at each
connector end.

2

Move the cursor over the 'handle' at the end of the
connector to reconnect.
The cursor changes to a small arrow pointing
upwards to the right.
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Click on and drag the connector end to the other
element to connect to.
When you release the mouse button, the connector
breaks from the original element and reconnects to
the new element.

Notes
·

You can also tidy up a connection by dragging the end of
the connector to a better position on the edge of the
element, or move both ends at once by dragging the
middle of the connector
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Delete a Connector
It is possible to hide a connector on a diagram, or to delete it
entirely from the model, removing the relationship between
the previously connected elements.
Displaying all of the connectors on a complex diagram can
make the diagram somewhat confused, so it can be useful to
hide some of the connectors, to clarify a specific aspect of a
more complex picture.

Hide or remove a connector between two
elements
Ste Action
p
1

Open the diagram containing the connector of
interest.
Either:
· Double-click on the diagram name in the Browser
window, or
· Make an already open diagram the 'active'
diagram, by clicking on its tab in the Diagram
View

2

Click on the connector in the diagram to select it.
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The selected connector is highlighted in the diagram.
3

Either:
· Press the Ctrl+Delete keys
· Right-click on the connector and select the 'Delete
Connector' option, or
· Press the Delete key
If you press Ctrl+Delete, a dialog displays prompting
you to confirm that you want to delete the connector
(and the relationship it describes) from the model.
Click on the Yes button to remove the connector.
The Delete key and 'Delete Connector' option
display the 'Remove Connector' dialog.

4

On the 'Remove Connector' dialog, choose one of the
options:
· Hide the connector or
· Delete the connector from the model
'Hide the connector' obscures the connector on the
current diagram; you cannot see it but the
relationship between the two elements still exists and
is shown on other diagrams containing the two
elements together, and on all reports of connectors
between the elements.
'Delete the Connector from Model' removes the
relationship that exists between the two elements;
the connector is removed from the current diagram,
from all other diagrams on which it is shown, and
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from all reports on connectors between the two
elements.
5

Optionally, tick the checkbox 'Don't ask again'.
Selecting this option prevents the 'Remove
Connector' dialog from being displayed next time
you select the 'Delete Connector' command; the
command uses the setting you last used on the
dialog.
Make sure that you have selected the right option to
use as your default.

6

Click on the OK button.
The connector disappears from the diagram.
If you selected the 'Delete the connector from the
model' option, the relationship represented by the
connector is also deleted from your model.

Notes
·

·

You cannot select multiple connectors - it is only possible
to select one connector at a time
If you select the 'Don't ask again' checkbox on the
'Remove Connector' dialog, you can reset this option on
the 'Links' page of the 'Preferences' dialog ('Start >
Appearance > Preferences > Preferences > Links' ribbon
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option, select the 'Prompt on connector delete' checkbox)
Selecting the 'Hide the connector' option in the 'Remove
Connector' dialog has the same effect as using the
'Visibility | Hide Connector' context menu option on the
connector
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Delete an Element
You can delete the elements of a model from a diagram or
from the Browser window.

Delete an element
Options
Remove elements from a diagram: this is essentially
'hiding' the element in that particular view of the model.
Delete elements from a model - the element, its properties
and any child elements or diagrams it has are all deleted;
the element is removed from all diagrams on which it
appears.
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Remove Elements From a Diagram
Removing an element from a diagram does not delete the
element from the model and therefore does not alter the
structure of the underlying model. When you remove an
element from a diagram, you are essentially 'hiding' the
element in that particular view of the model.

Remove elements from a diagram
Ste Action
p
1

Open the diagram that is to be modified.
Either:
· Double-click on the diagram name in the Browser
window, or
· Make an already open diagram the 'active'
diagram, by clicking on its tab in the Diagram
View

2

Either:
· Press Ctrl+A to select all of the elements in the
diagram, or
· Click on an element in the diagram to select it (and
use Ctrl+click to add further elements to your
selection, or to remove elements from the
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selection)
The selected elements are highlighted in the
diagram.
3

Either:
· Press the Delete key, or
· Press Ctrl+D, or
· Right-click a selected element and select the
'Delete <element name>' or 'Delete Selected'
option
The selected elements are removed from the
diagram.

Notes
You can 'undo' the removal of a diagram element, by
pressing Ctrl+Z, or by clicking the Undo button in the
Default Tools toolbar
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Delete Elements From Your Model
You can delete elements from your model, working either
from the Browser window or from a diagram.
· When you delete an element from your model, the
element, its properties and any child elements or diagrams
it contains are all deleted
· The deleted element is removed from all diagrams on
which it appears
· All relationships that it was involved in are also deleted
from the model

Delete one or more items from your model
using the Browser window
Ste Action
p
1

In the Browser window, click on an item to select it.
To select additional items, or to remove items from
the selection, use Ctrl+click or Shift+click.
The selected items are highlighted in the Browser
window.

2

Either:
· Press Ctrl+Delete or
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Right-click on one of the selected elements, then
select the 'Delete selected item(s)' option
A confirmation dialog displays.
·

3

Click on the Yes button.
The selected items are deleted from your model.

Delete one or more items from your model
using a diagram
Ste Action
p
1

To open the diagram containing the items to be
deleted from your model, either:
· Double-click on the diagram name in the Browser
window, or
· Make an already open diagram the 'active'
diagram, by clicking on its tab in the Diagram
View

2

Either:
· Press Ctrl+A to select all of the elements in the
diagram, or
· Click on an element in the diagram to select it,
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then use Ctrl+click to add or remove specific
elements to and from the selection
The selected elements are highlighted in the
diagram.
3

Press Ctrl+Delete.
A confirmation dialog displays.

4

Click on the Yes button.
The selected elements are removed from the model.

Notes
·

·

·

Deleting a Package completely removes the Package and
all its contents - diagrams, child Packages and elements from the model
Deleting an element completely removes the element and
its properties, connectors, child elements and child
diagrams from the model, and from every diagram that
contains it
Deleting a diagram completely removes the diagram from
the model, but not the diagram's component elements;
they remain in the parent Package
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